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INTRODUCTION 
INTRODUCTION  

The Vision-Pro Reference Guide 
Limited Warranty on CADlink Products 
Copyright Notice 

THE VISION-PRO REFERENCE GUIDE  
This reference guide contains an overview of the features and workflows that are included with the Vision-Pro 
package, with Spot Color module, and Print & Cut Manager module. This documentation is intended to help 
orientate the novice user and highlight particular workflows that will improve efficiency. Be aware that Vision-Pro 
is feature rich, so we invite you to experiment with new designs and methods. 

 

If you have not already done so, then we ask that you perform registration of your package, such that we may 
better customize our technical support to your needs.  

 

Vision can be contacted as follows: 

 

Either contact your local dealer, or contact Vision at: 
 
       tel: (602) 439-0700 

 Fax: (602) 439-0500     
       E-mail:            service@visionengravers.com 
       Internet:          www.visionengravers.com 

 

 

 
 

 

LIMITED WARRANTY ON CADLINK PRODUCTS  
CADlink warrants that the disk medium upon which the product is recorded, and any hardware accompanying said 
disk(s), shall be free from defects in materials and workmanship -- under normal use and service for a period of 
ninety (90) days from the date of delivery, as evidenced by a copy of the receipt. 

CADlink’s entire liability and exclusive remedy as to the disk(s) or hardware shall be at CADlink’s option -- 
either (a) return of the purchase price, or (b) replacement of the disk(s) or hardware that do not meet CADlink’s 
Limited Warranty. These must be returned to CADlink postage pre-paid with a copy of the receipt. 

If failure of the disk(s) or hardware has resulted from accident, abuse or misapplication, CADlink shall have no 
responsibility to replace the disk(s) or hardware, the replacement will be warranted for the remainder of the 
original warranty period or thirty (30) days, whichever is longer.  Other than the above limited warranty, CADlink 
makes no other warranties whatsoever, either legal or conventional, express or implied, with respect to the 
licensed software and hardware.  You are advised to test the licensed software thoroughly before relying on it.  
You assume the entire risk of using the licensed software.  Because of the diversity of conditions and hardware 
under which the licensed software may be used, no warranty of merchantability or fitness for a particular purpose 
is given. Some regions do not allow the exclusion of implied warranties, so the above exclusion may not apply. 

COPYRIGHT NOTICE  
No part of this publication may be reproduced mechanically or electronically or in any form without the prior 
written permission of CADlink. The software described in this online help is furnished under license and may only 
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be used or copied in accordance with the terms of such license. The information in this help is for informational 
use only, is subject to change without notice and should not be construed as a commitment by CADlink. CADlink 
assumes no responsibility or liability for any errors or inaccuracies that may appear in this document. Vision-Pro 
is a registered trademark of CADlink Technology Corporation. 

Written and designed at CADlink 
100 - 2440 Don Reid Drive, Ottawa, ON  Canada   K1H 1E1 
Phone (613) 247-0850    Fax (613) 247-1488 

Manual & Package Design by CADlink Marketing and Customer Support. 

Printed in Canada. Product of Canada. 
© January 2005, CADlink Technology Corporation  
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THE VISION-PRO WORKSPACE 
THE VISION-PRO WORKSPACE 

Workspace Elements 
Multiple Document Windows 
Workspace Colors 
Plate Size 
Plate Object 
Zoom Tools 
Order of Workspace Objects 
Custom Toolbars 
SmartBar Controls 
Guidelines 
Align Palette 
Workspace Options 

WORKSPACE ELEMENTS  
The Vision-Pro workspace is arranged to simulate a working area, where the Sign Plate can be set as a visual cue 
of the available space for the sign or cutting area. 

 

 
 

The basic display of workspace objects may be modified from the View menu. 
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The View menu items are summarized as follows: 

 

Show Plate  Show an outline that visually represents the dimensions over 
which the cutting tool will have free range. 

Show Substrate  Set the plate color according to the substrate color, as 
indicated by the currently selected Sheet Layer plate. 
When the Show Substrate option becomes disabled, the 
plate color will be reset to white. 

Show Fill  Toggle the use of wire frames to improve the screen 
refresh time. 

Show Bitmap Outlines  Display outlines in place of bitmaps in order to improve 
the screen refresh time. 

Link Show Fill and Bitmap 
Outlines  

When Show Fill is toggled, also causes wire frames to be 
shown instead of bitmap image. 

Show Tool Diameter  For a shape that has been applied with a tool path, toggle 
the display of the tool diameter. Also toggles the display of 
line styles. 

Show Tool Paths  For a shape that has been applied with a tool path, toggle 
display of the tool movements. 

Show Tool Paths Only  Hide all workspace objects except for tool paths. 

Show Rulers  Toggle the display of workspace rulers. 

Show 3D  Simulate cutting depth by creating an on-screen 3D effect.  

Show Bitmaps Only  Hide all objects that are not bitmaps. 

Show Reduced Bitmaps  For display purposes only, reduce the color depth and 
resolution of bitmaps. This will improve the screen refresh 
time. 

Show Grid  Toggle the display of grid lines. 

Show Guide Labels  Toggle the display of guideline labels. 

Palettes  Choose the color palettes that are visible. 
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Toolbars  Choose the custom toolbars that are visible. 

Show InstantReplay  Show the InstantReplay window. 

Show Storage Bin  Show the Storage Bin window. 

 

MULTIPLE DOCUMENT WINDOWS  
To have more than one Vision-Pro window open at the same time, enable the Multiple Instance option under the 
Options menu. To help manage these windows, there will be two additional commands under the File menu: 
Close and Close All. 
 

 
 

 

�      Close – Close the current Vision-Pro window (prompt to save) 

�� Close All – Close all of the Vision-Pro windows 

 

Having extra Vision-Pro windows allows components of the design to be edited separately and then combined. To 
move a selected object between Vision-Pro windows, use the Copy and Paste commands. In addition, an object 
can be drag-and-dropped between Vision-Pro windows. 

 

WORKSPACE COLORS 
The Workspace Colors dialog is used to customize the basic appearance of the 
workspace. The Background Color refers to the area around the plate size, and the Plate 
Color sets the edge color of the plate size. 
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The color within the plate size is set within the Current Selection of the Plate Size 
dialog. However, please note that this color is superceded by the View menu >> Show 
Substrate option. 

PLATE SIZE 
Plate Size 

The plate size is a visual representation of the area that is available for printing and/or cutting. The Plate Size 
dialog is used to customize the dimensions and orientation of the sign plate. In this fashion, the spatial 
arrangement of workspace objects may be verified prior to beginning a print or cut job. 

The Plate Size dialog is accessed by choosing Plate Size under the Layout menu. 

  

 
  

Origin Selection 
Origin Selection 

The Origin Selection is used to indicate the zero position of the sign plate. By default, the zero position is set to 
the lower-left corner of the plate. 

  

Orientation 
The Orientation refers to the rotation of the plate size (i.e. the document orientation). This Orientation is 
independent of the page size orientation that is used when printing. 
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Current Selection 
The Current Selection drop-list is used to choose the size (width by height) of the sign plate. If the Custom size 
is chosen, then the Width and Height fields may be entered. 

Below the drop-list is the default color of the sign plate. When a new workspace is created, the sign plate will 
default to this color. 

  

 
  

Note: When the Show Substrate option is disabled, the sign plate will default to white instead of using the default 
Plate Size dialog setting. This is a special case that is intended to prevent potential confusion when working with 
substrate colors. 

 
 

Dimensions 
Displays the current dimensions of the sign plate. If the Landscape option is enabled, then these values will be 
swapped (i.e. height by width). 

  

Resize Objects Proportionally 
If the Resize Objects Proportionally option is checked, then any changes to the plate size will cause the 
workspace shapes to be resized proportionally. 

  

Advanced Settings 
Click the Advanced button to toggle the display of advanced plate size controls. These controls are used to create 
a plate size that can be added to the Current Selection drop-list. 
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The advanced controls have two lists of plate sizes. The top list contains plate sizes that have yet to be added to 
the Current Selection drop-list. The bottom list contains plate sizes that are available in the Current Selection 
drop-list.  

 

Create and add new plate size 
If the "Create and add new plate size" button is clicked, then the advanced plate size controls will be temporarily 
replaced with controls for entering the new plate size. 

After entering the Name, Width, Height, and Units for the new plate size, click the Add New Plate button. The 
plate size will be added to the bottom list of plate sizes (i.e. it will be available from the Current Selection drop-
list.  
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Add to List 
For a selected plate size in the top list, click the Add to List button to include the plate size in the bottom list (i.e. 
add the plate size to the Current Selection drop-list). 

Delete 
For a selected plate size in the top list, click the Delete button to remove the plate size. 

Remove From List 
For a selected plate size in the bottom list, click the Remove From List button to remove the plate size (i.e. 
remove it from the Current Selection drop-list). However, the plate size will remain available in the top list. 

Display at start up 
If the Display at start up option is enabled, then the Plate Size dialog will open when a new workspace is 
created. 

 
 

PLATE OBJECT  
The Sign Plate Object menu item will create a shape that has the same dimensions and coordinates as the plate 
size. The newly created shape will be placed at the bottom layer order, such that it will appear under other 
workspace shapes. A spot color may then be assigned to the shape for use as a background. 

ZOOM TOOLS 
As a tip, pressing the F8 function key will return the view to the sign plate, which is equivalent to 100% zoom. 
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The zoom functions are summarized as follows: 

  

 
Zoom In [F5] Focus on marquee drawn by cursor. Right-click 

to zoom out. 

 
Zoom Out [F6] Display more area of the workspace. 

  Zoom In [Shift+F6] Alternative method to focus on workspace area. 

 
Zoom to Selected 
Object 

[F7] Fit the viewing area to the selected objects. If 
no objects are selected, then fit to all objects. 

 
Zoom to Plate 
Size 

[F8] Fit the viewing area to the sign plate. 

 
Zoom to Previous 
View 

[F9] Toggle between the current and previous zoom 
levels. 

 
Pan Workspace [Middle 

Button] 
Click-and-hold on workspace, then drag view. 

 
Percent Zoom [Mouse 

Wheel] 
View workspace at a specific zoom level. 

  

ORDER OF WORKSPACE OBJECTS 
Though objects are usually edited in terms of their width and height, workspace objects also have a layering order 
that determines whether an object will appear to be on top of another object. The order of individual objects may 
be modified using the following commands: 

  
To Front [Ctrl + F] Position the selected object before all other objects 

To Back [Ctrl + B] Position the selected object behind all other objects 

Forward [Ctrl + U] Increase the relative position of the object 

Backward [Ctrl + L] Decrease the relative position of the object 

Reverse [Ctrl + M] Invert the relative order for a group of selected objects 
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Circle has a higher layer order than the square 

  

 
Circle has a lower layer order than the square 

  

CUSTOM TOOLBARS  
Toolbars may be customized by right-clicking any of the toolbars. These customize controls are also available 
from the Toolbars flyout (View menu). 

 

 
 

Large Button Icons 
When editing the list of toolbars, the “Use large icons” option is used to access a larger alternative set of icons. 
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Customize 
When a new toolbar has been created, the Customize Toolbar dialog is used to add, remove and rearrange the 
available commands. 

 

 
 

The Customize Toolbar controls are described as follows: 

 

Available 
Toolbar 
Buttons 

This list displays the buttons that are not currently on the Customizable 
Tool Palette. To add a button to the palette, first select the button from 
this list, and then click the Add button. 

Add To add a button to the Customizable Tool Palette, select a button from 
the “Available toolbar buttons” list, and then click the Add button. 

Current 
Toolbar 
Buttons 

This list displays the buttons that are currently on the Customizable Tool 
Palette. To remove a button from this list, first select the button from 
this list, and then click the Remove button. 

Remove To remove a button from the Customizable Tool Palette, select a 
button from the “Current toolbar buttons” list, and then click the 
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Remove button. 

Close Click the Close button to exit the Customize Toolbar dialog. 

Reset The Reset button returns the Customizable Tool Palette to the settings 
that were in effect when the Customize Toolbar dialog was opened. 

Help Press the Help button to access the On-line Help. 

Move Up To increase the priority of a button, first select that button in the 
“Toolbar buttons” list, and then click the Move Up button. 

Move Down To decrease the priority of a button, first select that button in the “Toolbar 
buttons” list, and then click the Move Down button. 

 

SMARTBAR CONTROLS 
SmartBar Controls  

The SmartBar is a special toolbar in Vision-Pro that provides context-sensitive controls according to the type of 
operation that is being edited. When a shape is selected, the SmartBar displays information such as the shape size 
and position. 

 

 
 

Objects Selected 
Objects Selected 

The shape type is listed at the far-left of the SmartBar. Next to the shape type, the number indicates the database 
order of the shape. When pressing [TAB] to advance between different shapes, the [TAB] order is the same as the 
database order. 

  

 
  

Current Nub 
Selecting a shape will reveal its bounding-box, which has nine square nubs that are used for moving, scaling and 
resizing the shape. Within the SmartBar, the anchor controls indicate the current nub. When the SmartBar is used 
to move or resize a shape, the current nub is used as the reference. For example, clicking the lower-left nub in the 
SmartBar will indicate that shapes should be resized with respect to their lower-left bounding box. 
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Selected object Anchor controls 

 

Anchor Nub 
If the anchor nub is clicked in the SmartBar, then a small, "anchor" icon will appear within the bounding box. To 
use the anchor nub, position the anchor over a specific part of the shape. Then, type new X and Y coordinates in 
the SmartBar. The anchor will be moved to the new coordinates, and the shape will be moved with the anchor. 

 

X & Y Coordinates of Mouse/Cursor 
Below the Objects Selected field, the X and Y coordinates of the cursor are displayed, as well as the current units 
of measurement that are being used on the workspace. 

  

 
  

Object Coordinates  
The X and Y fields display the coordinates of the selected object. 

  

 
  

These coordinates may be changed by either dragging the object with the mouse, or by entering a new value in one 
of the fields. If entering new data in a field, then the data will not be accepted until the Enter key is pressed. 

Object Width and Height 
The Width and Height fields display the size of the selected object. 

  

 
  

These dimensions may be changed by either resizing the object with the mouse, or by entering a new value in one 
of the fields. If entering new data in a field, then the data will not be accepted until the Enter key is pressed. 

Object Scale 
The Object Scale fields are used to resize the object as a percentage of its original dimensions. 
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The Object Scale arrows will resize the object in 5% increments. Alternatively, the scale may be changed by 
entering a new value in one of the fields. If entering new data in a field, then the data will not be accepted until the 
Enter key is pressed. 

Aspect Ratio 
When an object is either resized or scaled, the Aspect Ratio button may be maintained by activating this button: 

  

 
  

Rotation 
The Rotation field indicates the degrees through which the object will be rotated. 

  

 
  

The Rotation arrows will rotate the object in 15 degree increments. Alternatively, the rotation may be changed by 
entering a new value in the field. If entering new data in the field, then the data will not be accepted until the Enter 
key is pressed. 

  

Object Color 
At the far-right of the SmartBar, the fill and stroke color for the selected object is displayed. If no object is 
selected, then the default fill and stroke colors are displayed. 

  

 
  

GUIDELINES 
Guidelines 

A guide is a vertical or horizontal reference that is used for placing objects. To create a guideline, right-click on 
the desired ruler location. Objects will then "snap" to the location as they pass over the guideline. 

Note: As many as sixty guidelines in either direction can be displayed on the screen. 

  

Guidelines may be edited by either right-clicking the workspace, or accessing the Guides flyout (Options menu). 

  

As an example, the following steps will create a guideline between two points: 

1.        Right-click the workspace to open the Edit Guides dialog 
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2.        Set the guideline orientation to diagonal 

3.        Choose "2 points" from the drop-down list 

4.        Set the coordinates for both Point 1 and Point 2 

5.        Click the Add button 

  

The resulting guideline will pass through the indicated points. Please note that the Edit Guides dialog will 
automatically simplify the coordinates that were entered. 

  

 
  

Guideline functionality is summarized as follows: 

�       Right-click a ruler to create a guide 

�       For a selected object, press [Shift] and right-click the object handles to create guides (not when editing 
a parametric shape) 

�       To add guides when node editing, press [Shift] and right-click the node 

�       Open the Edit Guides dialog by right-clicking on workspace (when there are no objects selected) 

�       Open the Edit Guides dialog by Options | Guides | Edit Guides 

�       When dragging the position of a guide, press [Shift] to constrain guideline to nearest ruler increment 

�       To remove a guide, press [Shift] and right-click the guide (when there are no objects selected) 

  

Locking the Guidelines 
From the Edit Guides dialog, enable the Lock Guides option to prevent guides from being moved or deleted 
using the mouse. Please note that the Edit Guides dialog may still be used to change a guideline position. 

Locking the guidelines does not prevent them from being deleted from the Edit Guides dialog, or via the Options 
| Guides | Remove All Guides command. 

  

ALIGN PALETTE  
Holding the [Control] key while right-clicking on the workspace will display the Align Palette, which provides 
tools for aligning objects with respect to the grid lines. Typically, these tools are applied to an object nub, though 
they may also be used when node editing. 

 

 
Set Origin Set the grid origin to selected location. 

 
Resize grid Resize the grid increments based on the distance between the 

selected location and the grid origin. 
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Snap to Grid 
Intersection 

Move the object, such that the nub is at the nearest grid 
intersection. 

 
Snap Vertically Move the object, such that the nub is at the nearest horizontal 

grid line. 

 
Snap Horizontally Move the object, such that the nub is at the nearest vertical grid 

line. 

 

If necessary, the origin may be reset by choosing Reset Origin from the Options menu. 

 

 
 

The Grid Size may also be set from the General Preferences dialog. 

WORKSPACE OPTIONS 
Workspace Options 

All the preferences settings for the Vision-Pro workspace are available from the Options menu. 

  

 
  

General Preferences 
General Preferences 

The General Preferences dialog contains basic workspace settings that are generally common to all features. 
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General 

Units 
Unless otherwise specified, the Units set here will be used throughout the Vision-Pro workspace and features. 
Clicking on the workspace rulers may also be used to change the units. 

Speed Units 
If the Engraving module is installed, then the Speed Units are used to specify feed and plunge rates for tool 
paths. 

Weed Offset 
This is the border distance that is maintained around shapes when adding a weed border. 

HPGL Scale 
Set the HPGL Scale to the desired plotter resolution. In the majority of cases, the required setting will be 1016. 
However, consult the manufacturer specifications to verify the required value. 

Layer Number 
The Layer Number toggles the display of color plate numbers. 

Speed Scroll 
If Speed Scroll is active, then dragging over the workspace edges will scroll the workspace. 

Off Disable speed scrolling 

Object Move Only perform speed scrolling when dragging an object. 

Full Perform speed scrolling when dragging an object, or when 
dragging a marquee. 
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Duplicates 
When using the Duplicate command (Edit menu), the Offsets specified here will be used to place the new object 
with respect to the original. 

Grid Size 
The grid dimensions are set here. The Snap Angle is used when the [Control] is held during certain operations, 
such as when editing line segments and corners. 

Polyarc / Polygon 
The Polyarc/Polygon setting indicates the type of shape that is produced by certain features, such as welds, 
shadows, or outlines.  

Warning Dialogs 
Throughout Vision-Pro, warning dialogs are used to allow a new user to consider pertinent details before 
continuing with an operation. As a user becomes more proficient with a given operation, that user may choose to 
disregard further warning dialogs for that operation. A warning dialog may be disregarded by clicking its “Do not 
show this dialog box in the future” option. However, if another new user begins to use Vision-Pro, the Reset 
button will force all warning dialogs to be shown during operations. 

 

 
 

 
 

Other Options and Preferences 
Other Options and Preferences 

The following sections describe options for which their purpose may not be readily apparent. 

Export Error Tolerance 

Undo Setup 

Dialog Box Font Setup 

Selection Tool Settings 

Sketching Tool Settings 

Import Bitmap Setup 

Display Units Dialog 

Automatic Saves 

Snap To Sign Plate 
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Export Error Tolerance 
When exporting a file from Vision-Pro, the resulting file sometimes contains a very large number of nodes. This is 
especially true of artwork that was originally imported from another software. As a solution, Vision-Pro files can 
be exported using a certain tolerance level. This will make the exported artwork smoother, as well as substantially 
reduce the number of required nodes. 

 

 
  

The Error Tolerance is specified in the current workspace units. We caution against a high Error Tolerance value, 
since this may introduce distortions of the exported objects. Generally, the default values (0.001 or 1/1,000 of an 
inch) will work very well with most files. 

Undo Setup 
The Undo Setup dialog is used to limit the resources that are used for storing Undo operations. Limiting the 
resources can prevent the loss of system performance that could occur when large quantities of image data are on 
the Undo stack. 

 

 
  

Dialog Box Font Setup 
The Font Settings dialog is used to specify the font type and point size that are used in Vision-Pro dialog boxes. 
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Use Default Indicates that the standard Windows font should be used. 

Automatic Chooses the most appropriate font to be used. 

Select Enables the dialog font to be chosen. 

  

Selection Tool Settings 
The Selection Settings determines the workspace behavior when shapes are selected and moved using the cursor. 
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Use Live Cursor 
The Live Cursor will recognize when it passes over an object. Note that Vision-Pro must be restarted for changes 
to this option to take effect. 

 

    

      Use Live Cursor (off)                        Use Live Cursor turned (on) 
 

Use Filled Region to Select 
By default, clicking within the filled region of a shape will cause that shape to become selected. However, this 
may not be desirable where a complex workspace has multiple overlapping shapes. If the "Use Filled Region to 
Select" option is disabled, then a shape may then only be selected by clicking the edge of that shape. 

 

Use Default Snapping Range 
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The Snapping Range determines how close a mouse click must be before it snaps to the nearest grid or line. The 
default range is three pixels, though a custom range may be set. 

 

Highlight Selected Objects 
The Highlight selected objects option is used to draw a Highlight Border around selected objects. The Highlight 
size field may be used to make the highlight more prominent, and the Color Picker is used to choose the highlight 
color. 

 

Speed Scrolling 
If Speed Scrolling is active, then dragging off the edges of the workspace will cause the workspace to scroll. 

 

Preview Smoothing 
When a workspace object is being dragged, an image or "ghost" of the object is typically shown. In cases where 
the object is extraordinarily large or complex, only the bounding box for the object will be shown. 

The Preview Smoothing option may be used to modify whether bounding boxes or ghost preview are shown. 
However, note that creating a ghost preview for large objects may impact the responsiveness when dragging the 
object. 

 

 
 

Sketching Tool Settings 
The Sketch Tool Settings are used with the Graphic Creation tools, as well as for editing vector graphics. 

  

 
  

Lines pass through nodes as stated will cause the lines to pass directly through the center of a given node. Lines 
pass near nodes will cause the line to pass near but not touching or over the node. Note that Vision-Pro must be 
restarted for changes to take effect. 
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Lines pass through nodes Lines pass near nodes 

  

Import Bitmap Setup 
When importing a monochrome bitmap, the Bitmap Import Colors Settings dialog will specify the Foreground 
and Background colors of the bitmap. 

  

 
  

 
 

Display Units Dialog 
The Toggle Units dialog specifies the units and precision that are displayed for workspace controls. 

  

 
  

If Show units on controls is enabled, then the current units will be displayed within edit fields, such as on the 
SmartBar. 
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Automatic Saves 
The Automatic Save feature is used to store the current workspace at preset intervals. This protects against the 
loss of work due to system failure, such as Microsoft Windows generating an unrecoverable error. 

The preferred settings are to enable Automatic Save and set the Time between saves to a reasonable value. By 
doing so, the work will be saved periodically in the event of a system failure. 

 

 
 

If a system failure does occur, then restarting Vision-Pro will restore the workspace. 

The amount of work recovered will depend on the Time Between Saves setting. If the time interval is too large, 
then a significant amount of work could be potentially lost when a system failure occurs. However, setting a time 
interval that is too small will cause Vision-Pro to frequently interrupt your work when performing automatic 
saves. 

 

Automatic Load Enabled 
Automatic Load is only valid when the Automatic save option is also enabled. When active, restarting Vision-Pro 
will automatically restore the last workspace that had been stored by the Automatic Save option. 

This feature is useful where Vision-Pro had been shut down using the File..Exit command, but the user had 
neglected to save the workspace. 

 

 
 

When prompted to save, No was clicked, and several minutes of editing were lost. However, if the Automatic 
Load option is enabled, then the lost work will be reloaded when Vision-Pro is restarted. At this point, the 
workspace should be immediately saved to ensure that the data is not lost. 

As discussed with Automatic Save, the amount of data recovered depends upon the Time between saves setting. 

 

Create Backup Files When Saving 
When the Save or Save as commands are used, the backup (.BAK) file will also be created. The backup file will 
have the same preface name as the workspace (.CDL) file, and it will be stored in the same directory. 
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Note: Back up files are a good safety measure against losing work. However, old backup files must be periodically 
purged from the system, since they can potentially consume tremendous amounts of hard disk space.  

 

Snap To Sign Plate 
Selecting this option causes objects to snap to the edges of the sign plate if placed within six pixels of it. Selected 
objects will snap to the sign plate at their outer edges, and at their vertical and horizontal centers. A small check 
mark beside this option indicates that it is selected.
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WORKING WITH LINE ART 
WORKING WITH LINE ART 

Basic Shape Creation 
Basic Shape Types 
Path Editing 
Object Types 
Polygon Editing 
Free Edit Flyout Tool 
Polyarc Editing 
Weld Tools 
Parametric Ruler and Dial 
Label Formatting Rules 
Parametric WASP Barcode 

BASIC SHAPE CREATION 
Basic Shape Creation  

Basic parametric shapes in Vision-Pro are available from the Shape Tools flyout. 

 

 
 

As an alternative to parametric shapes, polygon and polyarc are created using the Graphics Edit Tools flyout. 

 

 
 

 
Node Edit Flyout tool (Polygon editing) 
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Free Edit Flyout tool (Polygon sketching) 

 
Arc Edit Flyout tool (Polyarc editing) 

 

 

 

Ginsu Knife 
The Ginsu Knife tools are used to subdivide a selected shape. These tools are available from the Ginsu Knife 
Tools flyout. 

 

 
 

 
Open path 

 
Close path 

 

The Open path tool will leave the subdivided objects as open paths, whereas the Close path tool will create 
closed paths. 

When a Ginsu Knife tool is chosen, click on the workspace to place one-or-more cutting nodes. The nodes will 
form a cutting line. Where the selected object is intersected by a cutting line, the object will be subdivided. For 
example, refer to the following screenshots: 

 

  
Using the Ginsu Knife tool, one node was After applying the Ginsu Knife operation, 
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placed at the upper-left of the object, and 
the second node placed at the lower-right. 
A cutting line is formed between the two 

nodes. 

the object has been separated along the 
cutting line. 

 

Multiple objects may be part of the selection before applying the Ginsu Knife tool. 

 

BASIC SHAPE TYPES 
Basic Shape Types 

The basic Vision-Pro shapes are created by clicking and dragging to form the shape contour. Parametric shapes 
have extra editing handles that are used to customize the shape appearance. 

  

 
  

Circle Tool 
Circle Tool 

Click-and-drag to form the diameter of a parametric circle shape. The further the drag, the larger the circle that 
will be created. 

Pressing [Shift] will constrain the circle with respect to its center. For example, the following screenshot shows 
two guidelines being used as a starting point. For circle A, the [Shift] key was pressed, such that dragging will 
extend the radius of the circle. In comparison, circle B is being formed without pressing the [Shift] key. 
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SmartBar – Circle Controls 
The following circle properties can be edited from the SmartBar: 

  

�       X Coordinate 

�       Y Coordinate 

�       Radius 

  

  

Ellipse Tool 
Unlike the Circle tool, the Ellipse tool will not create a parametric shape. Instead, the Ellipse tool will create a 
Polygon shape that can be node edited. 

There are no SmartBar controls for the Ellipse tool. Simply click-and-drag to form the ellipse. The further the 
drag, the larger the ellipse that will be created. 

  

 
  

Like the Circle tool, pressing [Shift] will constrain the ellipse with respect to its center. In addition, pressing the 
[Ctrl] key will force the ellipse to form a perfect circle. 

  

Rectangle Tool 
Rectangle Tool 

Click-and-drag to form a parametric rectangle. The further the drag, the larger the rectangle that will be created. 

Press [Shift] to constrain the rectangle with respect to its center. In addition, press the [Ctrl] key to form a perfect 
square. 

There are special handles when editing a parametric rectangle. As per the following screenshot, the upper-left 
handle (A) is used to create notched corners. The upper-right handle (B) is used to create rounded corners. 
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SmartBar – Rectangle Controls 
The following rectangle properties can be edited from the SmartBar: 

  

�       X Coordinate 

�       Y Coordinate 

�       Angle 

�       Width 

�       Height 

  

Polygon Tool 
Polygon Tool 

Click-and-drag to form a parametric polygon. The further the drag, the larger the polygon that will be created. 

Press [Shift] to constrain the polygon with respect to its center. In addition, press [Ctrl] to prevent the polygon 
from rotating as it is being created. 

There are special handles when editing a parametric polygon. As per the following screenshot, the circular handle 
will round the corners of the polygon (A). The semi-circular handle is used to adjust the “Side Bulge Amount”. 

  

 
  

SmartBar – Polygon Controls 
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The following polygon properties can be edited from the SmartBar: 

  

�       X Coordinate 

�       Y Coordinate 

�       Angle 

�       Number of Sides 

�       Polygon Radius (size) 

�       Corner Rounding 

�       Side Bulge Amount 

  

Star Tool 
Star Tool 

Click-and-drag to form a parametric star. The further the drag, the larger the star that will be created. 

Press [Shift] to constrain the star with respect to its center. In addition, press [Ctrl] to prevent the star from 
rotating as it is being created. 

There are special handles when editing a parametric star. As per the following screenshot, the circular handles will 
round the corners of the star (A). The semi-circular handles are used to adjust the side bulge amount. The square 
handles are used to adjust the proportions of the star, which may also be set using Star Radius #1 and Star 
Radius #2 fields in the SmartBar. 

  

 
  

By experimenting with the editing handles, a variety of interesting star shapes can be created. 
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SmartBar – Star Controls 
The following star properties can be edited from the SmartBar: 

  

�       X Coordinate 

�       Y Coordinate 

�       Angle 

�       Number of Points 

�       Inside Radius 

�       Outside Radius 

�       Point Rounding 

�       Corner Rounding 

  

The outside “radius” is the distance from the center to each point of the star. The inside “radius” is the distance 
from the center to each (inside) corner of the star. If the “padlock” icon is active, then the inside radius may be set 
as a percentage of the outside radius. 

  

 
  

Both the points and corners of the star can be rounded. These controls are referred to as Corner Radius #1 and 
Corner Radius #2. 

  

 
 

Arrow Tool 
Arrow Tool 

Click-and-drag to form a parametric arrow. The arrow shape is composed of an arrowhead at the end of a shaft. 
The further the drag, the larger the shaft and arrowhead that will be created. The arrow will point in the direction 
that it is drawn, (i.e. dragging from left-to-right will create an arrowhead that points right). 
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Press [Shift] to constrain the arrow with respect to its center. In addition, press the [Ctrl] key to constrain the 
angle of the arrow. 

There are special handles when editing a parametric arrow, such that the length, width, and barb of the arrow can 
be adjusted. If the SmartBar is used to increase the Rounded Tip Radius, then two small handles will also 
become available for adjusting the arrow tip. 

  

 
  

 
 

By experimenting with the editing handles, the head and shaft can be adjusted to form a variety of interesting 
arrow shapes. 

  

 
  

SmartBar – Arrow Controls 
The following arrow properties can be edited from the SmartBar: 

  

�       X Coordinate 

�       Y Coordinate 
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�       Angle 

�       Total Length 

�       Shaft Length 

�       Total Width 

�       Shaft Width 

�       Head Angle 

�       Forward Bulge of Barb 

�       Read Bulge of Barb 

�       Tip Rounding 

  

To edit the barb bulge using the cursor, hold the cursor over the edge of the arrowhead. Then click-and-drag to 
adjust the bulge. 

 
 

Fan Tool 
Fan Tool 

Click-and-drag to form a parametric fan. The further the drag, the larger the fan that will be created. The fan is 
useful for creating arches, bowls, and rainbows to emphasize text shapes that are on an arc. In addition, the ends of 
the fan can be overlapped to form a ring. 

Press [Shift] to constrain the fan with respect to its center. In addition, press the [Ctrl] key to constrain the angle 
of the fan. 

There are special handles when editing a parametric fan, which are used to adjust the size, position, rotation, 
thickness, and arc of the fan. 

  

 
  

SmartBar – Fan Controls 
The following fan properties can be edited from the SmartBar: 

  

�       X Coordinate 

�       Y Coordinate 

�       Angle 

�       Arc of Fan 

�       Radius of Fan 

�       Thickness of Fan 

�       Length of Fan 
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Monument Tool 
Click and drag to form a parametric monument shape, as would be constructed onsite before a large corporate. The 
further the drag, the larger the rectangle that will be created. 

Press [Shift] to constrain the rectangle with respect to its center. In addition, press the [Ctrl] key to form a perfect 
square. 

There are special handles when editing a parametric monument shape. As per the following screenshot, the top-
center handle (A) is used to adjust the bulge amount. In the SmartBar, the Arch checkbox (B) will add a slope to 
the bulge. 

  

 
  

SmartBar – Monument Shape Controls 
The following monument shape properties can be edited from the SmartBar: 

  

�       X Coordinate 

�       Y Coordinate 

�       Width 

�       Height 

�       Bulge 

�       Arch 

  

  

PATH EDITING 
A workspace object is composed of nodes that specify the contours of that object, otherwise known as the object 
path. If the object contour is complete with no breaks, then it will appear as a solid object on the workspace 
(assuming that Show Fills is active). However, a broken contour will appear as a dashed line. 

  
Make Path Combine a selection of multiple objects into a single path 

Break Path Revert a combined path of objects into individual paths for 
each object 
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Connect Path For a broken contour, connect nodes to form a contiguous 
path 

Reduce Nodes Eliminate excessive nodes that may exist after tracing or 
scanning an object 

Text to Graphics Convert a text object into a path 

Convert to Polygon Substitute the object path with nodes used in polygon 
editing 

Convert to Polyarc Substitute the object path with nodes used in polyarc editing 

Convert to Curves Substitute the object path with equivalent Bezier curves 
(this improves the scaling of objects) 

Close Graphics Join the first and last nodes of a contiguous path 
  
  

OBJECT TYPES 
Object Types  

With respect to workspace object types, there are three broad categories that determine how their nodes are edited. 
The distinction between each type is important because the editing tools are specialized for each object type. 

 

Parametric An object composed using the Shapes flyout tool. As explained in the 
introductory section, these objects have specialized editing handles that 
are used to adjust the object properties. 

Polygon An object composed of a combination of corner, curve and tangent 
nodes. These nodes can be created and edited manually. Please refer 
to the Polygon Editing section. 

Polyarc An object composed entirely of curve nodes. These nodes may also be 
created and edited manually. Please refer to the Polyarc Editing section. 

 

For all object types, editing is performed by double-clicking the object. 

Holding the [Control] key and double-clicking a Parametric object will render it into either a polyarc or polygon, 
depending on the Polyarc / Polygon setting in the General Preferences dialog. 

Node Types 
Node types determine how straight or curved a contour will appear. For object that will be cutting, minimizing the 
number of nodes will reduce the amount of cutting data that is sent. 

The three types of nodes are Corner nodes, Curve nodes, and Tangent nodes, which are defined as follows: 

  

Corner Node A node that is used to construct straight lines. Placing two Corner 
nodes on the workspace will create a straight line. 

Curve Node A node that is used to construct a curved contour. 

Tangent Node A node that is used to provide a smooth transition from a straight 
line to a curved line. 

  

POLYGON EDITING 
Polygon Editing 
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The Node Edit Flyout tool is used for creating and editing Polygons. 

  

 
  

The Arc Edit tool will be active by default, and clicking on the workspace will create a node. As an alternative to 
clicking with the mouse, new nodes can be placed using the dialog bar edit fields. These fields are located at the 
top of the workspace, and the usage of each field depends on whether Polar or Rectangular coordinates are being 
used. 

The Arc Edit controls are summarized as follows: 

  

 
Absolute 

Placement 
New nodes will be placed with respect to the Plate Size 
origin. 

 
Relative 

Placement 
New nodes will be placed with respect to the previously 
created node. 

 
Polar 

Coordinates 

Polar Coordinates are used to place each new node. In 
this mode, the edit fields represent the Angle and Length 
of the new node position. 

 
Rectangular 
Coordinates 

Rectangular Coordinates are used to place each new 
node. In this mode, the edit fields represent the X-
coordinate and Y-coordinate of the new node position. 

  

  

Arc Edit tool 

 
The Arc Edit tool is used to create new nodes for an object. By default, clicking on the workspace will create a 
Corner node. By holding the right-mouse button, the Node Palette can be used to either change the type of node, 
or to edit the existing nodes. 

  

 
  

 
Corner Node 

Tool 
Change the currently-selected node into a Corner node, or 
specify that new nodes must be Corner-type. 

 
Join Tool 

Join two selected nodes, or join the endpoints of a selected 
contour. 

 
Curve Node 

Tool 
Change the currently-selected node into a Curve node, or specify 
that new nodes must be Curve-type. 

 
Toggle 

Rotation Tool 
Toggle the direction of the selected contour between Clockwise 
and Counter-Clockwise. 
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Set Start Point 

Tool 
Set the start point at which routing or engraving this contour will 
begin. 

 
Trash Can 

Tool 
Delete the selected nodes. 

 
Break Tool 

Break the contour at the selected node. 

 
Tangent Node 

Tool 
Change the currently-selected node into a Tangent node, or 
specify that new nodes must be Tangent-type. 

  

  

Node Edit tool 

 
Use the Node Edit tool to either drag or manipulate nodes. Clicking a node will select that node. Shift-clicking 
will add nodes to the current selection, and right-clicking will display the Node Palette. 

When node editing a shape, clicking the fill region of another shape will switch node editing to the other shape. 
When node editing a shape that overlaps another shape, hold the [ALT] key to prevent the accidental selection of 
the underlying shape. 

The following table summarizes the Hot Keys that may also be applied: 

  

Hot Key Function Name Purpose 

A Add node Create a node at the current cursor location. 

C Change node Cycle the type of the selected node. The type will cycle 
through Corner, Curve, and Tangent type nodes. 

R Remove Delete the selected node. 

L Locate origin Set the grid origin to correspond to the selected node. 

G Grid dimensions Resize the grid increments based on the distance between 
the selected node and the grid origin. 

S Snap to intersection Move the selected node to the nearest grid intersection. 

H Snap to horizontal 
grid line 

Move the selected node to the nearest horizontal grid line. 

V Snap to vertical grid 
line 

Move the selected node to the nearest vertical grid line. 

J Join Join the two selected nodes with a connecting line. 

B Break Break the contour at the selected node. 

D Deselect Clear the current node selection. 

O Create perfect circle Based on existing nodes, transform an oval contour into a 
perfect circle. If necessary, nodes will be added to 
complete the circle. 

T Toggle start point Set the start point at which routing or engraving this 
contour will begin. 

K (K)lick Select the node under the mouse cursor. 

  

  

Segment Edit tool 
Segment Edit tool 
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The Segment Edit tool is used to reshape a section of the contour to fit either a straight line, a corner, or a curve. 

To define a segment, select the Segment Edit tool. Notice the small, red circle that now follows the contour of the 
object. 

 
Moving the mouse will also move the circle. Click once to establish the start of a segment. Move the circle to the 
segment end and then click again. The segment is now defined. 

Once the segment is defined, holding the right-mouse button will display the Segment Palette. 

  

 
  

Choose a Segment Palette tool that will be applied to the current segment. The Segment Palette tools are described 
as follows: 

  

Corner Segment Tool 

 
Fit the segment to a corner. When this tool is selected, three handles appear that allow the corner to be adjusted. 
When adjustments are complete, click the Checkmark tool in the Edit Toolbox. 

  
Editing the corner After applying the corner 

  

Arc Segment Tool 

 
Fit the segment to an arc. When this tool is selected, two handles appear that allow the arc to be adjusted. When 
adjustments are complete, click the Checkmark tool in the Edit Toolbox. 
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Editing the arc After applying the arc 

  

Line Segment Tool 

 
Fit the segment to a line. When this tool is selected, the segment will be replaced with a straight line. 

  

Guide Line Tool 

 
Create a guide line that corresponds to the segment. 

  

Trash Can Tool 

 
Delete the segment. If the contour had previously been closed, then it will now be a broken contour. 

  

FREE EDIT FLYOUT TOOL 

 
The Free Edit Flyout tool is used to trace a polygon object by hand. Click and drag across the workspace to draw 
the object. Release the mouse button to create the object. If the start and end strokes are close in proximity, then a 
closed contour will be formed. Otherwise, either use the Close Graphics command from the Arrange menu to 
close the contour, or edit the contour using the Node Edit tool. 

  

POLYARC EDITING 
Polyarc Editing 

 
The Arc Edit Flyout tool is used for creating and editing Polyarcs. 

 
  

The Arc Edit tool will be active by default, and clicking on the workspace will create a node. As an alternative to 
clicking with the mouse, new nodes can be placed using the SmartBar fields.  

  

Snap To 
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As an aid for adding new nodes, the Snap To feature may be used. For more information about this feature, please 
refer to Snapping Setup in the next section. 

  

 
Toggle Snapping 

 
Snapping Setup 

  

  

Placement of each node depends on whether Polar or Rectangular coordinates are being used. The placement 
controls are summarized as follows:  

  

Absolute Placement 

 
New nodes will be placed with respect to the Plate Size origin. 

  

Relative Placement 

 
New nodes will be placed with respect to the previously created node. 

  

Polar Coordinates 

 
Polar Coordinates are used to place each new node. In this mode, the first and second edit fields represent the 
Angle and Length of the new node position. 

  

Rectangular Coordinates 

 
Rectangular Coordinates are used to place each new node. In this mode, the first and second edit fields represent 
the X-coordinate and Y-coordinate of the new node position. 

  

Arc Bulge Mode 

 
In this mode, the third edit field will represent the bulge of the curved line segment. The bulge is used as follows: 

1)       Determine the mid-point of the line segment without a bulge. 

2)       From the mid-point, draw a perpendicular line that is equal in length to the bulge. 

3)       Using the end of the perpendicular line, construct the curved line segment. 

  

Arc Radius Mode 
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In this mode, the third edit field will represent the radius of an imaginary circle. The new line segment will be 
drawn as if it had been traced along the circumference of the imaginary circle, while still connecting the two point 
that would have formed a straight line segment. 

  

Arc Edit tool 

 
The Arc Edit tool is used to create new nodes for an object. For polyarcs, clicking on the workspace will create a 
Curve node. When working on a polyarc object, two curve nodes will form a segment, and then the cursor may be 
used to drag the segment to form an arc. 

  

   
Straight line formed by two 

curve nodes 
Drag line to form arc Release cursor to create the arc 

  

By holding the right-mouse button, the Node Palette can be used to edit the contour. 

  

 
  

 
Join Tool 

Join two selected nodes, or join the endpoints of a selected contour. 

 
Toggle 

Rotation Tool 
Toggle the direction of the selected contour between Clockwise and Counter-
Clockwise. 

 
Set Start Point 

Tool 
Set the start point at which routing or engraving this contour will begin. 

 
Trash Can 

Tool 
Delete the selected nodes. 

 
Break Tool 

Break the contour at the selected node. 

  

  

Node Edit tool 

 
Use the Node Edit tool to either drag or manipulate nodes. Clicking a node will select that node. Shift-clicking 
will add nodes to the current selection, and right-clicking will display the Node Palette. 

When node editing a shape, clicking the fill region of another shape will switch node editing to the other shape. 
When node editing a shape that overlaps another shape, hold the [ALT] key to prevent the accidental selection of 
the underlying shape. 
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The following table summarizes the Hot Keys that may also be applied: 

  

Hot Key Function Name Purpose 

A Add node Create a node at the current cursor location. 

R Remove Delete the selected node. 

L Locate origin Set the grid origin to correspond to the selected node. 

G Grid dimensions Resize the grid increments based on the distance between 
the selected node and the grid origin. 

S Snap to intersection Move the selected node to the nearest grid intersection. 

H Snap to horizontal 
grid line 

Move the selected node to the nearest horizontal grid line. 

V Snap to vertical grid 
line 

Move the selected node to the nearest vertical grid line. 

J Join Join the two selected nodes with a connecting line. 

B Break Break the contour at the selected node. 

T Toggle start point Set the start point at which routing or engraving this 
contour will begin. 

  

  

Segment Edit tool 

 
The Segment Edit tool has been discussed previously under the Polygon editing section. 

  

  

Trim tool 

 
The Trim tool will reduce the length of a line segment, such that it will intersect another line segment. 

  
Click the Trim tool, click segment 

A, and then click segment B. 
Segment A will be reduced in length, 

and it will be joined to segment B. 
  

Extend tool 

 
The Extend tool will increase the length of a line segment, such that it will project to intersect another line 
segment. Note that the projection can be to an "imaginary" intersection point. In the following example, segment 
B is extended to intersect with segment A. 
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Click the Extend tool, click segment 

A, and then click segment B 
Segment B will be projected to the 

imaginary intersection point formed 
with segment A. 

  

Divide tool 

 
The Divide tool will subdivide a line segment with additional nodes. Click the required line segment, and the 
Divide Segment dialog will open. 

  

 
  

Specify the number of new nodes to insert, and then click the Divide button. 

  

Delete tool 

 
After activating the Delete tool, clicking on nodes or line segments will delete them. 

  

Delete Segment tool 

 
The Delete Segment tool is used to remove part of an object path. When active, a small, red circle will track the 
object path. Click once to set the segment beginning, and then click a second time to set the segment end. The 
segment will then be deleted. 

  

Offset Arc tool 

 
For a segment that has been selected using the Segment Edit tool, the Offset Arc tool will create a duplicate 
segment that is offset by the indicated amount. 
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If Double offsets are created, then the offsets will be to either side of the original segment. 

  

Snapping Setup 
Snapping Setup 

The Snap To tools are available when creating nodes in the polyarc editing mode. These tools will identify certain 
workspace coordinates, such as midpoints, intersection points, and the end of line segments. The mouse focus will 
then "snap" to the identified coordinate, and pressing the left-mouse button will create a new node at those 
coordinates. 

  

 
  

A "snap rectangle" is drawn about the cursor, which is used as a limit when identifying coordinates. For example, 
if a midpoint falls within the snap rectangle, then it will be identified as a valid coordinate for the focus. 
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Snap Options 
The Snap Options determine the valid workspace coordinates that will be identified when editing polyarc nodes. 
These options are as follows: 

  

 
Endpoint Snap to the end of a segment, as identified by the existence of a node. 

 
Midpoint Snap to the midpoint of a segment. This may be either a line or curve 

segment, as formed between two nodes. 

 
Any point Snap to a point that is along a segment. This helps to place a node 

that is flush with the given segment. 

 
Perpendicular 
point 

Snap to point so as to form a perpendicular line segment. 

 
Intersection point Snap to intersection point that would be formed by extending two 

line segments. 

 
Center point Snap to center of circle that would be formed by a curved segment. 

 
Bounding box 
point 

Snap to one of the eight nubs (corner, sides, top or bottom) that form 
the bounding box of a given Vision-Pro object. 

  

Show Help Window 
When this option is on, a tooltip will appear to help identify the coordinate that the Snap To tool has found. 

  

Show Snap Rectangle 
The Show Snap Rectangle option toggles the visibility of the snap rectangle. Though not visible, the bounds of 
the rectangle will still be used to identify valid workspace coordinates. 

  

Snap Dimensions 
The Snap X Radius and Snap Y Radius determine the width and height of the snap rectangle. 

  

WELD TOOLS 
Weld Tools  

The Weld Tools are used to bond overlapping shapes into a combined object. 
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Non-welded Lettering Welded Lettering 

 

The resulting object type will be either polyarc or polygon, depending on the Polyarc / Polygon setting of the 
General Preferences dialog. 

The Weld tools are accessible through the Weld Tools flyout: 

 

 
 

The available welds are: 

 

 
Basic (Fuse / Color) Weld 

 
AND Weld 

 
XOR Weld 

 

About Complex Welds 
There is an upper limit for the number of nodes that can be processed during a weld. This limit is based on the 
amount of physical memory available. 

If a weld is attempted and an error message is received (such as stack overflow), then break the welded objects 
into two portions before applying the weld. Doing this will reduce the number of nodes in each weld. Once each 
portion is welded, both portions can be welded into the final object. 

 

 
 

Basic (Fuse / Color) Weld 
Basic (Fuse / Color) Weld 

 
 

Fuse Weld 
Color Weld 
Using Color Weld 

Fuse Weld 
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The Fuse Weld tool is used to merge selected objects of the same color layer into one combined object. This tool 
is useful when working with script fonts that have a “lead-in” and “lead-out” (kerning) on each character that 
overlaps the adjacent letter. 

 
  

Unless the overlapping letters are welded, the letters will be cut with overlapped cutting lines. The Fuse Weld tool 
removes those overlaps to make script-lettering flow together as a single object. 

 
  

Note: Welding will automatically apply the Text to Graphics command (Arrange menu). 

  

 
 

Color Weld 
The Color Weld tool is used to delete overlapping sections between two different objects in separate color layers. 
Welding will reshape objects, such that underlying portions are removed. 

The following image shows two objects with their fills turned off. With respect to their layer orders, the star is 
resting above the circle shape. 

 
  

After the weld is applied, the star shape is unchanged, but the underlying circle shape has been modified. 
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If an object has the same color as that of either the sign plate or workspace background, then that object will be 
discarded. A warning dialog will query for confirmation before discarding takes place. 

  

 
 

Using Color Weld 
The Color Weld feature can create some interesting visual effects, such as ‘pinstripes’ and ‘knock-outs.’ The 
following screen shots demonstrate pinstripes: 

 
Two objects (the stripes have a hairline 

edge for clarity) 
  

 
The two objects overlapped.  Note the 

stripes are the same color as the sign plate 
or background. 

  

 
The result after color welding 

  

 
 

AND Weld  



Working With Line Art 

53 

 
The AND Weld will generate a combined object that is composed of only overlapping sections of the original 
objects. 

 

  
Two objects prior to weld Result of performing 

AND weld 

 

The resulting object is defined by the area where the two circles overlap, and is the same color as the previously 
hidden portion. 

 
 

The AND Weld tool is used for graphical effects such as fancy clipping as follows: 

 

  
Initially, a simple background pattern was 

created. For the text object, both a Duplicate 
and Outline were applied. 

Select the text object and pattern together. 

 

  
Applying the AND weld produces an 

interesting pattern. 
The Duplicate and Outline that were created 

earlier serve to enhance the effect. 
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Note: Only two overlapping objects or group of objects can be welded at the same time. If there are three or more 

objects that overlap at the same location these must be organized into two groups before they can be welded.   

 

 
 

XOR Weld 

 
The XOR Weld (Exclusive-Or Weld) will produce an object that is composed only of sections that did not 
overlap in the original objects. 

 

  
Two objects prior to weld Result of performing XOR 

weld 

 

The XOR Weld is useful for creating unique special effects: 

 

  
Text is placed over a sphere Applying the XOR Weld produces this 

"punched out" result. 
 

Note: Only two overlapping objects or groups of objects can be welded at the same time. If there are three or more 
objects that overlap at the same location, they must be organized into two groups before they can be welded. 

 

PARAMETRIC RULER AND DIAL 
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Parametric Ruler and Dial 
The Parametric Ruler and Dial are instant shapes that are available from the Shape Tools flyout. 

  

 
  

The Parametric Ruler Shape 
The Parametric Ruler Shape 

The Parametric Ruler Shape is an object that can be created on the workspace, much like a parametric circle or 
rectangle. Like other parametric shapes, the parametric ruler has handles that are used to adjust the ruler properties 
on the workspace, and additional SmartBar controls are also available. 

To create a parametric ruler shape, choose the Ruler button from the Shape Tools flyout. 

  

 
  

After choosing the Ruler button, click and drag within the workspace to form the initial coordinates, length, and 
angle of the ruler shape. The ruler will be automatically subdivided into equal sections, as indicated by the major 
ticks that are marked along the ruler. 

  

 
  

In the above screenshot, a basic ruler shape is shown that has no extra settings. This ruler shape is shown as 
having five "major ticks," which are drawn perpendicular to the ruler angle. 

 
 

In contrast, the following screenshot shows the same ruler shape, except that labels, minor ticks, and a baseline 
have been added. 
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At each end of the ruler shape is a handle that is used to modify the placement of the ruler. 

  

 
  

Edits to the ruler shape are displayed within the SmartBar. 

  

 
  

The SmartBar controls are described as follows: 

  

Coordinates of ruler shape 
At the far-left of the SmartBar are the coordinates at which the ruler shape is placed on the workspace. With 
respect to these coordinates, the Length and Angle values are used to construct the ruler shape. 

Length 
The Length field indicates the physical length of the ruler shape on the workspace.  

Angle 
The Angle field indicates the rotation of the ruler. If the Angle is zero, then the ruler extends from left-to-right, 
starting from the ruler coordinates, and extending as far as the Length value. 

Thickness 
The Thickness field indicates the thickness of the ruler baseline and ticks. If the Thickness value is zero, then the 
ruler baseline and ticks will be drawn as hairlines. 
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Draw base line 
If the Draw base line option is enabled, then the ticks will be connected ala a baseline. Disable this option to draw 
the ticks without a baseline. 

Tick Positions 
The Tick Positions drop-list is used to choose the style of the ticks. The ticks may be place either Above, Below, 
or Centered on the baseline. 

Minor tick marks 
Click the Minor tick marks button to open the Minor Ticks dialog. 

  

 
  

Up to three sets of minor ticks may be created. For example, suppose that the following settings are used to create 
one set of minor ticks: 

  

1 Number of minor ticks 

0.30 Size of Tick 1 

2 Number of spaces for Tick 1 

  

 
 

The Minor Ticks dialog will appear as follows: 

  



Vision-Pro 7 Doc Files 

58 

 
  

  

Click OK to accept the new settings, and the ruler shape will be updated on the workspace. 

  

  
The basic ruler shape with no minor ticks. 
The ruler is subdivided into four sections. 

The same ruler shape, except that one set 
of minor ticks has been created. Each 

section has been subdivided into two sub-
sections. 

  

Labels and major ticks 
Click the Labels and major ticks button to open the Major Ticks dialog. 
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Tick spacing 
If the Fixed number option is enabled, then the length of the ruler will be divided equally according to the 
Number of ticks setting. The length of each segment will depend upon the ruler length, as divided by the number 
of ticks. 

If the Fixed distance option is enabled, then the distance between each tick will be set according to the Distance 
between ticks setting. On the workspace, major ticks will be created or removed to correspond to the ruler length. 

Size of tick 
Each tick is drawn perpendicular to the ruler length. The Size of tick field indicates the length of each major tick. 

Tick labels 
If the Print labels option is enabled, then each major tick will be numbered. 

Note: If a label font has not been selected, then the Font Detective dialog will open. When the desired label has been 
selected, click the Select button to close the Font Detective. 

Label Orientation 
Below the Print labels option, the drop-list indicates the Orientation of the labels. If printed Horizontally, then 
the labels are oriented with respect to the workspace x-axis. If printed "On Ticks," then the labels are oriented 
with respect to the ruler length. 
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Start Number and Increment 
The Start number indicates the numeric value that is assigned to the first major tick. Each subsequent major tick 
will then be assigned a value according to the Increment value. 

Note: Values are rounded according to the label format. Please refer to the Label Formatting Rules section for more 
information. 

  

Label font size 
The size of the label font is expressed as a decimal percentage of the distance between each major tick. For 
example, a Label font size of 0.15 is equivalent to 15% of the distance between each major tick. 

Select Label Font 
To change the font of the labels, click the Select Label Font button. The Font Detective dialog will open. When 
the font is chosen, click the Select button to close the Font Detective. 

Label Format Rules 
To set the format of the labels, click the Label Format Rules button. 

Note: Please refer to the Label Formatting Rules section for more information. 

  

The Parametric Dial Shape 
The Parametric Dial Shape 

The Parametric Dial Shape is similar to the parametric ruler shape. To create a parametric dial shape, choose the 
Dial button from the Shape Tools flyout. 

  

 
  

After choosing the Dial button, click and drag within the workspace to form the initial coordinates and radius of 
the dial shape. The dial will be automatically subdivided into equal sections, as indicated by the major ticks that 
are marked along the dial. 
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In the above screenshot, a basic dial shape is shown that has no extra settings. This dial shape is shown as having 
five "major ticks," which are drawn perpendicular to the dial path. 

 
 

In contrast, the following screenshot shows the same dial shape, except that labels, minor ticks, and a baseline 
have been added. 

  

 
  

Workspace handles are placed about the dial shape, which may be used to modify the dial parameters. 

  

 
  

The dial handles are used to set the following dial parameters: 

  

A Coordinates 

B Radius 

C Start Angle 

D End Angle 

  

  

Edits to the dial shape handles are displayed within the SmartBar. 
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Coordinates of the dial shape 
At the far-left of the SmartBar are the coordinates at which the dial shape is placed on the workspace. With respect 
to these coordinates, the Start Angle, End Angle, and Radius are used to construct the dial shape. 

Start Angle and End Angle 
The Start Angle and End Angle indicate the dial arc. By default, the dial will be drawn clockwise from the Start 
Angle, and it will terminate at the End Angle. 

Radius 
The Radius field indicates the size of a "circle," upon which the dial will modeled. 

Thickness 
The Thickness field indicates the thickness of the dial baseline and ticks. If the Thickness value is zero, then the 
dial baseline and ticks will be drawn as hairlines. 

Direction 
The Direction button toggles the dial orientation between Clockwise and Counter-Clockwise. Depending on the 
orientation, the dial will be formed between the Start Angle to the End Angle. 

Draw base line 
If the Base line option is enabled, then the ticks will be connected ala a baseline. Disable this option to draw the 
ticks without a baseline. 

Tick Positions 
The Tick Positions drop-list is used to choose the style of the ticks. The ticks may be place either Above, Below, 
or Centered on the baseline. 

Minor tick marks 
Click the Minor tick marks button to open the Minor Ticks dialog. 
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Up to three sets of minor ticks may be created. For example, suppose that the following settings are used to create 
one set of minor ticks: 

  

1 Number of minor ticks 

0.30 Size of Tick 1 

2 Number of spaces for Tick 1 

  

The Minor Ticks dialog will appear as follows: 

  

 
  

 
 

Click OK to accept the new settings, and the dial shape will be updated on the workspace. 
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The basic dial shape with no minor ticks. 
The dial is subdivided into four sections. 

The same dial shape, except that one set of 
minor ticks has been created. Each section 
has been subdivided into two sub-sections. 

  

Labels and major ticks 
Click the Labels and major ticks button to open the Major Ticks dialog. 
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Tick spacing 
If the Fixed number option is enabled, then the length of the dial will be divided equally according to the 
Number of ticks setting. The length of each segment will depend upon the dial arc, as divided by the number of 
ticks. 

If the Fixed distance option is enabled, then the distance between each tick will be set according to the Distance 
between ticks setting. On the workspace, major ticks will be created or removed to correspond to the dial arc. 

Size of tick 
Each tick is drawn perpendicular to the dial arc. The Size of tick field indicates the length of each major tick. 

Tick labels 
If the Print labels option is enabled, then each major tick will be numbered. 

Note: If a label font has not been selected, then the Font Detective dialog will open. When the desired label has been 
selected, click the Select button to close the Font Detective. 

Label Orientation 
Below the Print labels option, the drop-list indicates the Orientation of the labels. If printed Horizontal, then the 
labels are oriented with respect to the workspace x-axis. If printed "On Ticks," then the labels are oriented with 
respect to the dial arc. 

Start Number and Increment 
The Start number indicates the numeric value that is assigned to the first major tick. Each subsequent major tick 
will then be assigned a value according to the Increment value. 

Note: Values are rounded according to the label format. Please refer to the Label Formatting Rules section for more 
information. 

  

Label font size 
The size of the label font is expressed as a decimal percentage of the distance between each major tick. For 
example, a Label font size of 0.15 is equivalent to 15% of the distance between each major tick. 

Select Label Font 
To change the font of the labels, click the Select Label Font button. The Font Detective dialog will open. When 
the font is chosen, click the Select button to close the Font Detective. 

Label Format Rules 
To set the format of the labels, click the Label Format Rules button. 

Note: Please refer to the Label Formatting Rules section for more information. 

  

LABEL FORMATTING RULES 
Label Formatting Rules 

The Label Format Rules are used to define the appearance of labels on parametric ruler and parametric dial 
shapes. For either type of shape, the label format may be set on the Major Ticks dialog by clicking the Label 
Format Rules button. The following dialog will open: 
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From the Defined Format Codes list, choose the formatting of the ruler or dial labels. When a format is clicked, 
the Sample Output field will display the results of applying that format to the Input Data field. 

Enable the Filter by Numbers option to display formats that are useful for numeric values. Enable the Custom 
option to display only formats that you have created. 

 
 

Creating a custom label format 
Click the Create/Edit Custom Format button to create a custom format. The following dialog will open. 
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For the Expected Input Data Type options, choose the type of format. For numeric labels, choose Integer. The 
Sample Input field will be reset according to the chosen format. 

In the Define Format Code field, enter the codes that will make up this custom label format. As edits are made to 
the Define Format Code field, the Sample Output field will display the result of applying the format to the 
Sample Input field. 

Format Codes 
Format Codes 

The following is a list of format codes that may be entered in the Define Format Code field. More than one 
format code may be used, though an incorrect arrangement of codes will produce a nonsensical result. 

Numeric Formatting 
Numeric formatting is divided into three categories: Symbols, Flags, and Negative formats. 

Symbols 
There are several characters that are used to indicate a special purpose or symbol. These characters are 
summarized as follows. 

  

# The '#' (hash) symbol is used to display a significant digit. More than one '#' symbol 
may be placed to either the left or right of the decimal point. 

0 The '0' (zero) symbol is used to display significant digits, though more than one '0' 
symbol may be used to create either leading or trailing zeroes. 

\ 

The '\' (backslash) symbol is referred to as an "escape" character, which is used to 
prevent a symbol from being interpreted as a formatting code. For example, the '#' is 
automatically interpreted to indicate a significant digit. But if the '#' is preceded by a 
backslash, ala "\#", then the '#' will be printed as a normal character. 

The '\' symbol may be used as an escape sequence for: ‘0’ (zero), ‘#’ (hash), ‘\’ 
(backslash), ‘[‘ (open square bracket), ‘]’ (close square bracket),‘;’ (semicolon), and 
‘-‘ (dash). 

  

 
 

Several examples are provided here to help demonstrate how these symbols are used: 

  

Sample Input Define Format Code Sample Output 

123 # 123 

123 #.# 123 

123 #.00 123.00 

123 0000.00 0123.00 

123 \[0000\] [0123] 

123 \\\\# \\123 

  

Flags 
Flags are special codes that are used to modify the label format. Flags are always placed between the square 
brackets '[' and ']'. The available flags are described as follows: 

  

[Tc]This flag is used to insert a thousands place character. For example, the first thousands place character will 
be inserted at the fourth position left of the decimal point, and additional characters will be placed at each 3rd 
power of ten. The 'c' indicates the type of character to use as a separator. If 'c' is not specified, then a ' ' (space) 
character will be used as the thousands place character. 
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[Dc]This flag is used to indicate the decimal point that separates the whole part from the fractional part. By 
default, a '.' (period) will be used as the decimal point. If the [Dc] flag is used, then the 'c' indicates an alternative 
character to used as the decimal point. 

[Rc]This flag indicates any rounding that should occur. If the [Rc] flag is not specified, then natural rounding will 
be used as default. However, the 'c' indicates alternative type of rounding. If 'c' is '-' (minus sign), then rounding 
down will always occur. If 'c' is '+' (plus sign), then rounding up will always occur. 

[Ef]  Indicates to use scientific notation to display value.  The format f specified is a simple number format using 0 
and # only.  When E is specified, the number of 0’s and #’s indicate the field length in the decimal part of the 
format code.  This indicates the number of significant digits to display, and thus the amount of the exponential 
value to apply to use in the scientific notation. 

[C]   Conditional flag.  C is of format [{<,<=,>,>=,<>}X] where X is a number.  When defining the conditional 
flag, two sets of format code are given, separated by a semi-colon.  The first code is used if the condition C is true, 
the second code is used if the condition C is false.  If a second format code is not given, then if the number is false, 
an error will return.  

[NX:Y]            Range flag.  The input value must fall between the values of X and Y where X > Y.  If the value is 
not within this range, an error is returned. 

  

Sample Input Define Format Code Sample Output 

123456.123456 [T,]# 123,456 

123456.123456 [D:]###### 123456:123456 

123456.123456 [R-]#.## 123456.12 

123456.123456 [R+]:#.## 123456.13 

  

Negative Formats 
The following formats indicate how a negative value should be displayed: 

  

[\] Display the negative sign '-' to the left of the value. 

[/] Display the negative sign '-' to the right of the value. 

[(] Enclose the value with parentheses ( ). 

  

 
 

Text Formatting 
For text formatting, the '@' sign is an input string placeholder. Input text will be placed at the location specified by 
the '@' symbol. If the '@' symbol appears multiple times, then each '@' symbol will designate one word from the 
input string. 

  

Flags 
The following codes must be contained within square brackets [ ] for global formatting, and between braces { } 
for local formatting. All flags between braces apply to the '@' character that immediately follows the braces. 

Note: When inserting a string literal, the “, [, and ] characters must be typed as escaped characters. This remains true 
for characters that are enclosed within double quotes. 

  

Fx Used to indicate the number of characters (x) to output. If x is either negative 
one (-1), or this flag is not specified, then all characters of the input text will be 
displayed. 
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P{l,r}:c Padding (or trimming) that is applied to text. Use 'l' or 'r' to indicate either left 
or right padding. The 'c' indicates the number of characters used for padding. If 
'c' is not specified, then there will be no characters for padding, but the text can 
be trimmed left or right. 

U Make all text upper-case 

L Make all text lower-case 

  

Date Formatting 
The following codes are used to apply date and time formatting: 

  

D Day as number of the month 1 – 31 

DD Day as number of the month  01 – 31 

DDD Day as short name Sun – Mon 

DDDD Day as long name Sunday – Monday 

DDDDD Day as number of the year 001 – 356 

  

M Month as number 1 – 12 

MM Month as number 01 – 12 

MMM Month as short name Jan – Dec 

MMMM  Month as long name January – December 

  

  

Y Year as 2 digit number 

YY Year as 2 digit number 

YYY Year as 4 digit number 

YYYY Year as 4 digit number 

  

h Hour as 12 hour clock 1 – 12 

hh Hour as 24 hour clock 00 – 23 

  

m Minute as number 00 – 59 

mm Minute as number 00 – 59 

  

s Second as number 00 – 59 

ss Second as number 00 – 59 

  

A Show the AM/PM symbol 

  

Note: A text literal that is within the date formatting must be enclosed with double quotes " ". This includes escape 
characters that use backslash. 

  

PARAMETRIC WASP BARCODE 
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Parametric WASP Barcode 
A barcode is an arrangement of vertical lines (of varying thickness and spacing) that form a machine-readable 
label. Depending on the type of barcode, the label can contain either numeric or alphanumeric data, which may 
then be scanned using a barcode reader. 

  

 
  

To create a parametric barcode shape, choose WASP Barcode from the Shape Tools flyout. 

  

 
  

The barcode controls will become available within the SmartBar. 

  

 
  

Bar Height 
Bar Height 

Specifies the height of the barcode shape, as expressed in current workspace units. The minimum bar height is 0.2 
inches. 

Bar Width 
Specifies the width of a narrow bar (sometimes called the X dimension) in the current workspace units. The 
minimum bar width is 0.0075 inches. 

The UPC/EAN/JAN barcode sizes are specified as a percentage of nominal rather than an actual bar width. 
Consequently, valid ranges for this field are 80 to 200 for the UPC/EAN/JAN symbologies. 

Since the PostNet symbology is of a fixed width, this field is not used. 

Bar Ratio 
Specifies the wide-to-narrow bar ratio. For example, a Bar Ratio of 2.5:1 indicates that a wide bar is 2.5 times the 
width of a narrow bar. 

This parameter has a valid range from 2.0:1 to 3.0:1, and it is only used with the following barcode types: Code39, 
Interleaved 2 of 5, Codabar, and MSI. 
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Value 
The Value field is used to type the barcode characters that will be encoded into the barcode. Please note that each 
type of barcode has its own rules concerning the entry of numbers, letters, and extended characters. Later this 
chapter, the Barcode Symbology section discusses each barcode type, including the valid characters. If an invalid 
character is typed and the Apply button clicked, then a warning dialog will prevent the barcode from being 
created. 

For some barcode symbologies, only numeric or a limited selection of alphabetical characters are allowed. Some 
of the more flexible symbologies can encode the ASCII table (values 0-127), though only a few symbologies 
support the extended ASCII table (values 128-255). Where the barcode symbology supports encoding of the full 
ASCII character set, a special method of entering non-printing ASCII characters is required. Three such methods 
are available: 1) using the character picker on the SmartBar, 2) using a Tilde escape sequence, and 3) using the 
[Alt] key in combination with the numeric keypad. These two methods are discussed as follows: 

  

Character Picker 
To the right of the Value field is the Character Picker button. 

  

 
  

Click the Character Picker button to expand a pop-up list of all the valid characters for the chosen barcode 
symbology. Click a character within the pop-up list, and that character will be inserted into the Value field. 

  

 
  

For some symbologies, the pop-up list displays non-printing characters as a Tilde Escape Sequence. The Tilde 
Escape Sequence is described within the following sub-section. 

Tilde Escape Sequence 
The [Tilde] character may be used to enter the ASCII value for a character that could not otherwise be entered 
within the Barcode text edit field. The [Tilde] key is located near the top-left of the keyboard, usually just below 
the [Esc] key, and to the left of the [Number 1] key. To create a [Tilde] character, press [Shift + Tilde]. 

Note: This documentation describes a standard QWERTY keyboard configuration. Where custom key assignments 
have been performed, please refer to the notes that were provided with the given keyboard. 

  

Once the [Tilde] character ( ~ ) has been entered, type the three-digit value for the ASCII character. For example, 
type ~065 to create the letter ‘A’. In ASCII code, the value 65 represents ‘A’, 66 represents ‘B’, 67 represents ‘C’, 
and so on. Likewise, a non-printing ASCII character value may be specified. However, please note that a three-
digit value must follow the [Tilde] character. For this reason, a two-digit ASCII value like 67 must be padded with 
a zero (067). 

For any tilde sequences within the Barcode text field, translation into ASCII will not occur until the Apply button 
has been clicked. Once the Apply button is clicked, each tilde sequence will be converted into its corresponding 
ASCII character, and then the Barcode text field will be encoded as barcode data. 
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Alt and the Numeric Keypad 
As an alternative to entering a [Tilde] sequence, Windows provides a means of entering an ASCII value that will 
be immediately converted into its corresponding ASCII character. This provides the ability to enter values 128-
255 (extended ASCII), which otherwise would not be accessible using a standard keyboard. Unfortunately, the 
disadvantage of this technique is that non-printing ASCII characters will be ignored (i.e. values 0-31). 

To create an extended ASCII character: 

  

1)       Click within the Barcode text field to indicate where the character should be inserted. 

2)       For the numeric keypad of your keyboard, verify that [Num Lock] is enabled. 

3)       Press the [Alt] key, but do not release it yet. 

4)       Using the numeric keypad, type the three-digit value that corresponds to the desired ASCII character. 

5)       Release the [Alt] key. 

  

The desired ASCII character will then be inserted within the Barcode text field. If the ASCII value is of a non-
printing character (000-031), then no character will be inserted. 

Barcode Symbology 
Below the Value field, the drop-list is used to choose the barcode symbology that will be applied when encoding 
the characters. The choice of symbology determines both the available SmartBar controls, and the characters that 
may be entered within the Value field. 

The barcode symbologies are discussed later in this section. 

Caption Settings 
To the right of the Value field, click the ellipsis button to open the Barcode Caption Features dialog. 

  

 
  

The Barcode Caption Features dialog is used to specify the font, point size, and style of the barcode caption.  
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The Caption position indicates the placement of the caption with respect to the barcode. Please note that some 
barcode symbologies restrict the caption placement. As such, an invalid caption placement will be ignored. 

Checksum 
Specifies whether to calculate and apply a checksum character to the barcode. The checksum method depends 
upon the barcode type. 

Note: This option is only used for the following barcode types: Code39, Interleaved 2 of 5, Codabar, and MSI Plessey. 
For MSI Plessey, disabling this option indicates one modulo 10 check digit, and enabling this option indicates two 
modulo 10 check digits. 

  

Append 
Certain symbologies allows several individual barcodes to be concatenated into a single, long barcode. Each 
barcode is printed as per a regular barcode. However, when the barcodes are later scanned, the reader will 
recognize that the barcodes must be concatenated. 

For example, suppose that three Code 128 barcodes (A, B, and C) must be concatenated. When creating barcode 
A, enable the Append option. When creating barcode B, enable the Append option as well. However, when 
creating barcode C, disable the Append option. Later, when these barcodes are being scanned, the following 
actions will occur: 

  

�       Barcode A will be identified as requiring concatenation with a subsequent barcode. 

�       Barcode B will be appended to Barcode A. However, Barcode B will also be identified as requiring 
concatenation with a subsequent barcode. 

�       Barcode C will be appended to Barcodes A and B. The barcode reader will recognize that no further 
barcodes need be appended. 

�       The result will consist of the concatenated data from barcodes A, B, and C. 

  

To continue appending barcodes in this fashion, simply create more barcodes with the Append option enabled. 
For the last barcode in the sequence, disable the Append option. 
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Rotation 
The Rotation drop-list is used to specify the bar code angle. The fixed angles are 0°, 90°, 180°, and 270°. 

  

Barcode Symbologies 
Barcode Symbologies 

A barcode symbology is a set of rules for encoding data, such that a scanning device may use the same rules to 
extract the data. Depending upon the sophistication of the barcoding system, the data may describe a variety of 
details about the scanned item, or the data may simply be a lookup value for a database. 

From the SmartBar, choose the Barcode Symbology from the drop-list. 

  

 
  

The available barcode symbologies are described in the following sections. However, it is beyond the scope of this 
documentation to provide specifications for each barcode symbology. Instead, there are standards agencies that 
will provide printed specifications for each barcode symbology. As a general rule, your client should indicate the 
barcode symbology that will be used, as well as any custom functionality (if any). 

Codabar 
Codabar is a variable-length symbology that is capable of encoding 16 characters within any length message. In 
addition to numeric values (0-9), the capital letters A through D are valid, as well as the following characters: 

  

- Dash 

$ Dollar Sign 

: Colon 

/ Forward Slash 

. Period 

+ Plus Sign 

  

Start/Stop Characters 
The capital letters A through D are used as start and stop characters. For example, the string “A6479309B” 
indicates that ‘A’ is the start character, and ‘B’ is the stop character. 

Checksum 
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If the Checksum option is enabled, then a modulo 16 check character will be used to enhance data security for 
Codabar barcode. The last digit of the barcode is assumed to be the check digit, and it is compared to a calculated 
check digit to verify the barcode. 

Code 128 
The Code 128 symbology can encode the ASCII character set (0-127). Code 128 is the most easily read code with 
the highest message integrity due to several separate message check routines. 

Of all the common linear symbologies, Code 128 is the most flexible. It supports both alpha and numeric 
characters easily, has the highest number of characters per inch, and is variable length.  Code 128 is usually one of 
the best choices when implementing a new symbology. 

Code 39 - Standard 
Code 39 is an alphanumeric symbology that can encode numbers (0-9), capital letters (A-Z), a space character 
(ASCII 32), and the following four special characters: 

  

$ Dollar Sign 

/ Forward Slash 

+ Plus Sign 

% Percentage Sign 

  

If lower-case letters (a-z) or other ASCII must be encoded, then please refer to Code 39 – Full ASCII, discussed 
in the next section. 

Checksum 
If the Checksum option is enabled, then a modulo 43 check character will be used to enhance data security for the 
Code 39 barcode. The last digit of the barcode is assumed to be the check digit, and it is compared to a calculated 
check digit to verify the barcode. 

Code 39 – Full ASCII 
The Code 39 – Full ASCII symbology is an enhancement upon Code 39 – Standard, where the four special 
characters are used to encode the ASCII character set (0-127). This is done by pairing one of the special characters 
($, /, +, %) with a letter (A-Z). When the given pair of characters are scanned by a barcode reader, they will 
interpret the result as an ASCII character. 

Vision-Pro will automatically generate the necessary character pairs, based on the Barcode text that has been 
entered. For example, if lowercase ‘a’ is typed in the Barcode text field, then clicking Apply will cause the 
lowercase ‘a’ to be translated to “+A” within the barcode. A barcode reader will then interpret the “+A” as being a 
lowercase ‘a’. 

Code 93 
Code 93 is an alphanumeric symbology that can encode the ASCII character set (0-127). Simply type the required 
ASCII characters within the Barcode text field. 

Background 
Like Code 39, the Code 93 symbology encodes numbers (0-9), capital letters (A-Z), a space character (ASCII 32), 
and the following four special characters: 

  

$ Dollar Sign 

/ Forward Slash 

+ Plus Sign 

% Percentage Sign 

  

However, Code 93 also uses four shift characters: [S1], [S2], [S3], and [S4]. These shift characters are used in 
combination with the basic Code 93 characters to encode the entire ASCII character set. 
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Vision-Pro will automatically insert any shift characters that are necessary for the encoding. For example, if 
lowercase ‘b’ were typed in the Barcode text field, then clicking Apply will cause the lowercase ‘b’ to be 
translated to “[S4]B” within the barcode. A barcode reader will then interpret the “[S4]B” as being a lowercase 
‘b’. 

 
 

DataMatrix 
The DataMatrix symbology is a two-dimensional symbology, where data is encoded in both the horizontal and 
vertical planes. In contrast, a one-dimensional symbology, such as UPC-A, encodes data from left-to-right. 
Whereas reading the UPC barcode is performed using a linear barcode reader (such as a wand), the DataMatrix 
code requires a two-dimensional scanner. 

The DataMatrix symbology can encode values 0-127 (ASCII character set), and values 128-255 (extended ASCII). 

Entering Barcode Text 
The data for a DataMatrix barcode must be read from a text file, where whitespace is considered to be the 
delimiter between each data element (whitespace characters are the space character, tab, and newline). From the 
SmartBar, click the ellipsis button that is next to the Value field. 

  

 
  

The Open dialog may then be used to choose the text file that contains the barcode data. Choose the data file and 
click Open. The focus will return to the SmartBar, where the chosen filename will appear within the Barcode text 
field. 

  

 
  

Click Apply to create the DataMatrix barcode. The shape will appear similar to the following. 
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EAN/JAN-13 
The abbreviation EAN/JAN refers to European Article Numbering/Japanese Article Numbering. The EAN-13 
symbology is a superset of the UPC-A symbology that is used in North America. The EAN-13 symbology was 
implemented because the UPC-A symbology was insufficient for international use. 

Like UPC-A, the EAN-13 symbology contains a manufacturer code and a product code. However, where UPC-A 
encodes twelve digits, the EAN-13 symbology encodes a thirteenth digit. The thirteenth digit is used as part the 
number system to indicate the country or economic region that had assigned the manufacturer code (to a specific 
company). 

The JAN-13 symbology is simply EAN-13, where the country code is 49. 

Note: Since EAN-13 is a superset of UPC-A and requires very little additional effort to handle than an UPC-A code, it 
is recommended that all new designs implement EAN-13 rather than UPC-A. Otherwise, the design will be restricted to 
the U.S. and Canada. In addition, the UCC Council has announced that as of January 1, 2005, all barcode systems in 
the U.S. and Canada must be able to handle EAN-13 barcodes, such that international manufacturers do not have to 
worry about printing a different barcode for products shipped to North America. 

  

The nominal height for the EAN/JAN-13 bar code is one inch. The reduced size is 80% of the nominal size. 

EAN/JAN-8 
The abbreviation EAN/JAN refers to European Article Numbering/Japanese Article Numbering. 

EAN-8 is the EAN equivalent of UPC-E in the sense that it provides a "short" barcode for small packages. 
However, unlike the EAN-13 compatibility with UPC-A, the EAN-8 symbology has no compatibility with UPC-
E. 

The JAN-8 symbology is simply EAN-8, where the country code is 49. 

The nominal height for the EAN/JAN-8 barcode is one inch. The reduced size is 80% of the nominal size. 

Interleaved 2 of 5 
Interleaved 2 of 5 is a numeric (0-9) symbology that is typically used in industrial and warehousing applications.  

Checksum 
If the Checksum option is enabled, then a modulo 10 check character will be used to enhance data security for the 
Interleaved 2 of 5 barcode. When this option is enabled, the last digit of the barcode is assumed to be the check 
digit, and it is compared to a calculated check digit to verify the barcode. 

LOGMARS 
LOGMARS (Logistics Applications of Automated Marking and Reading Symbols) is a special application of 
Code 39 used by the U.S. Department of Defense. LOGMARS is an alphanumeric symbology that can encode 
numbers (0-9), capital letters (A-Z), a space character (ASCII 32), and the following four special characters: 

  

$ Dollar Sign 
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/ Forward Slash 

+ Plus Sign 

% Percentage Sign 

  

For reference, the LOGMARS symbology is governed by Military Standard MIL-STD-1189B. The Modulus 43 
check digit, optional with Code 39, is defined and recommended in this specification. 

Checksum 
If the Checksum option is enabled, then a modulo 43 check character will be used to enhance data security for the 
LOGMARS barcode. The last digit of the barcode is assumed to be the check digit, and it is compared to a 
calculated check digit to verify the barcode. 

MSI Plessey 
MSI Plessey is a variable length numeric (0-9) symbology that is used for retail inventory control. 

Second Check Digit 
A modulo 10 check digit calculation is always performed on the data string. Enabling the Checksum option will 
activate a second modulo 10 check digit, which will perform a check on the entire string, including the first check 
digit. 

PostNet 
PostNet is used by the United States Postal Service to encode mail. This symbology can encode either a standard 
5-digit Zip Code, a Zip+4 code, or a full 11-point delivery point code. For example: 

  

Postal Code Example 

5-digit Zip Code 64081 

Zip+4 64081-2747 

Full 11-point delivery point code 64081-2747-01 

  
When entering values in the Barcode text field, the dash between values is optional. Dashes will not be encoded 
as part of the barcode data. 

With respect to the “Delivery Point Code,” the last two digits correspond to the last two digits of the street address 
of P.O. Box. For example, if the address were 401 SW Oldham Pkwy, then the delivery point code is “01.” 

Checksum 
A checksum is always applied to the PostNet barcode. 

Standard Code 39 
Please refer to the Code 39 – Standard symbology, which is discussed earlier in this chapter. 

UPC-A 
The UPC-A (Universal Product Code-A) symbology encodes 12-digit numeric values, which are commonly used 
in North American retail labeling. The nominal height for the UPC-A bar code is one inch. The reduced size is 
80% of the nominal size. 

It is recommended that all new designs implement EAN-13 rather than UPC-A. Please refer to EAN/JAN-13 for 
more information. 

UPC-E 
The UPC-E (Universal Product Code-E) symbology is a compressed form of UPC-A. Both UPC-A and UPC-E 
encode 12-digit numeric values, but the UPC-E barcode is about half the size of an UPC-A barcode. Typically, the 
UPC-E barcode is used on small items, where an UPC-A barcode would not fit. 

The nominal height for the UPC-E bar code is one inch. The reduced size is 80% of the nominal size.
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WORKING WITH IMAGES 

WORKING WITH IMAGES 
Render to Bitmap 
Image Menu Color Adjustments 
Image Menu Filters 
Plug-ins 
AccuScan 
PhotoMachine 
CenterLine Tracing 

RENDER TO BITMAP 
Render to Bitmap 

The Render To Bitmap feature converts any selected vector or bitmap object. The possible color depths are as 
follows: 

 

Color Depth Description 

Monochrome Convert the selected objects to black and white bitmaps 

16 gray levels Convert the selected objects to gray scale bitmaps with 16 shades 

256 gray levels Converts the selected objects to gray scale bitmaps with 256 shades 
of gray 

16 colors Convert the selected objects to 4-bit color bitmaps with 16 colors 

256 colors Convert the selected objects to 8-bit color bitmaps with 256 colors 

Full color Convert the selected objects to 24-bit color bitmaps with millions of 
colors 

 

The resolution of the bitmap is specified in Dots Per Inch (DPI). The default resolution is 72 dpi, though this may 
be changed manually. 

 

Color Mode 
The Color Mode indicates the maximum number of discrete colors that the image can have. There are four color 
modes available: 

• RGB – This is also known as a “full color” or “24-bit” image. This mode allows the maximum number 
of colors to be used in the image. 

• Grayscale – This mode allows for a maximum of 256 shades of gray. 

• Indexed Color – This is a special image mode that allows for a maximum of 256 colors. These are not 
limited to shades of gray. 

• Monochrome – This is also known as a two-color image, such as a black and white image. 

Image Size 
Under the Image menu, the Image Size command displays size and resolution parameters for the selected bitmap.  

• The Pixel Dimensions refers to the on-screen image size listed in pixels.  
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• The Resolution is listed in pixels per inch (i.e. like dpi).  

• The Image Dimensions are the actual size at which the image will be printed or cut, expressed in the 
current ruler units. 

Render Contour Bitmap 
Render Contour Bitmap 

The Render Contour Bitmap feature is used to create three-dimensional chiseled or beveled patterns using 
process colors. When a shape varies in thickness, the effect will be adjusted to maintain consistent proportions 
throughout the shape. 

When the Render Contour Bitmap command is chosen, the Contour Bitmap dialog will open. The DPI field 
indicates the "Dots Per Inch" of the bitmap that will be produced. A high DPI setting will produce a higher 
resolution bitmap (i.e. less aliasing), but a large file size will be required to store the bitmap. 

  

 
  

As a general rule, the bitmap DPI should be set at about 25% to 30% of the output device resolution, assuming 
that the bitmap is not being scaled. For example, if the output device has a resolution of 600 dpi, then the bitmap 
should be set from about 150 to 200 DPI. 

The Constant Slope option will cause the chisel/bevel effect to reach its maximum height/depth at the same rate. 
For areas of the bitmap that have a short distance between the edge and center, the bitmap will tend to plateau. The 
Constant Height option will cause the chisel/bevel effect to dip/peak along the centerline of the shape. The 
Direction option creates a chiseled appearance that is effective with lettering. 

  

  
Using the Constant Slope setting, a 

plateau is produced at the intersection 
between two rectangles. 

Using the Constant Height setting, the 
slopes are varied so that a peak is 
produced at the maximum height. 
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Clicking OK will close the Contour Bitmap dialog, and a preview of the bitmap will be displayed. At the far-left 
of the SmartBar will be a graph button, which may be clicked to open the Tone Reproduction Curve dialog. 

  

 
  

The Tone Reproduction Curve dialog is used to edit the distribution of tints in the chisel/bevel effect. By default, 
the curve will be a straight line from the bottom-left (100% tint) to the top-right (0% tint) of the graph. 

Subdividing Shapes 
Before converting a shape into a contour bitmap, the Ginsu Knife tool may be used to subdivide the shape. 

  

 
  

For example, suppose that the Ginsu Knife tool has been used to subdivide a rectangle shape into several small 
pieces. Using the Select tool, resize and nudge the pieces to create a small gap between each piece. When ready, 
select all of the pieces and apply a Render Contour Bitmap operation. A chisel/bevel effect will be created for 
each piece, which is then combined into the final bitmap. 

  

  
Rectangle shape that has been subdivided 

using the Ginsu Knife tool. 
Select the pieces and apply a Render 

Contour Bitmap operation. 
  

If a small gap is not created between the pieces, then the Render Contour Bitmap feature will create a bitmap 
that shows no separation between the adjoining shapes. 

  

Clipping the edges of the bitmap 
Once a contour bitmap has been created, the original shape may be used to clip the bitmap, as follows: 

  

A) When editing the contour bitmap, enable the Keep Original option within the SmartBar. 



Vision-Pro 7 Doc Files 

82 

  

 
  

B) After clicking the Apply button and returning to the Select mode, the bitmap object will be "above" the 
original shape.  

  

 
  

C) Click the bitmap, such that it becomes the current selection. Then choose the To Back command under the 
Arrange menu. 

  

 
  

D) The bitmap will now be behind the original shape. Drag a selection marquee around both the bitmap and 
shape, such that they are both selected. 

E) Under the Arrange menu, choose Clipping from the Clipping flyout. 

  

 
  

The bitmap will now be clipped according to the contour of the original shape. 

  

 
  

IMAGE MENU COLOR ADJUSTMENTS 
Image Menu Color Adjustments 
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Levels 
Adjust the distribution of color intensities throughout the bitmap, either to correct a scanned image, or to create an 
artistic effect. Increasing the Black level will equate the darkest portions to black, whereas decreasing the White 
level will equate the lightest portions to white. Increasing or decreasing the Gamma will modify the overall 
intensity of the bitmap. 

The End Limits are used to adjust the White and Black values, which is an effective means of removing absolute 
white or black from the bitmap. 

  

Note: A histogram is a chart consisting of horizontal or vertical bars, the widths or heights of which 
represent the values of certain data (in this case, the data represents pixel brightness across the 
bitmap). 
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Example of Using Levels – After a grayscale image has been inverted, the separations 

between the parquetry in (2) is white. Using the Levels feature, the White point is lowered 
to equate all the separations to white. The white End Limit is reduced to remove the 

separations. And then the Gamma is reduced to create a bitmap that is as dark as in the 
original grayscale (1). 

  

  

Contrast/Brightness… 
The Contrast setting is used to modify the perceived difference between light and dark areas of the bitmap. 

The Brightness setting is used to modify the overall intensity of the bitmap. 

  

Hue/Saturation… 
Adjust the Hue, Saturation, and Lightness values of the bitmap. 

  

�       Hue is the visual perception of a specific color, such as red, yellow, violet, or orange-brown. The Hue setting 
is arranged like a color wheel (ROYGBIV), where adjusting the Hue setting will rotate the bitmap colors 
through the color wheel. 

�       Saturation is the colorfulness of an area in consideration of its brightness level. For example, as a color falls 
under increasing levels of shadow, the color appears darker, even though its saturation remains constant. 

�       Lightness is the appearance of a color in terms of how white or black it appears. 
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Curves… 
Adjust the tonal range (shadows, midtowns, and highlights) of the bitmap. The horizontal scale of the graph 
represents the range of intensity values (shadows progressing to light, or vice-versa), and the vertical axis 
represents the current intensity values. The initial diagonal line represents the original distribution of intensities 
across the bitmap tonal range. 

The Toggle Gradient Mode button is used to alternate how the intensity values are displayed. The graph can 
either display shadows to highlights (with values increasing from 0 to 255), or display highlights to shadows (with 
values increasing from 0% to 100%). 

To set specific intensity values, either click within the graph, or enter the value using the edit fields. A maximum 
of thirteen intensity values can be set. 
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Invert 
Inverts the colors in the bitmap, making it like a photographic negative. This feature can also be used to invert the 
color of a grayscale image, making the black white and the white black. 

  

 
  

  

 
 

Posterize… 
Limit the number of color levels per plane (red, green, and blue). For example, two levels means two of red, two 
of green, and two of blue. The valid range for the number of levels is from 2 to 64. 
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Histo Contrast… 
Increases or decreases the contrast of the bitmap image, using a histogram to determine the median brightness. 
Once the median brightness has been determined, pixel values above the median are brightened, and pixel values 
below the median are darkened. 

  

Note: A histogram is a chart consisting of horizontal or vertical bars, the widths or heights of which 
represent the values of certain data (in this case, the data represents pixel brightness across the 
bitmap). 

  

 
  

 
 

Stretch Intensity 
Increase the color contrast in the bitmap without changing the number of discrete intensity values (ordinary 
contrast adjustments can lose high- and low-end values). 
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Histo Equalize 
Linearizes the number of pixels in the bitmap, based on the specified color space (RGB, Grayscale, etc.).  This can 
be used to bring out detail in dark areas of an image. 

  

 
  

 
 

Balance Colors… 
Redistributes the RGB values of individual bitmap pixels. For each pixel, its red, green, and blue components are 
isolated, and the color sliders are then used to increase or decrease the percentage RGB values within each pixel. 
In this manner, a color cast can be removed from the bitmap, or a color tinge can be created for an artistic effect. 

When adjusting the color sliders, the original image is maintained when the Red Factor = 100% Red, the Green 
Factor = 100% Green, and the Blue Factor = 100% Blue. 

As per the following color mixing diagram, setting all color sliders to 100% will result in a bitmap that is entirely 
white. Conversely, setting all color sliders to 0% will produce a black bitmap. 
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Swap Colors… 
Swap the color channels of the original bitmap. This feature is useful for obtaining artistic effects that would 
otherwise be difficult to achieve using the other Color Adjustment tools. 

  

 
  

  

IMAGE MENU FILTERS 
Image Menu Filters 
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Sharpen 
Increase or decrease the sharpness of the bitmap. 

  

Unsharp Mask 
The Unsharp Mask feature is actually considered to be a sharpening function because it increases the contrast 
between light and dark areas of the bitmap. Wherever there is a brightness transition between light and dark, the 
light area is made lighter, and the dark area is made darker, such that the transition becomes more distinct. 

  

1) A blurred copy of the bitmap is created, where the amount of blurring depends upon the Radius setting 

2) The blurred copy is then subtracted from the original (the resulting difference bitmap is referred to as the 
“mask”) 

3) Pixel-by-pixel, where the difference exceeds the Threshold setting, the difference is multiplied by 
Amount and then added to the original bitmap 

4) Where the difference does not exceed the Threshold setting, the original pixel value remains unchanged 

  

  

 
 

Blur 
Blur 

  



Working With Images 

91 

 
  

Average Filter 
Changes the color of each bitmap pixel to the average color of pixels within the surrounding pixels. This results in 
a blur effect. 

  

Gaussian Blur 
Smooth or blur pixels with respect to their surrounding pixels. The Radius determines the surrounding area that is 
considered when blurring a pixel.  

  

Motion Blur 
Blur the bitmap to create the illusion of movement within the image. The size of the blur is moderated by the Blur 
Effect setting. The Angle indicates the rotation of the blur, where a positive Angle indicates a clockwise blur, and 
a negative Angle indicates a counter-clockwise blur. 

If the Unidirectional option is checked, then the blur effect will extend only in the direction specified by Angle. If 
the Unidirectional option is unchecked, then the blur effect occurs both the Angle direction, and the opposite 
direction from Angle. 

  

Median Filter 
Changes the color of each bitmap pixel to the median color of pixels within the surrounding pixels. 

The Median Filter is similar to the Average Filter, except that Median Filter is primarily used for noise reduction, 
rather than a blur effect. 

  

 
 

Noise 
Noise 

Add Noise 
Despeckle 

 
 

Add Noise 
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Add random pixels to the bitmap. Adding noise can be an effective means of making an image appear older or 
dirtier, especially where the purpose is to distract the eye from imperfections in the original image. 

  

Despeckle 
Removes speckles from the bitmap, such as those present in scanned images. 

  

Stylize / Artistic 
Stylize / Artistic 

Emboss 
Solarize 
Oilify 
Mosaic 
Spatial Filter 
Halftone 
Intensity Detect 
 

Emboss 
Applies an emboss effect to the bitmap, letting you specify the depth and direction of the effect. The Depth 
indicates the apparent depth of the emboss effect. 

  

Solarize 
Creates an effect that mimics the accidental exposure of photographic film to light. This is done by inverting all 
color intensities that exceed the Threshold value. 

  

Oilify 
Create an oil-painting effect. For each pixel, the Amount indicates the number of surrounding pixels that are 
considered when creating the effect. Increasing the Amount will result in less detail in the resulting image. 

  

Mosaic 
Create a mosaic effect by dividing the bitmap into tiles of the specified size, and then averaging the pixel colors 
within each tile. 

  

 
 

Spatial Filter 
An assortment of artistic filters, including emboss, gradient, and various mathematical transforms (Laplacian, 
Sobel, Prewitt, etc.). 

  

Halftone 
Convert the bitmap to a grayscale halftone bitmap. The Angle setting is used to rotate the halftone pattern. 

The available patterns are: 

  

Circular Apply a circular halftone pattern 
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Elliptical Apply an ellipse halftone pattern 

Linear Apply a linear halftone pattern 

Print Apply a halftone pattern for printing 

Random Apply a random halftone pattern 

Rectangular Apply a rectangular halftone pattern 

View Apply a halftone pattern for monitor display 

  

  

Converts a bitmap with any resolution to a halftoned bitmap, with a specified pattern rotation. A halftoned bitmap 
is a 1-bit bitmap that has been dithered for black and white printing or display. 

  

 
 

Intensity Detect 
Pixel intensities within the bitmap range from 0 to 255 for each color plane (red, green, and blue). The Intensity 
Detect filter compares each pixel intensity with the Low and High values, and the pixel intensity is set as follows: 

  

Pixel Intensity Result 
Between Low and High Increase intensity to 255 

Less than Low Clear intensity to zero 

Above High Setting Clear intensity to zero 

  

Remove Red Eye 
Removes the “red eye” effect that results from flash photography. For each pixel, only the red color component is 
evaluated. This feature has no effect on grayscale images, since there is no “red eye” effect in a grayscale image. 
If desired, a new color can be substituted that is closer to the original eye color. 

The AccuScan tool should be used to select a small region around the eye. Otherwise, all pixels within the bitmap 
will be affected. 

  

Red Component of Pixel Result 
Greater than Threshold Pixels are replaced (Lightness value is applied) 

Less than Threshold No change 

  

  

  

Lightness – A "Percentage" value that indicates whether the pixels that are replaced are lightened or darkened. If 
this value is greater than 100, the replaced pixels will be lightened. If this value is less than 100, the replaced 
pixels will be darkened. This function preserves the lightness of the original pixels and substitutes the red color 
with the new color. 

  

 
 

PLUG-INS 
Plug-ins 
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Plug-ins are software modules that are used to create special effects for bitmaps. These modules may be obtained 
through either Adobe or third-party plug-in developers. 

Note: A plug-in file is recognized by its *.8bf file extension. 

  

To access a plug-in from within Vision-Pro, use the Plug-in Paths option (Image menu) to specify the directory 
wherein the plug-in has been installed. More than one directory may be specified as containing plug-ins. 

  

 
  

Some plug-ins require that a foreground and background color be set. In this case, use the Set Foreground Color 
and Set Background Color commands. 

When the directory of a plug-in has been specified, the available plug-ins will appear under the Image menu. For 
example, the following screenshot shows that the CADlink Levels filter has been installed, as well as several other 
plug-ins. 

  

 
  

To use a plug-in, select a bitmap and then choose the given plug-in from the Image menu. Depending on the type 
of plug-in, a dialog will open that allows the parameters of the plug-in to be edited. 

Note: For instructions on using specific plug-ins, please refer to the documentation that was 
provided with the plug-in installation package. 

  

 
 

Applying Plug-ins to sections of a bitmap 
In some cases, a plug-in may require that only part of the bitmap be selected. If a selection has not been made, 
then a warning dialog will indicate that a selection is needed: 
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To select part of a bitmap, double-click the bitmap to activate AccuScan mode. At the far-left of the SmartBar will 
be tools for selecting portions of the bitmap. 

  

 
  

For example, suppose that a bitmap containing several leaves is being edited, and the plug-in effect should be 
applied only to one of the leaves. In this case, the Draw Lasso tool is useful. 

  

 
  

Select the Draw Lasso tool and sketch a selection area around a leaf. 

  

 
  

From the Image menu, choose the given plug-in and a dialog will open that allows the plug-in parameters to be 
edited. Once the parameters have been set, the effect will be applied to the selected portion of the bitmap. In this 
case, the plug-in created a motion blur effect. 
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For more information about the AccuScan selection tools, please refer to the AccuScan chapter. 

  

ACCUSCAN 
AccuScan 

 
  

The AccuScan feature contains the tools required to convert a bitmap into a line-traced drawing format, which can 
then be cut by Vision-Pro. In addition, AccuScan provides the necessary tools for manipulating bitmaps and 
combining them with other objects. 

  

 
  

Though any color can be selected for the foreground and background of a bitmap, these descriptions assume that 
the foreground is black and that the background is white 

To use AccuScan, select an imported bitmap and click the AccuScan tool. As an alternative, double-clicking a 
bitmap will also activate AccuScan. In either case, the AccuScan controls will become available in the dialog bar. 
However, note that only one bitmap can be edited at a time. 

  

Applying Image Filters 
Applying Image Filters 
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Vision-Pro includes a wide variety of image filters for working with bitmaps. These filters can also be applied 
within AccuScan. If only a portion of the bitmap is selected, then the filter effect will only apply to the selected 
area. Similarly, any third-party Plug-Ins can be also be used. 

  

 
  

  

A Note About Colors and the Filters 
Colors displayed on screen are created using a mixture of red, green, and blue channels (components). Each of 
these channels range from zero (no saturation) to 255 (complete saturation). As all three color channels approach 
values of 255, the displayed color becomes white, whereas channel values of zero will produce black. 

The number of distinct colors available for a bitmap depends on the bit depth of the bitmap. Without elaborating 
on the mechanics of calculating the maximum number of palette colors, it is sufficient to use the following table as 
a guide. 

  

Bit Depth Number of Colors 

1 2 (monochrome) 

4 16 

8 256 

16 approximately 65,000 

24 approximately 16.7 million (photographic quality) 

  

Fundamentally, the bit depth is a measure of how much computer memory is required to store color information 
about each pixel in the bitmap, which is why a high color bitmap requires a large data file for storage. 

  

  

  

Selection Tools 
Selection Tools 

The following selection tools are available when preparing a bitmap for scanning: 
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 Whole Bitmap Select the entire bitmap 

 Ellipse Select Select an oval area 

 Rectangle Select Select a rectangular area 

 Draw Lasso Select a freehand area 

 Draw Select Define an area that has an irregular shape. 

 Eyedropper Pinpoint a color in the bitmap. 

 Palette Select regions based on specific colors. Colors may be either 
added or subtracted from the current selection. 

 Magic Wand Select region based on similar colors. The Magic Wand setup 
may be used to customize what is considered to be "similar." 

 
Magic Wand 
Setup 

Adjust the range of color intensities that the magic wand uses 
when determining a region. The Fill Holes option will include 
any gaps as part of the overall selection. 

 Clip Region Create a clipping shape from the current selection. The Clipping 
Clear command can be used to remove this clipping. 

 Invert Selection Invert the current selection area 

  

Modifier Keys 
When creating a selection, the [Shift] key may be used to extend the previous selection. In addition, the [Control] 
key subtracts from the previous selection. 

  

Bitmap Palette 
The Target palette color is displayed above the Palette button. Double-click the Target color to add colors to the 
palette. The new color will not be added until used with either the Brush or Fill tools. New colors will be 
automatically appended to the end of the palette. 

Note: If there is not enough space in the palette for new colors, then refer to the Merge Colors 
feature. 

  

 
  

Clicking the Palette button will display the current colors in the bitmap palette. 
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The Image Palette dialog may be used to select existing palette colors. For example, several of the colors may be 
clicked, which will cause them to be highlighted. 

  

 
  

Clicking the To Front button will shift these colors to the start of the palette, whereas clicking the To Back button 
will shift these colors to the end of the palette. 

In addition, the Re-Order button will sort the palette from most- to least-prevalent colors in the bitmap. All 
palette colors will be sorted, and no selection is required. 

The Custom button may be used to add colors to the palette, though as mentioned previously, new colors will not 
be added until either the Brush or Fill tools are used with that color. 

  

Manipulation Tools 
Manipulation Tools 

The tools for manipulating a bitmap are as follows: 

Brush Tool 

Move Region 
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Crop Tool 

Fill Region 

Quarter Bitmap 

Extended Information 

Merge Colors 

Posterize Region 

Brush Tool 

 
The Brush tool uses the Target color to touch up the bitmap. There are several brush shapes available by clicking 
the Brush Selection button. 

  

 
  

Move Region 

 
The Copy tool may be used to accomplish one of two tasks, use it to move a selected area to another position 
within the bitmap, or use it to copy a selected area to another position. 

Copy A Selection 
To copy a selected area, click the Move Region button. The mouse cursor may then be used to drag the selection. 

Move A Selection 
To move a selected area, click the Move Region button, and then hold the [Control] key when dragging the 
selection. The area vacated by the selection will be filled with the Target color. 

Crop Tool 

 
The Crop tool removes all of the bitmap except for selected areas. 

Fill Region 

 
The Fill Region tool will fill a selected area with the Target color. To use this tool: 

�       Select a Target color by double-clicking one of the palette colors in the Image Palette dialog 

�       Select the area to be flooded using the selection tools 

�       Click the Fill Region button 

  

Quarter Bitmap 

 
The Quarter Bitmap button will reduce the screen resolution of the bitmap by 50% in terms of its width and 
height. Though the storage requirements for the bitmap will be reduced, the visual quality of the image may suffer. 
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Extended Information 

 
Display information concerning the dimensions and resolution of the bitmap. Clicking the Resample button will 
perform the same function as the Quarter Bitmap command (discussed previously). 

Merge Colors 

 
The Merge Colors buttons performs two tasks: 

�       It removes all unused colors from the bitmap palette. 

�       It merges colors that are selected in the Image Palette dialog (opened by clicking the Palette button). 
These colors will be replaced with the current Target color. 

  

Merge Cursor 

  Opening the Image Palette dialog also activates the Merge Cursor. Colors may then be merged on the 
bitmap as follows: 

  

Click!                                                Drag!                                               Release! 

                                               

  

Wherever the mouse is released, the Target color will be set to the underlying color. 

Using the Merge Cursor, Shift-clicking on the bitmap will add colors to the current selection. Selected colors will 
be highlighted in the Image Palette dialog. Similarly, Control-clicking will remove colors from the selection. 
When the selection is complete, click the Merge Colors button to set the selected colors to the Target color. 

Double-clicking on the bitmap will set the Target color. 

  

Posterize Region 

 
Posterization is the process of generating a color palette for a bitmap where none exists, or expanding/reducing the 
size of the palette attached to a bitmap. Click the Posterize Region button to open the Posterization dialog, and 
choose the number of colors that will compose the resulting bitmap. 

  

 
  

The Sharpen option indicates that the color boundary between objects in the bitmap are to be narrowed, which 
will create the impression of sharp edges for the objects. 
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Posterizing scanned images 
Scanners often generate new colors at the edges where two colors meet in an original image. Scanners can also 
detect a range of a given colors that we perceive only one color , such as four similar shades of blue. To avoid 
eliminating essential colors during the posterization process, use either at least three more colors than can easily be 
counted in a bitmap, or 50% more colors than can easily be counted (whichever is more). 

  

 
 

Bitmap Vectorization 
Bitmap Vectorization 

The Bitmap Vectorization tools are used to trace the components of a bitmap and generate a corresponding 
sequence of vectors. These vectors may be then be edited and cut like regular workspace objects. 

Note: The Vectorization feature may only be applied to bitmaps of 8 bits or less (256 colors). 
However, AccuScan filters (discussed later) will produce 24-bit bitmaps. Therefore, if a filter has 
been applied to a bitmap, then the Mode of the bitmap must be reduced (Image menu) before 
tracing may occur. 

  

The level of Vectorization detail is determined by the Trace Setup controls, which are located at the far-right of 
the AccuScan controls. 

  

 
  

The Vectorization button  will begin the process of generating the vectors, and the drop-list is available for 

selecting previous saved settings. Click the Trace Setup button  to edit these settings, which will open the 
Trace Setup dialog. 
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Line Fit 
The Line Fit controls will determine how close the tracing will occur along the edges of scanned artwork. Careful 
settings can produce a high-quality trace from poor quality bitmaps. 

 

 
  

Tolerance 
The Tolerance will indicate the precision with which edges are traced. A tight Tolerance will indicate that a high 
precision must be used. 

�       For a detailed bitmap, a tight Tolerance should be used (7 or greater). 

�       If the bitmap is of poor quality, or the bitmap has long, smooth edges, then a loose Tolerance should be 
used (3 or less). A loose Tolerance will avoid imperfections in the bitmap, though fine details may also 
be lost. 

  

Corners 
The Corner setting modifies corner recognition. In other words, this settings is used to help distinguish parts of 
the bitmap that represent a corner, versus parts that represent a tight curve. 

�       For angular bitmaps that are composed mostly of sharp corners, use a sharp Corners setting (7 or 
greater).  

�       For bitmaps that are composed mostly of curves, then use a round Corners setting (3 or less). 

�       For bitmaps that have a mixture of curves and sharp corners, use a moderate Corners setting (4 to 6). 

  

Tracing Options 
The Tracing Options set general rules that are applied to the trace. 

  

 
  

Speckle Filter 
Bitmaps that are generated using a scanner can often contain undesirable speckles, which are typically caused by a 
scratched or dirty scanner bed. To ignore these imperfections, the Speckle Filter may be applied as part of the 
trace. However, be cautious of using a high setting, since small details may be potentially mistaken for speckles. 

Set the Speckle Filter to the number of pixels that will be recognized as being a speckle. During the trace, only 
objects that are larger than the set value will be considered. 
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Speckles may also be recognized in terms of a percentage of the overall bitmap size. Setting the Speckle Filter to a 
percentage is useful when the bitmap is particularly dirty. 

  

Snap Long Lines to Vertical/Horizontal 
When using a scanner to create a bitmap, the original document may not be perfectly aligned on the scanner bed. 
As a result, lines that were intended to be precisely horizontal or vertical will be slightly incorrect. 

The "Snap long lines to vertical/horizontal" setting can compensate for misalignment of the original document. 
For example, a setting of 5 degrees will correct lines that are "off" by that amount. If the Degrees can not be set 
high enough, then the document should be scanned again, or the bitmap can be rotated on the workspace. 

  

Small Shape Accuracy 
The effectiveness of the Line Fit settings may depend upon the relative size of the bitmap versus the component 
objects that make up the bitmap. For example, a small object may be considered as dirt when the bitmap is large. 
However, the same object will be more significant when the bitmap is small. 

To use Small Shape Accuracy, assess the size ratio between the largest bitmaps objects versus the smallest. When 
the ratio appears large, set the accuracy to high (7-10). Where objects are similar in size, set the accuracy to low 
(Off-3). 

 
 

Overlay 
As part of the tracing, the bitmap is scanned in order to identify the component objects of the bitmap. The Overlay 
option is used to choose the style of scanning that is used: Traditional or Overlay. 

Traditional Scanning Style 
If the Overlay button is disabled, then the Traditional scanning style will be used, and each object will be 
identified as an independent part of the bitmap. For example, individual objects will be recognized as within a 
surrounding object. 

  

  
Given this bitmap... ...the Traditional style would yield these objects. 

  

Overlay Scanning Style 
Overlay scanning will create a mask for each palette color, and each mask will then be evaluated to help identify 
distinct objects. 

  

   

Given this bitmap... ...the Overlay style would also yield these objects. 

  

Since masks are evaluated according to the order of their colors in the bitmap palette, it is recommended that the 
Re-Order button first be used (Image Palette dialog) to signify the importance of the more frequently used 
bitmap colors. 
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Overlay tracing has the following benefits over Traditional tracing: 

�       Simpler objects are produced 

�       No overlap will occur between objects 

  

However, objects are typically larger than where Traditional tracing had been used. 

  

PHOTOMACHINE 
PhotoMachine 

 
  

The PhotoMachine tools that are required to convert a bitmap into a line-traced drawing format that can be cut, 
routed, or engraved by Vision-Pro. 

  

 
  

PhotoMachine traces the selected object based on the selected style. For example, the Image Cut style will trace 
the lighter portions of the image with thin lines, whereas darker portions are traced with thick lines. Though the 
Image Cut style is strictly for use with cutters, advanced engraving options are available for use with cutters, 
routers, and engravers. 

Note: Under the View menu, there is a Show Reduced Bitmaps option, which can be used to 
improve screen refresh rates. When working with the Scan Tools, Vision recommends that the 
Show Reduced Bitmaps option be active, so that large bitmaps may be redrawn quickly. 

Band Settings 
The number of bands used in the scan will determine the quantity of detail that will be extracted from the original 
image. For the band settings, the band width and the number of bands are interdependent. Changing one value will 
update the other value. 
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In addition, several of the other settings can be adjusted to modify the banding effects. 

Style and Options 
Style and Options 

At the far-left of the Dialog Bar, the tracing styles are accessible from the drop-down list. Next to each list item is 
a visual representation of the style. 

  

 
  

The available options vary according to the selected Style. 

 
 

None 

 
No style is applied and no Options are available. When the bitmap is photomachined, a grayscale bitmap will be 
produced. 

Image Cut 

 
This style is strictly for use with cutters. 

  

 
  

The Image Cut style options are: 

  

Band Minimum 

The minimum width of the bands for light areas, represented in 
terms of the Band Width. If the minimum is too low, then 
weeding the vinyl will be difficult because the strips will be too 
thin to handle. 

Band Maximum 

The maximum width of the bands for dark areas, represented in 
terms of the Band Width. If the maximum is too high, then 
weeding the vinyl will be difficult because little space will 
remain between bands. 
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Wiggle 

 
For use with low-resolution engraving, this style creates a pattern that appears to wiggle across the image. 

  

 
  

The Wiggle style options are: 

  

1st gray limit Any shade below this limit will have no wiggle, but will instead be 
represented as a straight line. 

2nd gray limit Any shade above this limit will have a “double-wiggle” applied. 

  

When using Wiggle with a mechanical engraver, the recommendation is to set the 1st gray limit to zero, so as to 
limit the number of tool lifts. The 2nd gray limit should be set low, so as to achieve a good final image. Laser 
engravers can handle higher values for each limit. 

Output Tool Paths 

 
For use with low resolution engraving, creates a standard engraving pattern. There are no Options settings for this 
Style, though the Double-density appearance may be set. 

 
 

Squares 

 
This style is specifically for use with cutters. A pattern of variable-sized squares is used to depict the image. 
Smaller squares represent lighter shades of gray, and larger squares represent darker shades of gray. 

  

 
  

The Squares style options are: 

  

Minimum size Sets the smallest possible size of the small squares (light gray 
objects) to a percentage value of the possible square size. 

Maximum size Sets the largest possible size of the large squares (dark gray objects) 
to a percentage value of the possible square size. 

  

The farther apart these values are, the more detail is shown in the final image, however to large a difference can 
create one large black square. 

Stars 

 
This style is similar to the Squares style, except that star shapes are used instead of square shapes. 
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Rain 

 
For use with laser-engravers, creates multiple lines for each pixel. The Options settings available with Rain are: 

  

 
  

The Rain style options are as follows: 

  

Density This field indicates the number of lines per pixel. 

Angle The angle to use when rendering the Rain lines. 

  

Iron filings 

 
This style is similar to Rain, though the Angle option is not present. Instead, all lines are created at random 
angles. 

  

3D Image 

 
The 3D Image style creates a 3D tool path based on the image. For devices that support depth control, the tool 
path may be used to render a three-dimensional relief image on the loaded material. 

  

 
  

The 3D Image style options are as follows: 

  

Depth Sets the maximum depth for the tool path. When routed, all shades 
of gray will fall between this depth and the surface of the material. 

Slope 
Threshold 

Represents a maximum ratio of change in depth to change in 
horizontal movement, as the tool cuts the image out of the material. 

Tool diameter The diameter of the tool that will be used to route the image. Any 
image sections that are smaller than the tool diameter will not be 
routed. 

  

Note: Routing and engraving are both particularly detailed processes. The higher the resolution of a 
given image, the finer will be the results of the job. However, using a higher resolution will require 
a corresponding increase in time for processing. 

Appearance 
Appearance 

The Appearance options effect how an image will appear after the PhotoMachine has been applied. The available 
options depend upon which style has been selected. 
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Negative and Positive Image 
Either the Negative or Positive option will be used with each Style. The Positive Image setting will apply thin 
bands to dark colored areas, and wide bands to light colored areas. 

The Negative Image will reverse the banding effect, such that wide bands are applied to light colored areas and 
thin bands are applied to dark colored areas. 

 
Negative image 

 
Positive image 

  

Double Density  
The Double Density option is available for the Engrave Style only. When the Double Density check box is 
activated, the frequency of the lines is doubled. This can be applied to both a Negative and a Positive image. 

White Space 
The White Space option is available for the Stars and Squares Styles. When the White Space check box is 
activated, all white areas are left blank with no Squares are Stars placed within. This can be applied to both 
Negative and Positive images and results in a cleaner image. 

Orientation 
The Orientation options are output device dependent. Check the device manual, regarding how the device relays 
the X and Y axes. In order to maintain a good quality cut, use the option that uses less movement of the device. 
Generally, the vertical option is more commonly used. 

  

CENTERLINE TRACING 
CenterLine Tracing  

 
  

The CenterLine Tracing feature is available from the Scan Tools flyout. 

The CenterLine Tracing feature uses a bitmap to produce a CenterLine-traced drawing that can be cut, routed, or 
engraved by Vision-Pro.  This feature works best with larger size objects where v-bits and/or conical bits have an 
obvious effect. As a result this feature does not work as well with photographic images, in which case 
PhotoMachine would be a more effective tool. 

When creating a CenterLine Tracing, select the object to be traced and choose the CenterLine option from the 
Scanning tools fly-out. The dockable toolbar will display the CenterLine tools. 
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Note: The CenterLine feature can only be applied to gray-scale images, color images must be 
resampled to gray-scale using the Render to Bitmap option available from the Transforms menu 
and explained in the Transformations chapter. 

CenterLine Tracing Features 
The CenterLine Tracing tools behave like the other bitmap editing tools available with Vision-Pro (i.e., 
AccuScan). 

  

Applying CenterLine Tracing  
Pressing the Vectorization button applies a CenterLine Trace to the selected object based on the settings provided. 

  

Selection Tools  

 
With CenterLine Tracing activated, there are eight different tools available from the Select Tool in the tool bar. 
These tools are designed to help define those areas to scan, and each is different from the others. These tools are 
described in detail in the AccuScan chapter earlier. 

  

Manipulation Tools 
There are several tools available within the CenterLine Tracing dialog box for manipulating a bitmap, allowing to 
prepare it for either routing or printing.  

The Copy  ,Crop  , Fill Region, Quarter Bitmap, Extended Information, Merge Colors, Brush and Brush 
Selection tools are all explained in detail in the AccuScan section. 

  

CenterLine Tracing Settings 
CenterLine Tracing Settings   

Pressing the CenterLine Tracing Settings button opens the CenterLine Tracing Setup dialog box. 
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Options 
There are two options for performing CenterLine Traces: CenterLine Trace only; and CenterLine and Outline 
Trace which traces the center of the image as well as tracing the Outlines of the image. Activating one Option de-
activates the other Option.  

Tolerance 
The Tolerance setting specifies how closely the CenterLine Trace follows the lines of an object in a bitmap. A 
loose setting will approximate an object’s shape rather loosely, while a tight setting will follow the lines very 
precisely. 

Tolerance should be set tight if a bitmap is very detailed and accurate. This allows for all of the fine detail to be 
traced. In general, the higher the detail, the higher the Tolerance setting. 

The Tolerance should be set loose if a bitmap contains long smooth edges, or if it is of poor quality. This results in 
CenterLine Tracing ignoring small errors in the edges of the objects, but can also result in a loss of the finer 
details. 

Speckle 
Many bitmaps contain undesirable bits of dirt. These random spots of color usually appear due to a scratched or 
dirty scanner bed. The Speckle Filter allows for removal of these specks and creation of a cleaner finished product. 

The speckle filter sets the threshold at which CenterLine Tracing recognizes a group of pixels as an object. Once 
the filter is set, an object must be larger than the set value in order to be traced during a scan. For example, if the 
Speckle Filter setting is four pixels, then objects must be five pixels or larger in order to be recognized as a true 
object, and therefore scanned. 

Note: While higher Speckle Filter settings result in fewer extraneous objects being traced, it may 
also result in the loss of smaller objects. Exercise caution when choosing an appropriate filter 
setting. 

Resolution 
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As part of the CenterLine trace process, the original vector- or bitmap-based object undergoes rasterization to the 
set Resolution value, and then a trace is performed.  The default value of 300 DPI (dots per inch) is adequate for 
most cases. 

 
 

Corner Sensitivity 
The Corner Sensitivity is used to differentiate a corner from a tight curve during the tracing operation.  If an object 
contains sharp corners and is mostly angular, then set the Corner Sensitivity to high (7 or greater).  If the object is 
composed mostly of curves, then set the Corner Sensitivity to low (3 or less).  Moderate settings (4 to 6)  work 
best for objects that are composed of a mix of corners and curves. 

Path Type  
There are three choices for the type of path for a CenterLine Trace: 

  

 
Loops The Loops path type traces the entire image as one object. 

 
Individual Lines The Individual Lines path type traces each line as a separate 

object. 

 
Longest Lines The Longest Lines path type selects continuous lines and traces 

each as an object. 

  

  

Detail Level 
The Detail Level setting controls CenterLine Tracing detail recognition ability.  

If a bitmap contains a lot of detail, set the Detail Level to a higher value. If it a simple image, set the Detail Level 
lower. Moderate settings work best with images that include areas of high detail with areas of low detail. 

Truncate Endpoints 
The Truncate Endpoints setting controls the CenterLine Tracing corner and endpoint recognition ability. 
CenterLine Tracing uses this setting to determine which parts of a trace represent a corner/endpoint, and which 
parts represent a tight curve. CenterLine Tracing will place a buffer value so the engraver/router can have a 
smooth rise to the true endpoint of the image. 

If a bitmap contains sharp corners, and is mostly angular with sharp endpoints, set Truncate Endpoint to a lower 
value. If it is mostly curves, set Truncate Endpoint to a higher value. These values are also dependent on the depth 
to which the image is being engraved. The following CenterLine Trace shows the difference between a high and 
low Truncate Endpoint values: 
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Original Bitmap                      Result that occurs using a high Truncate Endpoint value (0.1)      Result that occurs 
using a low Truncate Endpoint value (0.02) 
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WORKING WITH TEXT 
WORKING WITH TEXT 

Text Composition 
Choosing the Font 
General Text Attributes 
Auto Kern 
On-Screen Kerning Tool 
Auto Layout and Creating Text Frames 
Auto Layout Controls 
Additional Auto Layout Controls 
Braille 
Braille Font Types 
Creating Braille 
Font Editing 

TEXT COMPOSITION 
Text Composition 

Text composition is begun by defining the text frame, which is the dashed rectangular bounds that encloses the 
text. When typing characters into a text frame, the properties of the text frame determine how the text will 
compress, expand, wrap, etc. For example, each line of text can be compressed to fit the text frame width, or text 
can be expanded in width and height to fill the entire text frame. 

  

 
  

To create text, choose Text Compose from the Text Tools flyout. 
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After choosing the Text Compose tool, there are three methods of setting the text frame. 

  

�       Click on workspace: This will set an entry point for the text. As text is typed, the text frame will 
expand and contract to enclose the text. 

�       Click and drag marquee: Dragging a marquee with the mouse will set the text frame bounds. This is 
particularly effective where guides have been arranged to help the cursor snap to the required 
coordinates. As text is typed, the text frame will remain fixed, and the text will be constrained according 
to the text frame properties. 

�       Press [Shift] and click on workspace: This will set the text frame equal in size to the sign plate. 

  

  

In addition to the Text Compose tool, the Frame Text Compose tool will automatically set the text frame equal 
in size to the sign plate. 

  

 
  

  

Regardless of how the text frame was created, the Horizontal Compression, Vertical Compression, Line 
Properties, and Frame Properties buttons are used to change the behavior of how text fits within the frame. 

  

 
  

Horizontal Compression 
Horizontal Compression 

Click the Horizontal Compression button to modify how text is arranged to fit on a line. This command is only 
available when the text frame width is fixed. Using compression, text may be prevented from exceeding a set line 
length. Conversely, expansion may also be used to spread text over the entire line length. The Word Wrap can be 
set to occur after a specific amount of compression has occurred. 

  



Working with Text 

117 

 
  

The available methods of compression and expansion are: 

Width Constrain text by modifying the character width. 
Height Constrain text by modifying the character height. 
Kerning Constrain text by modifying the distance between characters. 
Word Kerning Constrain text by modifying the distance between words. 

  

Vertical Compression 
The Vertical Compression button may be clicked to specify how lines of text are arranged to with within a fixed 
text frame. This command is only available when the text frame height is fixed. 

  

 
  

The available methods of compression and expansion are by: 

�       Character height, which constrains text by modifying the character height. 

�       Line spacing, which constrains text by modifying the spacing between lines of text. 

  

Note: If a given line of text contains a mix of character sizes, then vertical compression will be based on the height of 
the first character on that line. 

  

Line Properties 
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The field next to the Line Properties button is used to adjust the line spacing. This field is also accessible from 
the Line Properties dialog. 

Clicking the Line Properties button opens the Text Line Properties dialog: 

  

 
  

The Free Length option allows the line to run to its "natural" length, based on the height, width, and kerning 
settings. The Relative Length will resize the line to a percentage of its natural length. The Absolute Length will 
fix the line to a specific length. 

The Spacing is used to determine the vertical distance between successive lines of text. A relative spacing is 
expressed as a percentage of the font height. Typically, a relative spacing of 150% is a reasonable default. An 
absolute spacing will maintain the set distance between successive lines, expressed in current workspace units. 

The X and Y fields will position the line of text at specific coordinate with respect to the sign plate origin. 

  

Frame Properties 

 
  

The purpose of the text frame is to constrain text to the given height and width. 
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With respect to either Free Width or Free Height, the text will be set according to the height, width and kerning 
settings for the given font. Alternatively, fixed width or height may be set. 

The X and Y fields are to position the line of text at specific coordinate with respect to the sign plate origin. 

The text frame margins may be set in terms of absolute distances from the text frame edge, or by a percentage of 
the text frame size. 

  

Line Compression 
Next to the Frame Properties button is the Line Compression field. This field is used to compress a line width to 
a percentage of its original width. For example, enter 50 to compress the line to 50% of its original length. 

  

CHOOSING THE FONT 
Choosing the Font 

At the far-left of the SmartBar, the Typeface drop-list will display all of the installed fonts in alphabetical order. 
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In addition to the drop-list, the Font Detective can also be used to search the installed fonts in terms of specific 
criteria, such as thickness, script lettering, serifs, etc. 

In addition to both general info and location information about each font, Panose font information is displayed. 
Panose is a typeface matching system used to classify and/or match type styles. 

  

 
  

For example, suppose that all Small Caps fonts must be located. Set the Type of font to "Decorative," and limit 
the Range of characters to "Small caps." By clicking the Filter button, the Font Detective will show all the 
available Small Caps fonts. 
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Picture Guide 
When choosing which font attributes to filter, a picture guide is provided as a memory aid. Some examples are as 
follows: 

  

 

Display Vision-PRO VEF fonts 

 

Display Vision-PRO VEF fonts 
and TrueType fonts 

 

Display fonts that have open loop finials 

 

Display fonts with a high weight 

  

  

Displaying an Entire Character Set 
From the Text Tools flyout, right-clicking the Text Compose button will open the Font Detective. However, 
after selecting a given font, the workspace will be updated with a display of all the characters in that font. 

 
  

Installing New Fonts 
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Installing New Fonts 
Vision-Pro supports a wide range of font technologies, such as TrueType and Adobe Type 1 fonts. During the 
Vision-Pro installation process, any such fonts were located and registered with Vision-Pro, such that the fonts 
could be used within Vision-Pro. Similarly, an install option had been given to install additional Vision-PRO VEF 
fonts from the Fonts and Sign Clip Art CD. 

In order to use a new font with Vision-Pro, or to use a VEF that had not been installed with Vision-Pro, first copy 
the font files into a common directory on the local hard drive. From the Vision-Pro File menu, choose Install 
Fonts to open the Install Fonts dialog. This dialog is used to locate and register the new font files that have been 
copied onto the hard drive. 

Note: Be cautious of registering fonts on a CD or other removable media, since this will require that the CD be inserted 
prior to beginning Vision-Pro sessions. 

  

 
  

  

Specify the type of font formats that are required, and browse to the directory in which the fonts are located. When 
ready, click the Search Now button to display the fonts that have been found. These fonts may then be installed 
individually, or the Install All button may be clicked. Installing fonts in this manner causes them to be registered 
for used with Vision-Pro, and they will then be available from the Typeface drop-list when editing text. 

Though not recommended for regular usage, the Reset button will remove all fonts from the database, except for 
Vision-PRO VEF fonts. The Reset button is provided as a means of purging the database after perhaps years of 
adding fonts from different sources. This is a convenient means of reconciling perhaps hundreds of font 
references. The fonts may then be loaded again from a common folder. 

  

Convert button 
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When composing text, many of the font names are abbreviations based on the old Windows filename restrictions 
(i.e. eight characters for the filename, with three characters for the filename extension). Unfortunately, these 
restrictions forced the usage of font names that were sometimes cryptic. To solve this problem, click the Convert 
button to replace the abbreviated font names with more meaningful names. These meaningful names will appear in 
the Font Type drop-list when composing text.  

Note: The list of font names that are substituted is contained within the fontlist.ini file, which is in the Vision-Pro 
install directory. 

  

Text and Special Effects 
In most cases, text will still be editable after it has been subjected to a transformation, such as fitting text to a path, 
a rotation, or an outline operation. 

If individual words or characters of a text object must be edited, then perform an Ungroup operation to the text. 
However, once a text object has been Ungrouped, the characters will thereafter be treated as individual objects. 

Some operations automatically apply the Text to Graphics operation, which will convert the text characters into 
individual graphic objects. If so, then these characters will no longer be editable as if they were text. 

GENERAL TEXT ATTRIBUTES 
General Text Attributes  

Slant 
Text Orientation 
Justification 
Line Spacing 
Case Control 
Character Placement 
Text Underline 
Bullets 
Spell Check 
Braille 
Style Painter 
Character Width 

Slant  
To the right of the font height field is the Slant control. The Slant is used to tilt the text either right or left. This is 
not a substitute for choosing an italic font, but it does create an effect that is similar to italics. 

  

 
  

The Slant is expressed in degrees, which ranges from +15 (right) to -15 (left) degrees. Clicking the Slant button 
will clear the slant value to zero. 
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Text Orientation 
Indicates the direction that the text should be read. 

  

 
Horizontal Text Arrange text from left-to-right. 

 
Vertical Text Arrange text from top-to-bottom. 

 
Arabic Text Arrange text from right-to-left. 

  

Justification 
Indicate how the text should be justified horizontally within the text frame. 

  

 
Left Justify 

 
Center Justify 

 
Right Justify 

  

Line Spacing 
Indicate how the text should be justified vertically within the text frame. 

  

 
Top Spacing 

 
Center Spacing 

 
Bottom Spacing 

  

Case Control 
Case controls are applied to the currently selected text. 

  

 
Upper Case Convert to upper case. 

 
Lower Case Convert to lower case. 

 
Proper Name Case For each work, make the first letter upper-case, and 

the remaining letters lower-case. 
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Character Placement 
Use these controls to create superscripts and subscripts. 

  

 
Superscript Create raised lettering. 

 
Subscript Create lowered lettering. 

 
Unscript Remove superscripts and subscripts. 

  

Either the Superscript or Subscript buttons may be right-clicked to customize the settings. The percentage by 
which to reduce the text size may be specified, as well as the amount that the text will be raised or lowered. 

  

 
  

Text Underline 
To add an underline to a text object, choose Text Underline from the Text Tools flyout. 

  

 
  

The underline settings are taken from the Text Underline Setup dialog, which is accessed by right-clicking the 
Text Underline button. 
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Bullets 

 
Clicking the Bullets button will place a bullet. To customize the shape of the bullet, right-click the Bullets button.  

  

 
  

The bullet pattern may be chosen from any of the registered fonts. Click the Browse button to open the Font 
Detective, which is used to choose the font from which the bullet will be chosen. The font will then be available 
from the drop-list in the Text Bullet Properties dialog. 

  

Spell Check 

 
When editing text, click the Spell Check button to verify the spelling of the currently selected text. If no text is 
selected, then the entire text object will be checked. 

To spell check all of the text objects on the workspace, choose Spell Check from the Text Tools flyout. 

  

 
  

If any spelling errors are found, then the Spell Checker dialog will open. 
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Default dictionaries for several languages are provided. The Main dictionary selection represents the active 
dictionary. In addition, a User dictionary may be created by clicking the New button. 

When spell checking, both the Main and User dictionaries are used. If any new words are added, then the User 
dictionary will be used to store the new word. The Main dictionary will remain static. 

  

Braille 

 
The Braille module is used to create accurate, ADA-compliant Braille translations. The resulting Braille may then 
be rendered by means of either drilling, punching or photo-etching. 

This operation of this feature is described in the Braille section, located later in this guide. 

Style Painter 
Style Painter 

 
  

When editing a paragraph of text, the Style Painter tool is used to copy the font style from one sentence to 
another. By right-clicking the Style Painter button, the Text Style dialog is used to select what style elements will 
be copied. 
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Copying a style within a paragraph 

1.        Highlight the text that will be copied from 

2.        Click the Style Painter button to copy the style 

3.        Click within the text that will be pasted to 

4.        Click the Style Painter to preview the result 

5.        With the cursor, highlight the text to paste the style 

  

  

Copying Text Styles 
When there are two separate text shapes, the text style can be copied between the two shapes. 

  

Copying a style between two text shapes 

1.        Select the text shape that will be copied from 

2.        Right-click anywhere except the handles of the text shape 

3.        From the context menu, choose Copy Style 

4.        Select the text shape that will be pasted to 

5.        Right-click anywhere except the handles of the text shape 

6.        From the context menu, choose Paste Style 
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Character Width 

 
The Character Width tool can apply compression to individual characters of a word. Right-clicking the Proper 
Character Width button opens the Character Width Style dialog. 

  

 
  

The Width Style options are as follows: 

  

Free Width Maintain the characters at their original widths. This setting does not allow 
the Character Width to be adjusted. 

Relative Width 
Percentage 

Adjust the character width as a percentage of the original width. 

Absolute Width Adjust the character width to be a specific width. 
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Once the type of Width Style has been selected, highlight the text and set the Character Width edit field. For 
example, the following screenshot indicate characters that have been compressed to 50% of their normal widths. 

  

 
  

AUTO KERN 
Auto Kern 

 
The Auto Kern command balances the white space between characters, such that a more pleasing arrangement of 
text is created. 

The Kern Percent field is used to specify that a percentage of the regular kerning is to be applied. Reducing the 
percentage will decrease the space between characters, while increasing the percentage will move characters 
further apart. 

  

 
  

The Auto Kern feature may be customized by right-clicking the Auto Kern button. 
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Kerning Styles 
Kerning Styles 
The available kerning styles are: 
  

Normal Balance the amount of white space, while maintaining a normal 
character spacing. 

Wide Insert approximately 20% extra white space between characters. 
Narrow Remove approximately 20% of white space between characters. 
Touching Arrange the characters so that their finials touch, yet do not overlap. 
Overlap Force adjacent characters to overlap by approximately 5%. 

  

Accuracy versus Speed 
Due to the number of calculations involved with finding the best kerning for a given pair of characters, it may be 
desirable to sacrifice some of the kerning accuracy in exchange for faster results. If so, then choose the Fast 
setting instead of Accuracy. The Fast setting will often produce acceptable results. 

Auto Kern and Engraving Tools 
When an engraving tool is to be used, set the Tool bit Diameter to ensure that kerning compensates for the bit 
size. 

 
 

ON-SCREEN KERNING TOOL 

              

  

The On-Screen Kerning feature is used to make manual adjustments to text using a special set of kerning nubs. 
The kerning nubs may be used to adjust inter-line spacing, line kerning, individual letter pair kerning, and the 
alignment skew of text. 

On-Screen Kerning is accessible from the Text Tools flyout, as well as from the Text Compose toolbar. In 
addition, holding the Control key and double-clicking a text object will enter On-Screen Kerning mode. 
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Kerning handles may be dragged using the mouse. In addition, by clicking on a handle, that handle will become 
selected. The cursor keys may then be used to move that handle by one pixel. Holding the [Shift] key will move a 
handle by five pixels. 

  

The types of kerning handles are described as follows: 

  

Line Movement Handle 
Used to position the line of text. Holding the [Control] key may be used to constrain the movement of the line. 
Holding the [Shift] key will align all the text lines along a path between the current handle and the handle of the 
first line. 

  

Line Kerning Handle 
Used to adjust kerning for the current line. Holding the [Control] key will adjust the word kerning, while keeping 
the space between adjacent characters constant. 

  

Letter Kerning Handle 
Adjusts the kerning of characters that are opposite the Line Kerning handle. 

  

 
 

AUTO LAYOUT AND CREATING TEXT FRAMES 
Auto Layout and Creating Text Frames 

The Auto Layout feature is a convenient method of creating a text frame that is segmented into horizontal and 
vertical cells. Text and/or graphics may then be placed within each cell. 

The Text Edit field may be used to enter text for a given field, and pressing the Tab key will advance the focus to 
the next cell. When entering text is complete, clicking the Apply button will open the Font Detective, which in 
this case will be used to select the font for the layout. 

When working with the Auto Layout feature, the Undo function is temporarily disabled. As a result, be careful 
about using the delete function available in Auto Layout. 
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Note: The Auto Layout feature is part of the Engraving module. 

  

Each cell is represented by a blue outline, and the active cell is indicated by a red outline. 

  

 
Created two columns and four rows of cells 

  

 
Result of entering text and clicking the Apply button 

  

 
 

 
Layouts may be stored for later use. In this manner, a layout library can be made available for other projects. 
Layouts are customized as follows: 

  

 
Plate Parameters 

Set the dimensions of the plate, as well as the initial 
number of rows for the layout. 

 
Advanced 

Specify the margins around the plate, as well as the 
compression mode for the text. 

  
The initial plate dimensions will be sized to the selected object. If no object is selected, then the sign plate 
dimensions will be used by default. 

  

Formula 
  

Offset The Offset is expressed as a percentage of the overall plate height, and 
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it is used to indicate the amount by which the bottom margin is larger 
than the top margin. A positive value will increase the bottom margin, 
whereas a negative value will increase the top margin. 

    

Multiplier Take the average inter-line spacing and increase it by the Multiplier. 
The result will determine the size of both the top and bottom margins. 

  

  

Example Offset Multiplier Result 
1 0 2 Both top and bottom margins are equal in size, and 

they are each twice the average inter-line spacing. 
2 10 2 The top and bottom margins are initially twice the 

average inter-line spacing. However, the bottom 
margin is larger than the top margin by ten percent 
of the plate height. 

3 -20 1 The top and bottom margins are initially the same as 
the average inter-line spacing. However, the top 
margin is larger than the bottom margin by ten 
percent of the plate height. 

  

AUTO LAYOUT CONTROLS 
Auto Layout Controls  

The general controls for Auto Layout are as follows: 

Text Justification 

Additional Auto Layout Controls 

Braille 

Braille Font Types 
 

 

 

Text Justification 
Text Justification 

Text justification may be defined according to individual cells. 

  

 
Left Justify 

 
Center Justify 

 
Right Justify 

  

Line and Cell Number 
The Line and Cell Number fields are used to index the layout cells. These fields indicate the currently active cell. 
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Line and Cell Controls 

  

The Line and Cell controls are used to insert cells both horizontally and vertically. Cells may also be deleted. 

  

Cell Behavior 
The remaining edit fields are used to customize the cell behavior. 

 
  

Percent and Absolute Spacing Used to set the distance from the bottom of one cell and the 
top of the next. 

Relative Line Height When editing a layout is begun, all lines are considered to be 
at 100% height. The Relative Line Height field is used to set 
the selected cell to a percentage of this initial height, though 
in so doing the remaining lines will be changed in height. 
However, the remaining lines will still be considered to be at 
100% height. 

Absolute Line Height Specify the height of the current line. Note that changing 
this value will affect the relative height value. 

Percent Cell Spacing For the current line, this field specifies the spacing between 
horizontal cells, expressed as a percentage of the cell widths. 

Percent Kerning Set the text kerning (space between characters) for the 
selected cell. This is expressed as a percentage of the normal 
kerning associated with the given font. 

  

ADDITIONAL AUTO LAYOUT CONTROLS 
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For reference, the following diagram indicates common elements when editing the layout: 

 
  

Note that: 

�       The plate outline is blue. 

�       The four margin marks (crop marks) are green. 

�       Control nubs are red, and each line has four of them. Control nubs are located at the right, left, top, and 
bottom edges of each line. 

�       The text alignment indicators are red, with each cell containing one indicator. 

�       The cell outlines are blue, with the selected cell denoted by a red frame within the outline. 

  

When the Keyboard options: 

�       Pressing [Enter] after entering text in box adds an identical line of cells below the selected cell. 

�       Pressing [Shift+Enter] adds an identical cell to the selected line, and resizes the cells to fit the line. 

�       Pressing [Tab] shifts the focus into the next adjacent cell in the layout (moving from left to right, top to 
bottom). 

�       Pressing [Shift+Tab] shifts the focus to the previous adjacent cell in the layout (moving from right to 
left, bottom to top). 

�       Pressing the [Up or Down Arrow] on the keyboard move the focus to the cell before (UP), or after 
(Down) the currently selected cell. 

  

Mouse Controls 
Holding the [Shift] key when clicking either a cell will add a new cells. Shift-clicking either top or bottom control 
nubs will create a duplicate of the current line. In contrast, the [Control] key will remove cells and lines. 

Dragging either left- or right-control nubs will adjust the margin for the given line. Holding the [Control] key will 
adjust left- and right-margins of the line equally. 

  

BRAILLE 
The Braille module is used to create accurate, ADA-compliant Braille translations. The resulting Braille may then 
be rendered by means of either engraving, punching or photo-etching. 

Braille cannot be modified using the Auto Kern feature. The Braille fonts are carefully constructed to meet the 
Federally-mandated ADA standard in the United States, and using any special kerning modes (Wide, Narrow, etc.) 
will cause the text to be non-standard. 
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Note: The Braille feature is included with the Braille module. 

BRAILLE FONT TYPES 
There are four types of CADlink VEF fonts that are used for generating Braille. The following chart indicates 
where each font is used: 

  

Braille Rendering method Braille font used 

Engrave BrRout.vef 

Punch BrRoutCA.vef 

Photo-resist BrPunch.vef 

Pre-bled photo-resist BrPunchCA.vef 

  

CREATING BRAILLE 
Creating Braille 

To avoid spelling errors, type the initial text using a non-Braille font, and then convert the text into Braille. The 
typical steps for creating Braille are as follows: 

  

1)       Choose Text Compose from the Text Tools flyout, and then click on the workspace to place the text. 
The Text Compose controls will be displayed within the SmartBar. 

  

 
  

2)       There are several Braille fonts provided with Vision-Pro. To set the default Braille font, right-click the 
Braille button within the SmartBar. 

  

 
  

 
 

3)       The Braille Properties dialog will open. 

  

 
  

4)       Click the Browse button, and the Font Detective window will open. 
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5)       From the Font drop-list, choose the Braille font that will be used. In this case, the brilbox.vef engraving 
font was chosen. 

Note: If the required Braille font is not available, then refer to the Font Installation section. 

  

6)       Click the Select button to close the Font Detective, and the selected Braille font will become available 
within the Braille Properties dialog. 

  

 
  

7)       Click OK to close the Braille Properties dialog. 

  

 
 

8)       The focus will return to the Vision-Pro workspace. Type the text that must be converted into Braille. 
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9)       Within the SmartBar, left-click the Braille button. 

  

 
  

10)    The text will be converted into Braille. 

  

 
  

11)    To finish text editing, click within an empty portion of the workspace. Note that the height of the Braille 
is automatically set to 0.395 in, as per the default setting within the Braille Properties dialog. 
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Braille Engrave 
The Braille Engrave method is intended for use with a router or engraver. The characters consist of uniform 
rectangles, which are hollowed out to leave only the dots that distinguish the Braille characters. Use the brilbox.vef 
font when engraving Braille. 

Note: Engraving both Braille and regular text in the same engraving job is not supported. As an alternative, engrave the 
Braille as a single job, and then engrave the regular text as a follow-up job. 

  

The following steps summarize how to configure a driver to engrave Braille. For a complete description of 
configuring the Plot dialog, please refer to the Cut Menu section. 

  

�       Under the Cut menu, choose the Plotting Defaults option. 

�       The Plot dialog will open. 
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�       In the Plot dialog, set the Selected Driver.  For this example, the Vision 1624 driver was used. 

�       From the Tool drop-down list, verify that the “Single pass” option is active. 

�       In the Options section, verify that the Tool Paths Only checkbox is off. 

 
 

�       Click the Move Control button. The Move Control dialog for the Selected Driver will open. 

  

 
  

�       In the Tool section, choose the Single Pass option. 

�       Set the other Move Control settings as required. 

�       Click OK to close the Move Control dialog. The settings will be automatically saved. 

�       Back in the Plot dialog, click the Save Default button. The current driver settings will now be stored for 
future sessions. 

  

The Plot dialog will close, and the driver is now configured to engrave Braille. 

  

 
 

Braille Punch 
The Braille Punch method uses a mechanical punch, where the Braille lettering is punched onto the underside of 
a plastic sheet. The Braille will then be readable on the topside of the plastic sheet. When the Braille is punched, 
the lettering is automatically mirrored, such that the topside of the plastic sheet will be readable. Use the 
brpunch.vef font when punching fonts. 

The following steps summarize how to configure a driver to punch Braille. For a complete description of 
configuring the Plot dialog, please refer to the Cutting and Plotting section. 

  

�       Under the Cut menu, choose the Plotter Setup option. The Plot dialog will open. 
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�       In the Plot dialog, set the Selected Driver. For this example, the Dahlgren CASdirect 1.0/300Z driver 
was used. 

�       From the Tool drop-down list, verify that that the “Braille Punch” option is active. 

�       In the Options section, verify that the Tool Paths Only checkbox is off. 

�       Click the Move Control button. The Move Control dialog for the Selected Driver will open. 

  

 
  

�       In the Tool section, choose the Braille Punch option. 

�       Set the other Move Control settings as required. 

�       Click OK to close the Move Control dialog. The settings will automatically be saved. 

�       Back in the Plot dialog, click the Save Default button. The current driver settings will now be stored for 
future sessions. 

  

The Plot dialog will close, and the driver is now configured to punch Braille. 

  

Braille Photo-Resist 
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The Braille Photo-Resist method is designed for printing onto a transparency. The transparency may then be used 
as a mask to expose photo-sensitive material to ultraviolet light, thereby constructing the dots that compose the 
Braille lettering. Use the brilpho.vef font for designing a transparency mask. 

Braille Pre-Bled Photo-Resist 
The Braille Photo-Resist method may in some cases produce dots that are larger than the acceptable standard for 
Braille lettering. The Braille Pre-Bled Photo-Resist method corrects this problem by resizing the brilpho.vef font 
to compensate for dot sizes that are too large. In this case, use the brilpho1.vef font for designing a transparency 
mask. 

  

FONT EDITING 
Font Editing 

Vision-Pro can modify existing fonts, or create new ones from scanned, digitized, or hand-drawn objects on-
screen. Regardless of whether the font is new or edited, it will always be saved in .VEF format, even if the original 
font had been stored in another format, such as True Type (TTY) Postscript (PFB). 

Any workspace object can be converted into a font character. However, the object must be a single-path graphic. 
Imported or grouped objects must be welded and/or converted to a single path prior to creating a font version from 
those objects. 

To import objects that have multiple paths, use the Make Path command to convert them into a single path. Also, 
the Text To Graphics command must also be applied. 

There are two functions that the Font Editor performs. The first is the editing of an existing fonts. The second it 
when a font is being created from scratch. In either case, the resulting font will be stored in a .VEF format. If the 
font was originally in .VEF format, then be aware that saving the font in its original name will overwrite the 
original font. 

When editing fonts, it is important to understand how the placement of individual letters is accomplished. As a 
rule, each character’s font metrics include two general types of information: (a) the shape and size of the character 
itself, and (b) its placement in relation to the other characters in the font. 

The area that a character occupies can be thought of as being an enclosed box. The box is considered to have an x-
axis, a y-axis, and an origin in the lower-left corner. 

  

 
  

Such placement information is necessary to help arrange adjoining letters correctly, while also considering any 
possible descenders. The three primary adjustments are (i) the white space after the character, (ii) the character 
backspace, and (iii) the offset from the baseline. 

  

�       The white space after the character adjusts the right (or trailing) side of the bounding box 

  

�       The character backspace shifts the beginning of the character in relation to the left side of the bounding 
box 

  

�       The offset from baseline shifts the character above or below the bottom of the bounding box 
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Create / Edit Font Dialog 
Create / Edit Font Dialog 

Choosing Edit Font from the Edit menu will open the Create / Edit Font dialog. 

  

 
  

When editing a font, there are two broad classes of adjustment. Global adjustments are applied to all of the 
characters in a given font, whereas Character adjustments are specific to a single character within the font. 

To create a new font, click the Create button. You may enter the name of your new font in the Create New Font 
dialog. After clicking OK, you will also be queried to save the font. 

  

 

Note: As a precaution with .VEF fonts, use a Font Name that is different from the original font. Otherwise, the original 
font data will be overwritten. 
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Global Attributes 
Adjustments to the Global Attributes are used to define the general appearance of a font. These adjustments will 
be applied to all the characters within the font. 

Font Height 
The Font Height defines the actual height of the font as it was created. When creating a new font, the height of a 
reference letter should be entered, so that the remaining characters can be sized correctly. 

For example, suppose that an uppercase 'M' were chosen as the reference letter (this is a typical choice). For the 
Height field, you would measure the height of the 'M'. 

It is very important to assign an appropriate height to a font being created. The height of a font is often based on 
the height of an uppercase M or H. The precise letter height will be used when creating a block-style font, whereas 
script fonts may require a more creative estimate of height. In the following example, notice how the script 
character is slightly taller than the non-script character. 

  

 

Interspace 
We mentioned previously that characters are considered to be within an enclosed box. Interspace is the nominal 
amount of trailing white space that will provide a gap between the following letter. By modifying the Interspace, 
fonts can be given either a wide or narrow kerning, such that the characters appear either closer or further apart. 
For example, using a negative interspace value will create a condensed font. 

 

Use Bottom of Sign Plate as Baseline 
The space occupied by a given character has been described earlier as an enclosed box, and the bottom of this box 
is considered to be the baseline of the character. This baseline will determine the vertically position of the 
characters. When creating a new font, the vertical position of each character is defined in relation to the baseline. 
To the vertical position of the characters, either (i) manually adjust each of the characters using the Offset from 
Baseline (described later), or (ii) use the Use Bottom of Sign Plate As Baseline option. 
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For the second option, use the Align feature to arrange the characters along the bottom of the sign plate. Then 
return to the Create / Edit Font dialog and enable the "Use Bottom of Sign Plate as Baseline" option. Vision-Pro 
will automatically perform the calculations, such that all the characters will be placed along a consistent baseline. 

  

Monospace Font 
The Monospace Font option converts the font to a fixed-width font, in which each character occupies the same 
amount of horizontal space regardless of its width — for example, the character 'i' taking as much width as an 'm'. 

  

Stretch 
The Stretch Font dialog is used to adjust the ratio between the font height and width, expressed as a percentage. A 
value less than 100 produces a font that is both short and wide, whereas a value greater than 100 produces a font 
that is both narrow and tall. 

  

 
  

Slant 
The Slant Font dialog is used to specify the slant degree for the font characters. A positive slant will create an 
Italic font, whereas a negative slant will create a "backhand" appearance. 

  

 
  

 
 

Character Attributes 

Letter 
This box is used to specify the character currently being operated upon. The edit box displays the actual character. 

  

Code Value 
For computers to recognize text characters, a numeric code value called the ANSI standard is used. This is a 
widely accepted standard that ensures that text data will be understandable between different models of computers. 
For a given font, there are 255 characters in the ANSI character set, which encompasses upper-case letters, lower-
case letters, numbers, and (sometimes) special symbols. 

Because some of these ANSI values are intended for communication protocols between devices, not all of the 
characters will be printable. For example, the first 31 characters are reserved for special command sequences that 
would be recognizable by a modem or printer, but which have no significance for our purposes of editing a font. 
However, it is sufficient for us to use the characters that are allocated for us to create normal, printable characters. 
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The following table indicates some sample values: 

  

ANSI code value Which we know as: CASHEWB font EMBASSY font 

65 The letter 'A' 

  

66 The letter 'B' 

  

67 The letter 'C' 

  

97 The letter 'a' 

  

98 The letter 'b' 

  

99 The letter 'c' 

  

48 The number '0' 

  

49 The number '1' 

  

50 The number '2' 
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51 The number '3' 

  
  

White Space After Character 
This field is used to adjust the width of a character bounding box. In effect, this will increase the separation from 
the following character. Though this is similar to Interspace, keep in mind that this setting is applied on a per 
character basis, whereas Interspace is used to adjust the overall kerning of the font characters. 

 
  

Character Backspace 
Character Backspace is used to move the character with respect to its bounding box origin. In effect, this will 
place the character either further away, or closer to, the preceding character. 

 
  

 
 

Offset from Baseline 
The Offset From Baseline adjusts the vertical character placement with respect to the baseline. 

For example, an uppercase H in a sans serif font will generally have an offset of 0 (no offset). This means that the 
bottom of the actual letter will be the same as the bottom of the letter’s bounding box. 

  

 
  

On the other hand, a lowercase 'g' will require a negative offset, so that its descender (the tail) will fall below the 
baseline. 
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Select Previous and Select Next Buttons 
Font characters can be designed on the Vision-Pro workspace and then added to a new font. Vision-Pro orders 
workspace objects according to the sequence in which they were created. Using the Select Previous and Select 
Next buttons, you may browse workspace objects without leaving the Create / Edit Font dialog. When the correct 
object is selected, click the Apply Changes button to create the character. 

For example, suppose that you have created a new alphabet, such that you have objects for "A B C D E F..." etc. 
on the workspace. From the Create / Edit Font dialog, you would set the Code Value to 65, and then you would 
use the Select Next button to select the 'A' object on the workspace. At this point, clicking Apply Changes would 
create the new character. Then, you could increment the Code Value to 66, click the Select Next button to select 
the 'B' object, and click Apply Changes again. This process would be repeated for each character that you create 
for the font. 

  

Define Character as Selected Object 
When editing a font, select an object to be included in the font as a character. To designate a selected object as the 
current character, check this box. 

  

Define Character as Space 
There is also a non-printing character that is often forgotten, but which must be present in a font: the space 
character. Without the space character, which appears when the space bar is pressed, there will be no spaces 
between the words created when composing text, so it is critical that a space character be included when 
generating a font. 

There are two ways to create the space character: 

1.        To use an existing character, select a character that best represents an appropriate space, and enable the 
Define Character As Space option. 

2.        To create the space character using an object, exit the Create / Edit Font dialog and create an object 
that has an area that is appropriate for the font. Once the object is selected, open the Create / Edit Font 
dialog and enable the Define Character As Space option.  

  

Apply Changes 
Clicking Apply Changes will save the character information and begin editing another character. Note that the 
changes are not saved to disk until the font is saved using the Save Font or Save Font As button. 

  

Display Box 
This box displays the current information for the character being edited. It also displays the bounding box for the 
selected character (including a top line representing the font height) and the character’s current placement within 
the box. When changes are made to the character, those changes are immediately reflected in the display box, but 
those changes are not permanent until the Save Font button is clicked. 
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The Display Box will display kerning pairs, as well as words where necessary. 

  

Kerning Pair Adjustment 
The Vision-Pro font maker provides the ability to adjust individual kerning pairs manually. 

  

Kern Letter 
The Kern Letter field indicates the character to be manually kerned in the trailing position, relative to the character 
currently being edited. The letter pair will then be displayed in the Display Box. 

  

Distance From Start Of Letter To Start Of Kern Letter 
Adjust the kerning white space between the current character and the kerning letter. 

  

 
  

Specifically, this setting identifies the exact distance between the start points of the two characters. A larger 
number increases the space while a smaller figure reduces the space. 

This setting is grayed out and unavailable unless a kern letter is selected to be paired with the current character. 

  

Display Word 
To examine the kerning set for a given letter in a realistic context, type a word containing the letter in the Display 
Word box. The word will be displayed in the Display Box. 

Note: In order for the word to appear in the display box, it must contain the character currently being edited. 

Auto Kern 
This button opens the Auto Kern dialog box. 
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Auto Kern is used to automatically generate a kerning table for a given font. Kerning tables contain information 
about the spacing between pairs of characters. 

  

Why Use Auto Kern? 
The Auto Kern feature is similar to the Text On-Screen Kerning feature that is available from the Text Tools 
flyout. Once kerning information is created for a font, Vision-Pro will simply duplicate the kerning table already 
defined. 

Due to the time required to generate a kerning table on-the-fly, the main advantage of using Auto Kern at the font 
generation stage is that Vision-Pro generates paragraphs of text very quickly when entered in Text Compose, since 
Auto Kern will not be used at that stage.  

There are four settings that can be adjusted in order to generate a custom kerning table for a font. 

  

1st Character 
By definition, a kerning pair has a first (or leading) character and a second (or trailing) character. Use the two 
entry boxes to specify the range of characters (from first to last) to be set to Auto Kern in the first position. By 
default, Vision-Pro will kern all 255 ANSI characters in the leading position. 

  

2nd Character 
Use these two entry boxes to specify the range of characters to be set to Auto Kern in the second position. By 
default, Vision-Pro will Auto Kern all 255 ANSI characters in the trailing position. 

  

 
 

Accuracy Vs. Speed 
Auto Kern works by checking and adjusting the distances between a number of points along the height of letter 
pairs. From the Accurate versus Speed drop-list, there is a choice between Accurate and Fast, that provides the 
ability to draw a balance between speed and precision. 

Using Fast will speed the kerning process by examining only a limited number of points. 
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Using Accurate will result in kerning based on the examination of substantially more points. 

  

 
  

Style 
Auto Kern can generate a font with one of five different kerning styles — Normal, Wide, Narrow, Touching, and 
Overlap. 

  

�       The Normal setting kerns the font normally, adding white space roughly in proportion to the width of 
the letter. 

�       The Wide setting kerns fonts at a rate of Normal kerning plus 20% (i.e., there is 20% more white space 
added between each letter). 

�       The Narrow option sets kerning at Normal kerning minus 20%. 

�       The Touching setting causes letters to touch, but not overlap. 

�       The Overlap setting causes letters to overlap each other by 5% of their Normal kerning. 

  

 
 

Save Font 
When editing a font, the new information is not written to the hard drive until actually told to save the font. Until 
then, the font is buffered. A buffered font is somewhat in limbo — it exists and is available to Text Compose, but 
it has not been committed to the hard drive. This means that the option to save or discard changes to the font 
before exiting Vision-Pro is still available. 

Saving a font means moving the information out of the buffer to the hard disk, thus making it permanently 
available. Any font saved is placed in the directory where the existing .VEF fonts are currently located. 

Clicking on the Save Font button will result in the font being written to disk immediately. The alternative is that 
Vision-Pro provides the option to save the font when issuing an exit command. If the font is not saved before 
exiting the Font Maker dialog box, a prompt to do so when either beginning a new session with the New command 
under the File menu, or exit Vision-Pro. 

  

Save Font As 
The function of this button is very similar to the Save As command in the File menu. Specifically, it provides the 
opportunity to give an edited font a new name, and then save the font under a new name. This is particularly 
useful when creating a new font by editing an existing font, since it allows to save the changes under a new name 
without losing the original font information. 
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OK 
Clicking OK will accept the current font changes and close the Create / Edit Font dialog. 

It will not save the font or changes to individual characters, but will commit them to memory so that they can be 
saved later. 

Font changes may be saved by (i) using the Save Font button in the Create / Edit Font dialog, (ii) using the New 
command under the File menu, or (iii) exiting Vision-Pro. By not saving, font changes will be discarded when 
exiting Vision-Pro. 
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IMPORTING AND EXPORTING 
IMPORTING AND EXPORTING 

Importing and Exporting Files 
The Vision-Pro Export Filters 
Publish to PDF 
Export Palette 
Importing from CorelDRAW!TM 
Linking Text and Images 
Acquire Image 
Digitizing Setup 

IMPORTING AND EXPORTING FILES 
Importing and Exporting Files 

All graphic software applications have their own proprietary file formats that are used to store data files. As such, 
there are a wide range and complexity of file formats currently in use, which creates challenges when exchanging 
files between different software. For this reason, most graphic software applications provide import and export 
filters to facilitate the exchange of data files. 

Each file format is used with a specific intent for the data being stored. Most the most part, file formats are 
designed to store either line art (vectors and curves), or bitmaps (raster images). The Vision-Pro workspace 
supports both line art and bitmaps, so either type of data can be imported or exported via Vision-Pro. The Vision-
Pro file format, known as the Vision Drawing File (*.CDL) format, is referred to as a “combination file” because 
it can contain both line art and bitmap data. 

  

Working with CDL Files 
Working with CDL Files 

The Vision Drawing File (*.CDL) can be opened into its own workspace (using File | Open). In addition, a CDL 
file can also be imported into an existing workspace (File | Import), provided that the Merge option is enabled. 

When using the File | Open command for the first time, Vision-Pro will query whether the intention had actually 
been to use the Import command. 

  

 
  

Restoring Printer Info 
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When a CDL is saved (File | Save), the printer and cutter information from the Print and Cut Setup dialog is 
stored with the CDL file. When opening the CDL file, enable the “Restore Printer Information” checkbox to 
load the printer and cutter settings. 

  

Zoom Open 
When the File | Open command is used, the workspace will zoom to the loaded objects. The File | Zoom Open 
command is similar to the Open command, except that the zoom level will alternate between 1) the current zoom 
level, and 2) zooming to the loaded objects. As such, Zoom Open should be considered to be a special purpose 
variant of the Open command. 

  

The Vision-Pro Import Filters 
The Vision-Pro Import Filters 

The Vision-Pro import filters are designed to convert the file data into objects that can be edited upon the Vision-
Pro workspace. Often, a customer will send an obscure file format that they intend as their concept for the job 
being ordered. Similarly, there may be a need to reuse artwork from older CAD software that is no longer in use. 
In either case, Vision-Pro supports a wide range of import filters, such that there should hopefully be few 
restrictions when loading such files. 

  

The Import Command 
The Import command is under the File menu.  

When importing with the Merge option checked, the imported file will be added to the existing workspace 
objects. If the Merge option is unchecked, then the existing workspace objects will be deleted. 

For certain types of files, the Customize button will become active in order to specify certain parameters for the 
given file type. For example, if the Files of type drop-list is set to “Bitmap Files (*.bmp),” then the foreground 
and background of monochrome bitmaps can be set. 

The Filter button is used to customize the file types that are listed within the Files of type drop-list. 

  

Importing DWG Files 
On the Import dialog, the Files of type drop-list is used to distinguish between differing file extensions. For 
example, there is an AutoCAD (DWG) file extension, which is not to be confused with GraphicCAD (DWG), 
GenericCAD (DWG), and MonuCAD (DWG). 

Note: Vision-Pro does not include an import filter for the AutoCAD (DWG) file format. Instead, use the AutoCAD 
DXF format. 

  

Importing EPS Files 
When importing Encapsulated PostScript (*.EPS), please note that there is a fair amount of variety in how 
different graphics applications export data to the EPS file format. If there are problems encountered when 
importing the EPS file into Vision-Pro, then a useful alternative is to export an Adobe Illustrator (*.AI) file 
instead. Vision-Pro will then be able to import the AI file. 

  

 
 

THE VISION-PRO EXPORT FILTERS 
There are two commands for exporting objects from Vision-Pro: Export and Export Image. 
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The Export command is mainly used to export line art shapes. However, for file formats that are capable of 
storing both line art and bitmap shapes (i.e. combination files), the Export command can also be used to export 
bitmap shapes. 

When exporting line art, caution is required to prevent creating file objects that contain excessive numbers of 
nodes. This is especially true of artwork that was originally imported from other software. To overcome this 
problem, click the Customize button on the Export File dialog. The Parameter Specification dialog will open: 

  

 
  

The Parameter Specification dialog is used to substantially reduce the nodes of exported objects. If the default 
values are insufficient, then caution is urged against setting a high value for the Error Tolerance. As a rule, the 
default value (0.001 or 1/1,000 of an inch) will work very well with most files. 

The Export Image command is used to bitmap (raster) images, such as Bitmap, JPEG, PNG, etc. If line art shapes 
are being exported, then Vision-Pro will render the line art into raster data during the exporting process. Vision-
Pro will prompt for the resolution and color depth of the raster data. 

  

 
  

PUBLISH TO PDF 
The File | Publish to PDF command is used to save the current workspace as a Portable Document Format (PDF) 
file. The utility of PDF files is that they can be viewed using the freely available Acrobat Reader application, 
which is available from the Adobe web site. 

On a side note, the Vision-Pro install includes Acrobat Reader for viewing Vision-Pro help documents. However, 
the most recent version of Acrobat Reader is available through Adobe. 

  

 
 

EXPORT PALETTE 
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The spot and duotone colors in Vision-Pro palettes may be exported to either CorelDraw or Adobe Illustrator. This 
allows the reuse of custom Vision-Pro palettes that have been configured with the current inventory of foils in 
your sign shop. If the CorelDraw or Adobe Illustrator file is then brought back into Vision-Pro, then the imported 
colors should have a one-to-one correspondence with the custom Vision-Pro palette. If necessary, the Map 
Named Colors dialog may be used to confirm that the imported colors are matched correctly. 

Please note that only spot and duotone colors can be exported. To export the Shop Palette, choose Export from 
the Shop Palette context menu. At the time of this writing, the palette may be exported to either CorelDraw or 
Adobe Illustrator. 

  

 
  

The Export Palette dialog will open. Enter the File Name and Palette Description. In addition, at least one of 
either the Export Duotones or Export Spot options must be selected. 

  

 
  

The Export To field indicates the save location of the exported palette. As a general rule, save the palette in a 
location that is convenient for retrieval. 
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IMPORTING FROM CORELDRAW!TM 
Importing from CorelDRAW!TM  
Using CMF files 

When Vision-Pro is installed, and either of CorelDRAW!TM versions 3, 4, or 5 has already been installed, Vision-
Pro will install an export filter into the CorelDRAW!TM export menu. This custom export filter is optimized for 
file exchange between CorelDRAW!TM and Vision-Pro. The filter will appear in the CorelDRAW!TM export menu 
as “Export To Vision-Pro,” and it will generate *.CMF files. This is the preferred method of file exchange for 
these versions of CorelDRAW!TM. 

Note: The CMF filter is not available if CorelDRAW!TM is running from the CD-ROM. 

 

Using the Application Launcher 
For CorelDRAW!TM versions 5 through 9 inclusive, the Application Launcher may be used. On the Standard 
CorelDRAW!TM toolbar, the "CorelDRAW to Vision-Pro" option may be chosen from the Application Launcher. 

 
The focus will then switch to the Vision-Pro workspace, where the exported object may then be placed on the sign 
plate. 

 

Creating a "2signlab.csc" toolbar button 
For versions of CorelDRAW!TM versions 8 and 9, a toolbar button may be created by using the "2SignLab.CSC" 
file that is available from CADlink. The following steps describe how to create this toolbar button. Before 
following these steps, please verify that you have the "2SignLab.CSC" file. If this file was not installed with 
Vision-Pro, then it is available as a download from the CADlink web site. 

1)       Using Windows Explorer, copy the "2SignLab.CSC" file into the following directory: 

C:\Program Files\Corel\Graphics9\Draw\Scripts\Scripts 

Note: This is a default directory that would have been set up during the installation of CorelDRAW. If CorelDRAW 
has been installed to an alternative directory path, then place the "2SignLab.CSC" file in the appropriate sub-directory. 

 

2)       From within CorelDRAW, choose Options from the Tools menu. The Options dialog will open. 
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3)       On the left-hand side of the Options dialog, expand the Customize item, and then choose the Toolbars 
option. 

4)       A list of Commands will appear in the center of the Options dialog. 

5)       Expand the Application Scripts item, and then choose the "2signlab.csc" option. To the right of the 
Commands list, a group of available icons will appear. 

6)       Click and drag the icon that will be used to represent the "2SignLab.csc" button. 
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7)       Drag the icon to the CorelDRAW toolbar where the new button will be placed. An insertion cursor will 
appear as you hold the icon over a given toolbar. In this example, the button was created on the Standard 
toolbar. 

8)       When the icon is in the desired toolbar position, release the mouse button. At this point, a toolbar button 
for the "2SignLab.CSC" file has been created. 

9)       Click the OK button to close the Options dialog. 

 

As a test, create an object in CorelDRAW, select that object, and then click the "2SignLab.CSC" toolbar button. 
The focus will shift to Vision-Pro, and the object will be placed on the sign plate. 

 

Saving Embedded CDL Files 
The File | Save command is used to save the current workspace as a CDL file. If the workspace contains linked 
images (using the Link command), then the CDL file will contain a reference to the linked file. 

The File | Save Embedded File command is like Save, except that the entire data of linked files will be stored 
within the CDL file. As such, the CDL file can be sent to another workstation without worrying about broken 
links. 

  

LINKING TEXT AND IMAGES 
Linking Text and Images 
Introduction 
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Microsoft OLE (Object Linking and Embedding) technology is designed to facilitate the sharing of text and 
graphics between Windows applications. For example, an editing area may be created within Application A, 
wherein objects from Application B may be created or modified. 

Sharing between applications is commonly done by dragging a text or graphic object from one application to 
another. Simply select the object, left-click it and drag, and then release the object when it is over the other 
application window. After dragging an object, releasing the left-mouse button is referred to as "dropping" the 
object. 

In addition to simply dragging-and-dropping an object, there are modifier keys that specify the operation that 
should be performed. The modifier keys are summarized as follows: 

  

Modifier Keys Action performed 

[none] Move object to the target application. 

[Control] Copy object to the target application. 

[Control + Shift] Create a link for the object in the target application. 

  

Creating a linked object between two applications will allow either application to edit that object. Edits made in 
one application will be shown in the linked application, and vice-versa. However, note that the frequency of 
updates is determined by the operating system, so updates may not be immediate. 

To create linked text within Vision-Pro, suppose that a paragraph of text had been created within MSWord 97: 

  

�       Select the paragraph that will be linked. 

�       With the left-mouse button, click and drag the paragraph over to the Vision-Pro workspace. However, 
do not release the mouse button. 

�       Press and hold both the [Shift] and [Control] keys. Notice that the mouse cursor will indicate an 
"insertion" arrow. 

�       While still holding the [Shift] and [Control] keys, release the left-mouse button. The link to the text 
will be created within the Vision-Pro workspace. 

  

  

In the above example, once the link has been established, any edits within MSWord would also be shown on the 
Vision-Pro workspace. 

Note: Though Microsoft has specified a standard for OLE implementation, support of OLE functionality may not be 
available with certain applications. In some case, there is support for moving and copying objects, but not for creating 
links. 

  

 
 

Links 
Links 

Multiple objects may be linked into the Vision-Pro workspace. To view the current links, choose the Links 
command (Edit menu). 
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The following actions are available for the selected link: 

  

Update Now If edits have occurred in the linked file, then update this 
information on the Vision-Pro workspace. 

Open Source Open the object in its associated application. 

Change Source Modify the link, such that it points to a different file. If the file is 
valid, then changing the type of file is acceptable. 

Break Link 
Remove the link that exists between the Vision-Pro workspace and 
the original application. Edits within the application will no longer 
be shown within Vision-Pro. 

  

  

The Update options are Automatic and Manual. The Automatic option will refresh changes to linked objects 
periodically. The Manual option will require that the Update Now button be clicked before changes are shown. 

 
 

Insert New Object 
As an alternative to dragging-and-dropping, the Insert New Object command will link objects that are from 
another application. Either a previously created file may be used for linking, or a new object may be created 
within the Vision-Pro workspace. 
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Editing Linked Objects 
After an object has been inserted, it may be double-clicked to continue editing. In addition, selecting the object 
will activate the following Edit menu flyout commands: 

  

 
  

Edit Edit the object within the Vision-Pro workspace. 

Open Open the object within its associated application. 

Convert 
Convert the object type, such as from MSWord 97 into MSWord 2000. 
This command is provided in cases where objects from a previous release 
must be accessed. 

  

Convert to Vision-Pro Object 
After an object has been inserted into the Vision-Pro workspace from another application, this command will 
convert the object into an actually Vision-Pro object. Once this conversion has been performed, there will be no 
method of editing the object in the original application. 

If the object being converted is a text object, then the resulting Vision-Pro object will be a text object. Otherwise, 
the converted object will be of either type polyarc or polygon, depending on the Polyarc / Polygon setting in the 
General Preferences dialog. 

Note: The result of the conversion will be grouped, though an Ungroup [Alt + G] command may be performed. 

 
 

ACQUIRE IMAGE 
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Acquire Image 
The Acquire Image item provides access to the TWAIN support offered by Vision-Pro. This support provides the 
ability to operate TWAIN-compliant scanners directly from within Vision-Pro, without any intermediary software. 
To function properly, the scanner control software must be properly installed within Windows, and must be 
TWAIN-compliant. 

  

 
  

Acquire 
Acquire 

This option calls the TWAIN-compliant software, initializes the scanner, and prepares the system to receive a 
scanned image. Upon exit from the scanning software, the acquired image will be imported into Vision-Pro. 

Select Source 
This option provides the ability to choose the TWAIN input device that will acquire images.  

If only one source (i.e., only one scanner and/or scanning software) is attached to the system, set this once. 
However, if more than one source of TWAIN-compliant input (i.e., both a flat bed scanner and a hand-held 
device) is attached, this feature provides the ability to choose between the devices to suit specific needs at any 
time. Select Source opens the Select Source dialog box: 

 

 
  

The Sources list is of all available TWAIN-compliant devices attached to the system. After choosing the source 
device, click the Select button. 

  

Acquire Vector 
This is a variation on the Acquire command. Where the Acquire command will produce a bitmap image, the 
Acquire Vector will produce line art from the scanned image. 

  

Scan and Trace Wizard 
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The Scan and Trace Wizard includes all the steps to import and trace and image. In addition to importing a 
scanner image, the wizard can accept either an image data file, or an images that was copied to the Windows 
clipboard from another application. 

  

DIGITIZING SETUP 
Digitizing Setup 

Vision-Pro will interface cleanly with a digitizing tablet, and no other intermediary software drivers are required. 
However, verify that the tablet is correctly connected to the computer, as per the manufacturer instructions. Once 
connected, configure the tablet using the Digitizing Tablet Setup dialog. 

  

 
  

Enable Digitizer 
Enable Digitizer 

This check box is used to enable and disable the digitizer. In order to reduce the load on the system, it is 
recommended that the digitizer be disabled when not in use. This will prevent Vision-Pro from polling the tablet, 
and therefore free up system resources. 

Track Pen 
This check box is used to enable and disable the tracking of the digitizing pen. In order to reduce the load on the 
system, it is recommended that the digitizer be disabled when not in use. This will prevent Vision-Pro from 
polling the tablet, and therefore free up system resources. 

Reset Baseline 
When starting a new drawing, or if the original angle and position of the tablet baseline need to be restored, select 
the Reset Baseline option. The baseline of the tablet will be reset to match that of the material. See Set Baseline 
below for more information regarding baselines. 

  

Set Baseline 
The baseline of a drawing defines both the bottom of the artwork, as well as the angle of the horizontal axis. 
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Typically, a digitizer designates the bottom of the tablet as the baseline, which Vision-Pro will also use as a 
reference. Use the Set Baseline button to align the baseline with that of an artwork, rather than the tablet bottom. 
This avoids the requirement that the artwork be precisely aligned with the bottom of the tablet. 

  

 
  

Using the Digitizer 
Vision-Pro responds predictably to the four buttons on a standard four-button puck. 
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Button Function Description 

Top Corner node Place corner node on workspace 

Left Curve node Place curve node on workspace 

Bottom Tangent node Place tangent node on workspace 

Right Finish End and close contour, or create custom shapes. Double-
clicking will close the contour. 

  

The Curve nodes drawn by the digitizer are different from those drawn by the mouse in standard draw mode. 
Draw mode uses the nodes as control handles that pull at the curve as it is formed, while a curve drawn in 
digitizing mode will pass directly through the nodes as they are placed. 

  

Button Combinations 
Certain button combinations may be used to form basic shapes. Place two Corner nodes to form the opposite 
corners of a rectangle, and then double-click the Finish button to complete the rectangle. Similarly, place two 
Curve nodes to form the diameter of a circle, and then double-click the Finish button to complete the circle. In 
addition, placing three Curve nodes and then double-clicking the Finish button will fit a circle to the three nodes. 
If four or more Curve nodes are placed, then a circle will be created that best fits those nodes.
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PALETTES, STROKES AND FILLS 
PALETTES, STROKES AND FILLS 

Working with the Color Palettes 
Edit Color Dialog 
Shop Palette Context Menu 
Sheet Layer Palette 
Job palette 
Line Style Tool 
Gradient and Pattern Fills 

WORKING WITH THE COLOR PALETTES 
Working with the Color Palettes 

The basic color palette is the Shop palette, which lists the color plates that are available for use on the workspace. 
The other palettes are designed as an aid for working with spot colors, particularly with respect to foils. By 
default, color palettes are docked at the edges of the Vision-Pro workspace, as indicated in the following 
screenshot. 

  

 
  

Though docked, a palette may be "undocked" by clicking-and-dragging the palette away from its docked position. 
The palette may then be said to be "floating" over the workspace. Alternatively, double-clicking a palette will 
toggle its position between docked and undocked. 
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In addition, Vision-Pro also has the functionality to open stand-alone Manufacturer palettes. Specific color 
plates may then be dragged from a manufacturer palette and added to the shop palette. In this manner, the Shop 
palette may be quickly customized to include the most frequently used color plates. Manufacturer palettes are 
discussed later in this chapter. 

  

Shop palette 
Shop palette 

The default location of the Shop palette is along the bottom of the workspace, and it is commonly referred to as 
simply the color palette. The Shop palette contains all the color plates that are currently available for use on the 
workspace. 

  

 
  

Left-clicking a color plate will set the default fill color for new shapes, as well as set the fill color of any currently 
selected shapes. To change a shape fill color without changing the default fill, color plates may be dragged-and-
dropped onto a shape, as per the following steps: 

  

1.        Left-click and drag the color plate away from the shop palette. 

2.        As the cursor is moved, it will appear as if a small color plate were being dragged. 

3.        Hold the cursor over a workspace shape and release the mouse button. 

4.        The shape will now be assigned that color. 

  

The following screenshots demonstrate this drag-and-drop operation: 
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Click and drag the color Release mouse button when cursor is over object 

  

 
 

Changing the stroke color 
Right-clicking a color plate will set the default line style color for new shapes, as well as set the line style color of 
any currently selected shapes. As with fill colors, color plates may be dragged-and-dropped onto the line style of a 
shape. When holding the color plate over the line style of a shape, the dragged color plate will appear to be 
hollow. This indicates that releasing the mouse button will change the line style color of the shape. 

  

  
Dragging color plate. When over the shape line style, 

the plate appears hollow. 
Release the mouse button, and the line style color is 

changed. 
  

Note: By default, workspace shapes have no line style. For more information, please refer to the Line Style tool (later 
in this chapter). 

  

Changing the fill color of grouped shapes 
Dragging-and-dropping a color plate onto a collection of grouped shapes will set all of the shape fills to that 
color. However, pressing the [Ctrl] key will allow the color to be dropped onto a single shape within that group. 
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For the grouped shapes, press and hold the [Ctrl] key when dropping the color 

onto the circle, and only the circle fill will be changed. 

  

  

Changing the order of color plates 
To change the order of the color plates within the Shop palette, a given color may be dragged-and-dropped onto a 
different location of the palette. The color will be inserted at the new location, and colors to the right of that color 
will be shifted to the right. 

  

               

 
Magenta plate is dragged-and-dropped into new location      Magenta plate is inserted in new location 

  

These basic rules for dragging-and-dropping plates also apply to the other color palettes. Special cases of this 
functionality will be discussed within the relevant sections. 

Modifier Keys and Color Plates 
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When either left-clicking or right-clicking a color plate, additional functionality is available by holding the [Shift], 
[Control], or [Alt] keys. The following table summarizes these modifiers: 

  

Action Result 
Left-click Set fill color of current object 

Right-click Set line style color of current object 

[Shift] + Left-click Include all objects of that fill color in current selection 

[Control] + Left-click Disable the color plate. All objects with that fill color will appear as 
dashed outlines on the workspace. 

[Alt] + Left-click Disable all color plates, except for the plate that was clicked 

  

For example, holding the [Control] key and clicking a palette color will toggle the "active" status of that color 
plate. Objects that have inactive colors will not be editable. 

  

 
  

The Invisible Color Layer 
At the far-left of the Shop palette is the Invisible Color Layer, which is used to indicate the absence of color for 
either an object fill or line style. The Invisible Color may be applied to objects like a regular palette color. 

  

 
  

When applied as a fill color, the object will be reduced to the sum of its thick line attributes, which is useful for 
creating cutting paths. 

Where applied as a line style color, the object will effectively have no thick line attribute. 

  

The Line/Fill Selector Button 
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At the left of the Shop palette is the Line/Fill Selector button, which is used to toggle between Fill mode and Line 
mode. 

  

 
  

If the Fill mode is selected, then left-clicking a color plate will set the fill color of a selected shape, whereas right-
clicking will set the line style color. 

If the Line mode is selected, then left-clicking a color plate will set the line style color of a selected shape, 
whereas right-clicking will set the fill color. 

This behavior is summarized in the following table: 

  

Button Mode Left-click Right-click 

 
Fill Set the fill color Set the line style color 

 
Line Set the line style color Set the fill color 

  

The Halftone palette also has a Line/Fill Selector button, which operates in similar fashion for Knock Out, 
Overprint, Overlap, Primers and Halftones. 

  

Color plate labels 
Each plate on the Shop palette is indexed according to the order of colors in the palette. 

  

 
  

To hide these labels, uncheck the Show Layer Numbers item from the palette context menu. 
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Note: The display of color plate labels may also be toggled using the Layers On / Off option in the General 
Preferences dialog. 

  

When an object is selected, its color plate is shown on the SmartBar, and the Color Layer is visible within the 
plate. In addition, each color has a letter that identifies its color type: Process (P), Spot Foils (SF), or Spot Color 
(SC). 

  

 

Note: When cutting objects, the cutting sequence is determined by the database order. Exceptions to this order may be 
made by using the Sort dialog, or the Cut by Color feature. 

  

EDIT COLOR DIALOG 
Edit Color Dialog 

The Edit Color dialog is opened by double-clicking a color plate in the Shop Palette, and there are two tab pages 
of controls on this dialog: General and Output Tool Paths.  
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The main controls of the Edit Color dialog are within the top third of the dialog. These controls are used to 
indicate the specific color value, its color space (rgb, cmyk, etc.), and how the color should appear on the 
workspace. On the General tab, there are additional controls that are used to indicate the type of color (process, 
spot color, spot foil), and the manufacturer of this color. The Output Tool Paths tab has controls that allow each 
color to be associated with a specific cutting depth, which is used when outputting to a cutting device that supports 
depth. 

  

 
  

Setting the Color Value 
The color sliders indicate the specific color value according to the Color Space setting (RGB, CMYK, etc.). There 
are three methods of changing the color value: 1) adjust the color sliders, 2) choose a color from the color picker, 
or 3) click the Measure button to read a color from a color measurement device. When the color value is adjusted, 
it will be previewed next to the current color. The RGB value of the new color is below the preview. 
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Color Space 
The Color Space may be chosen from the drop-list at the top-right corner of the Edit Color dialog. The choice of 
Color Space will determine the colorants used to define the color. 

  

 
  

  

RGB 
Red, Green and Blue (RGB) is commonly used in additive color mixing. For example, a computer monitor is 
designed to emit red, green and blue (RGB) light, which combines to form the desired color. 

CMY 
Cyan, Magenta, and Yellow (CMY) is commonly used in subtractive color mixing. This sort of mixing works on 
the principle that an external light source will be required to view the image, such as an image on a white sheet of 
paper. 

CMYK 
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Cyan, Magenta, Yellow, and Black (CMYK) is an extension of the CMY model, where it is observed that three 
equal portions of CMY colorants may be replaced with a single portion of Black (K) colorant. 

HLS 
The Hue, Lightness and Saturation (HLS) model identifies colors according to the following parameters: 

  

�       Hue is the visual perception of a specific color, such as red, yellow, violet, or yellow-brown. 

�       Lightness is the appearance of a color in terms of how white or black it appears. 

�       Saturation is the perceived richness of a color in consideration of its intensity. For example, as a color 
falls under increasing levels of shadow, the color appears darker, even though its saturation remains 
constant. 

LAB 
The L*a*b* color space, otherwise known as CIELAB, was promoted as a standard in 1976 by the International 
Commission on Illumination (CIE). The purpose of L*a*b* was to standardize the practice of predicting color 
differences, where previously there had been as least twenty alternative formulas in use to account for color 
differences in production workflows. 

The L*a*b* color space is used to maintain color consistency between devices used in color reproduction 
workflows. As such, the L*a*b* color space is a superset of both RGB and CMYK color spaces. The “L*” 
component refers to the Lightness, the “a*” component varies from Green to Red, and the “b*” component varies 
from Blue to Yellow. 

  

Color Type 
The Color Type is set on the General tab. In order to use Color Types effectively, the following printing methods 
should be understood: 

The most commonly understood printing method is the process color printing of CMYK inks, where the colors 
Cyan (C), Magenta (M), Yellow (Y), and Black (K) are combined in varying proportions to produce the hues of a 
graphic image. The number of inks actually depends upon the type of printer, but the methods are similar. 

A second printing method is of thermal resin foils, where each hue is represented by a foil cartridge that is loaded 
into the printer as required. Each foil color is printed in separate passes over the media, and two foils can be 
combined to create duotones. Like printing with CMYK inks, a thermal printer can also combine CMYK foil 
cartridges (four separate passes) to produce the hues of a graphic image. 

A third printing method is of color separations, where each color in the graphic image is printed separately. 
Typically, a color separation would be prepared for each of the CMYK components of a graphic image, and an 
additional color separation would be created for each Spot Color in the image. Once all of the color separations 
have been prepared, they are combined in an offset printing process to recreate the original image. 

Having summarized the preceding printing methods, we can now explain how Color Types in the Shop Palette are 
used: 

  

�       Process color (P): A hue that is printed by combining CMYK inks. In addition, a Process color can be 
printed by a thermal printer using CMYK foils. When printing color separations, a Process color is 
included with the CMYK components of the graphic image. 

�       Spot Foil (SF): A Spot Foil represents a specific foil color cartridge that is printed using a thermal 
printing process. Each foil color cartridge is a distinct hue, such as Kelly Green or Sapphire Blue, which 
are physically loaded into the printer as required. In order to make greater use of a given foil, its Tint 
value can be varied to create different shades of the color. 

�       Spot Color (SC): A Spot Color represents a distinct hue that is used when printing color separations. 
Each Spot Color represents its own color separation that is defined by its LAB value. For process color 
printing, the Spot Color will be incorporated into the graphic image using CMYK inks. For thermal resin 
foils, the Spot Color will be incorporated into the graphic image using CMYK foils. 

  

The main distinction between Process color and Spot Foil printing is that Process colors are created by combining 
inks, whereas each foil represents a physical cartridge that is loaded into the printer as required. As such, it should 
be noted that “process white” is the absence of CMYK inks, and “spot foil white” is an actual foil that is applied to 
the media. 
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Reflectivity 
The Reflectivity can be described as being either Plain, Reflective, or Metallic. This setting is used to describe the 
type of vinyl that is being cut. Also, some spot colors may be described as being either reflective or metallic. 

  

Color Name 
When the cursor is above a Shop Palette color, the Color Name will appear within the tooltip. 

With respect to Spot Foils, the Color Name is assigned by the manufacturer as a reminder of the hue that will be 
generated by the foil. In addition, the Vendor and Vendor Code are assigned by the manufacturer for reference 
purposes. 

When creating a new spot foil, adding the Color Name is necessary because the name is used as a reference during 
the printing process. When a tint of a Spot Foil is created, the tint will inherit the Color Name, and the tint value 
will be appended to the name. 

When creating a Spot Colors, the Color Name must be defined because the name is used as part of the lookup 
process for LAB values. Similarly, if a Process color is defined in terms of a LAB value, then its Color Name must 
also be defined for reference purposes. 

  

Pen setting 
Where multiple pens are available, the Pen field is used to indicate the index position that should be used with the 
given color. 

  

Output Tool Paths 
On the Output Tool Paths tab, a cutting depth can be assigned to each color. This allows the color of workspace 
objects to be a visual representation of their various cutting depths. In addition to the depth, setting the Depth per 
pass will calculate the number of passes that will be performed. Alternatively, set the number of Passes, and the 
Depth per pass will be calculated. 

  

 
  

SHOP PALETTE CONTEXT MENU 
Shop Palette Context Menu 

With the exception of the Manufacturer palettes, all of the color palettes have context menus that are accessed by 
right-clicking within the bounds of the palette. The context menus may also be accessed by clicking the context 
menu buttons that are on each palette. 

The context menu for the Shop palette appears as follows. The available menu items are described in the following 
sections. 
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Open Manufacturer Palette 
Open Manufacturer Palette 

The manufacturer palettes are composed of commonly used color plates, which are stored in a Palette (.PAL) file 
format. More than one manufacturer palette may be open at once, and colors from different palettes may be 
applied to the workspace objects. 

  

 
  

Color plates may be dragged from the manufacturer palette and "dropped" onto workspace objects. In so doing, 
the dragged color will be added as a new color plate at the far-right of the Shop palette. If the manufacturer palette 
is later closed, then the added color will remain as part of the Shop palette, which is then saved with the 
workspace file. 

Color plates from a manufacturer palette may also be dropped onto the Shop palette, which will add a new color 
plate for that color at the far-right of the Shop palette. 

  

  

 
 

Save 

 
  

After a custom palette has been prepared with frequently used color plates, use the Save As item to save the 
palette for later use. 

The Save As command it used to save the current Shop palette settings as a new Palette (.PAL) file. Typically, 
saving the Shop palette is desirable after it has been customized with commonly used color plates. The saved 
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palette may then be opened like a manufacturer palette, or it may be set as the default palette that is loaded with 
each new Vision-Pro workspace. 

If the Save default on exit item is enabled (a checkmark should appear next to the item), then all changes to the 
Shop palette will be saved when Vision-Pro is shut down. For example, choosing Exit from the File menu will 
cause the palette settings to be saved. 

Note: Creating a new Vision-Pro workspace will not cause the palette settings to be saved. Instead, use the Save As 
command to save such settings before creating a new workspace. 

  

Load 
During the installation of Vision-Pro, a “Palettes” directory was created within the Vision-Pro installation 
directory. The Palettes folder contains color palettes for a variety of manufacturers, and each palette can be 
identified by its *.PAL file extension. 

To load a Vision-Pro color palette, choose Load New from the Shop Palette context menu. This will replace the 
current Shop palette configuration. 

  

 
  

The Merge item is used to select an existing Palette (.PAL) file, which is then appended to the Shop palette. Use 
this command to combine the color plates of two-or-more commonly used palettes. 

When Vision-Pro is launched, a standard palette is loaded that has a selection of commonly used process colors. 
Use the Set default item to specify an alternate palette that should be loaded instead of the standard palette. For 
example, the default may be set to a custom palette that was previously saved. 

Note: After installation, Vision-Pro will use the "Factory Default.pal" file. 

  

Shop Palette Wizard 
The Shop Palette Wizard is a visual browsing tool that is used to create a custom palette by browsing and selecting 
from the palettes that were installed with Vision-Pro. Colors from more than one palette may be combined, and 
there is no restriction on creating a palette that has colors from different manufacturers. 

  

Truncate 
The Truncate command will remove all color plates that are to the right of the currently selected color plate, with 
the exception of any colors that are currently being used on the workspace. 

  

Sort Colors 
The Sort Colors flyout is used to rearrange the Shop palette color plates. Sorted colors will be moved to the front, 
which is the far-left of the Shop Palette. 
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By selected objects Sort the colors of the currently selected objects. 

By all objects Sort the colors of all objects on the workspace. 

By active colors Sort active colors to the front of the Shop Palette, and sort 
inactive colors to the end. 

Move Color To 
Front 

Select from an alphabetical list of colors and move that color 
to the front of the Shop Palette. Only Spot Color and Spot 
Foils are listed. 

  

Find Color 
The Find Color command is the same as the Move Color To Front command. The Move Color To Front dialog 
is used to select from an alphabetical list of colors and move that color to the front of the Shop Palette. Only Spot 
Colors and Spot Foils are listed. 

  

 
  

Find and Edit Color 
Select from an alphabetical list of colors and open that color in the Edit Color dialog. Only Spot Colors and Spot 
Foils are listed. 

  

Reset 
The Reset option will reload the Shop palette, discarding any changes that may have been made to the color 
plates. The standard Shop palette will be loaded, unless it has been specified that a default palette should be loaded 
(see Load default at startup, earlier in this section). 
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By using the Reset option, the original palette colors may be restored without deleting the objects that are 
currently on the workspace. 

Show Layer Numbers 
The Layer Numbers refer to the Shop palette color plates, where each color plate is assigned both an index 
number, as well as a letter designation that indicates the correction mode for that color. If the Layer Numbers 
option is set to Off, then the index numbers and letter designations are hidden. 

  

SHEET LAYER PALETTE 
Sheet Layer Palette 

The workspace area is a visual display of the shapes and text that have been prepared for printing and/or cutting. A 
Sheet Layer is a subset of the workspace, where Vision-Pro can maintain multiple sheet layers within the same 
workspace. If only one layer exists, then all shapes and text will belong to that layer. Where more than one sheet 
layer is available, shapes and text may belong to different layers. 

When sending output to a device, a given layer may be specified, such that only the objects on that layer are 
output. 

Placing objects on layers 
Placing objects on layers 

By default, shapes are placed on sheet layer 0 (zero). The following screen shot shows a workspace where there 
are three layers present. 

  

 
  

For selected objects, clicking a layer plate will place those objects on the layer. Alternatively, an object may be 
assigned to a layer as follows: 

  

1.        Left-click and drag the layer plate away from the Sheet layer palette 

2.        A small square will appear to be dragged by the cursor 

3.        Hold the dragged square over a workspace shape, and then release the mouse button 

4.        That shape will now belong to the given layer 

  

   
Click-and-drag a plate from 

the sheet layer palette 
Dragging the plate Hold plate over workspace 

object and release mouse 
button 
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Selecting All Shapes on a Layer 
All shapes on a given sheet layer may be selected by holding the [Shift] key and left-clicking the layer plate. The 
shapes will be added to the current selection. 

  

Disabling Sheet Layers 
A sheet layer may be disabled by holding the [Control] key and left-clicking the layer. The layer plate will be 
superimposed with a hatch pattern, and all objects on that layer will become hidden on the workspace. 

  

  

A star on layer 1, and three circles on 
layer 2. 

After Control-clicking the layer 1 plate, 
the layer becomes disabled. Notice that 

the star is no longer visible. 
  

For a disabled sheet layer, holding the [Control] key and left-clicking that layer will enable it again. 

  

Sheet Layer Properties 
The properties for a sheet layer may be edited by double-clicking the sheet layer plate. The Sheet Layer dialog 
will open. 
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Active 
The Active option specifies whether this sheet layer is enabled or disabled. This option is an alternative to 
Control-clicking the layer, as described in the previous section. 

  

Type 
The Type of layer is “Engrave Only.”  

  

Highlight selected objects 
For shapes that are on a “Engrave Only” layer, those shapes will be given a red highlight. These highlights are 
intended as a quick visual cue to confirm the nature of a given shape. However, to enable or disable these 
highlights, use the "Highlight selected objects" option on the Selection Settings dialog. 

  

 
  

JOB PALETTE 
The Job Palette shows the colors that are currently being used on the workspace. This palette is also used to 
perform global color substitutions, such as instantly replacing all shapes of a given color with another color. For 
example, where different cutting depths have been assigned to a series of colors, performing a color substitution is 
a quick means of reassigning the cutting depth. 

By default, the Job palette shows the Color View, which lists all the color plates, primer colors and halftones that 
are currently in use on the workspace. 

  

 
  

The Foil View will cause the Job Palette to list only Spot Colors or Spot Foils, which serves as a quick summary 
of the spots that will be used when printing a job. 

  

Performing a Global Color Substitution 
The Job Palette can be used to substitute one color for another, and this substitution will take place throughout the 
entire workspace. For example, suppose that there are several RED shapes on the workspace, which need to be 
changed to ORANGE. 
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1) From the Shop Palette, left-click and drag the ORANGE color. The cursor will appear to be dragging the 
color plate. 

2) Move the cursor to the Job Palette, and position the TIP of the cursor over the RED color. 

3) Release the left mouse button, and all RED shapes will now be ORANGE. 

  

LINE STYLE TOOL 
Line Style Tool 

 
The Line Style tool is used to apply either a hairline stroke or “thick line” effect to workspace shapes. 

When a shape is selected, the colors of its fill and line style are visible from the SmartBar. For example, the 
following screenshot of the SmartBar shows that the current fill color is blue (process color plate 2). The red 
outline around the blue square indicates that the line style color is red. 

  

 
  

To change the line style color for a shape, right-click a color plate in the Shop palette. 

Note: For more information about changing colors, refer to the Shop palette, described earlier in this chapter. 

  

In cases where workspace shapes should have thick line styles, but none are visible, verify that the Show Tool 
Diameter option is active (under the View menu). 

  

 
  

To add a line style to a selected shape, choose Line Style from the Stroke and Fill Tools flyout. 

  

 
  

The SmartBar controls will appear similar to the following: 
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The line style is selected at the far-left of the SmartBar, as follows: 

  

Button Line Style Comment 

 
No line Removes any previously applied line style. 

 
Hairline Creates a 1-pixel wide line. This line cannot be cut, but it may 

be applied as a line stroke. 

 
Thick Line This is initially zero, so the line will not be visible until the 

Thickness field is incremented. 

  

  

At the far-right of the SmartBar, the color picker may be used to select the line style color. In addition, left-
clicking a Shop palette color will also change the line style color. 

 
  

For the Thick Line attribute, parameters of the line may be set from the SmartBar. 

  

 
  

Click the “Set Default Line Style” button to store the current SmartBar settings for reuse. However, please note 
the line color will not be stored as part of this default. 

  

Lock Proportions 
If the Lock Proportions option is enabled, then scaling the shape will cause the stroke thickness to be scaled in 
proportion. 

  

 
  

For example, the following two rectangles have been scaled by 200%. However, the yellow shape has a stroke 
with Lock Proportions enabled, such that its stroke has also been scaled by 200%. 
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Line Above 
By default, a thick line will actually overlap the contour of the shape. If the Line In Front option is enabled, then 
the line style will partially obscure the shape. Alternatively, the Line Behind option will cause the line style to be 
partially obscured by the shape. 

  

 
Line In Front The line style will appear as if it were above the shape. 

 
Line Behind The line style will appear as if it were below the shape. 

  

  

  
Star with line behind the shape. Star with line in front. Note that the star 

shape is partially obscured by the line 
style. 

  

  

End Styles 
There are three different line styles, which are used to modify the termination of open paths: 
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Butt End cap The line style will extend only to the end of the open path. 

 
Extended End 
cap Create square end caps as terminators for an open path. 

 
Round End cap Perform rounding of open paths. 

  

  

Corner Styles 
There are three corner styles: 

  

 
Sharp corner Corners retain sharp angles as per the base object. 

 
Round corner Corners are rounded. 

 
Miter corner 

For a sharp corner of the original object, the corner formed 
by the line style may be quite steep. Use the Miter 
Amount to clip the line style according to a percentage of 
the line thickness. 

  

  

 
Star with line behind the shape. The Miter 

Amount has bee set to 100% of the line 
thickness. 

  

Cutting Thick Lines 
When a shape with a thick line style is sent to be cut, the shape is effectively rendered as two objects (the shape as 
it is without a line style, and the line style itself). As such, there are two methods in which the shape and line style 
may be cut: 

�       Both the shape and its thick line style may be cut as separate objects, such that the original contour of 
the shape is not changed. This is useful because it helps to eliminate registration problems that might 
occur. 

�       Cut the thick line as shown, but only cut the shape where it is not obscured by the thick line. However, 
if the line style is "in front" of the shape, then there is a risk of a registration error (i.e. where the shape 
does not line up precisely with the line style). 

  

When jobs are sent for cutting, the presence of thick lines will open the following prompt: 
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Select Yes to cut the thick lines without diminishing the size of the original contour. 

Select No to send the job, though thick lines will ignored. 

If Cancel is selected, then Vision-Pro will return to the select state. At this point, it is possible to select the shape 
and perform a weld operation, which will convert the thick line style into a shape that is separate from the original 
shape. 

  

GRADIENT AND PATTERN FILLS 
Gradient and Pattern Fills 

The Gradient Fill tool is available from the Stroke and Fill Tools flyout. 

  

 
  

  

Gradient Fills 
Gradient Fills 

The gradient fill styles are selected at the far-left of the SmartBar. 
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Examples of these fills are as follows: 

  

 
Uniform Fill 

 

 
Linear Fill 

 

 
Radial Fill 

 

 
Conical Fill 

 

 
Square Fill 

 

 

Triangular 
Fill 

 
  

Choosing a Fill Style 
When a fill style is selected, color nubs will appear about the object on the workspace. 
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The placement of color nubs will depend on the given style. The initial color nubs will also be represented in the 
Gradient Bar. 

  

 
  

The two end-nubs of the Gradient Bar are fixed, but double-clicking within the Gradient Bar will add a color nub. 

  

 
  

The new nubs will also be shown on the workspace. 

  

 
A line joins the two initial color nubs, which will indicate valid regions for creating color nubs. Double-clicking 
within this valid region will create a color nub. 

Changing Nub Colors 
On either the Gradient Bar or the workspace, a color nub may be clicked to give it the focus. Once given the focus, 
the nub color may be changed by clicking the color picker. The color picker is located above the Gradient Bar. 

  

Dragging Color Plates 
Color plates may be dragged from the shop palette and dropped onto a color nub. The color nub will be assigned 
the given color. 
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Dragging a color plate from the shop palette 

  

 
Hold the color plate over the existing color nub, 

and then release the mouse button. 

  

 
The color nub is assigned the new color. 

  

  

If a plate is dropped onto an area of the shape that does not already contain a color nub, then a new color nub will 
be created. 

  

Deleting Color Nubs 
On either the Gradient Bar or the workspace, control-clicking a color nub will delete that nub. To clear all color 
nubs, click the Clear Nubs button. 

 
 

Horizontal and Vertical Position 
By default, the Gradient Fill is placed at the center of the object. The Horizontal and Vertical Position fields may 
be used to place the gradient fill. 
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Gradient Angle 
Dragging the color nubs may be used to adjust the angle of the fill. The Angle field on the dialog bar may also be 
used. 

 
  

Repeats 
The fill can be applied with either a Single, Sawtooth, or Wave repeat. 

  

 Single Render the fill from the initial color through to the final color. 

 Sawtooth 

Render the transition from the initial color through to the final color, which then 
repeat the specified number of times. For example, five colors with 4 repeats 
would display shades in the following order: 1-2-3-4-5, 1-2-3-4-5, 1-2-3-4-5, 1-
2-3-4-5. 

 Wave 

Render the transition from the initial color through to the final color, and then 
from the final color through (in reverse order) to the initial color. For example, 
five colors with 2 repeats would display shades in the following order: 1-2-3-4-5, 
5-4-3-2-1. 

  

Pinstripe versus Blend 
By default, fills have a Blend style. 

  

 
The Pinstripe style will create an abrupt transition between each fill color. 

 
Using a Blend style will create a gradual transition between each fill color. 

  

 
 

Spectrum Up and Down 
By default, a gradient fill between two colors will only have progressive shades between those two colors. By 
doing so, the intervening colors of the spectrum are ignored. By clicking either the Spectrum Up or Spectrum 
Down buttons, the blend of colors will include these intervening spectrum colors. 

For example, consider the memory aid ROYGBIV, which is short for Red, Orange, Yellow, Green, Blue, Indigo, 
and Violet. If the gradient fill is initially between Orange and Blue, then the following is true: 

  

Button Button name Resulting gradients 

 
Spectrum up Orange, Red, Violet, Blue 

 
Spectrum down Orange, Yellow, Green, Blue 
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Linear gradient – Orange to Blue 

 
  

Orange to Blue gradient – Clicked Spectrum Up 

 
  

Orange to Blue gradient – Clicked Spectrum Down 

 
  

 
 

Save Fill 
At the far-right of the SmartBar is the Save Fill button. When this button is clicked, the gradient fill will be saved 
as a new color plate and appended to the end of the Shop palette. 

  

 
  

 The gradient fill plate may then be applied like a regular palette color. 

  

 
  

By default, the name of the plate will be "Gradient Fill." If the Gradient Fill plate is double-clicked, then the Edit 
Gradient Fill dialog will open. 
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The Edit Gradient Fill dialog may then be used to rename the fill, choose different colors for the fill, or change 
the type of fill. 

Note: The Triangle Fill type is not available from the drop-list. The triangle gradient fill has a different Edit Gradient 
Fill dialog that is incompatible with the other gradient fills. 

  

 
 

Editing a Triangle Gradient Fill 
For a triangle gradient fill, the Edit Gradient Fill dialog behaves slightly differently than for the other fills. 
However, the only real difference is that there are three color pickers, which are used to select the triangle fill 
colors. 

  

 
  

Gradient Fills and Color Layers 
When a shape is applied with a gradient fill, that shape will be considered to remain on its original color plate 
layer, even though the shape will be rendered using the indicated fill. 
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Original shape with an aqua fill 

(plate layer 13) 
The same shape with a spot gradient fill. 

This shape is considered to be on layer 13. 

  

 
 

If the InstantReplay window is open, then the fill of the selected shape will be a "Special Fill" to indicate that it 
has a spot gradient fill. 

  

 
  

However, suppose that the "Special Fill" is selected, and then the Delete key is pressed. The gradient fill will be 
deleted, and the shape will have the fill of its original layer color (aqua). 
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Selecting shapes by their color 
As previously mentioned, Shift-clicking a color plate in the Shop palette will select all shapes that have that color 
fill. However, this also includes gradient fill shapes that originally had that color fill. 

For example, consider five shapes that had been applied with a beige color, where one shape was then applied 
with a spot gradient fill. 

  

 
  

Later, it was decided that the beige colored shapes should be selected. From the Shop palette, the beige color plate 
was Shift-clicked, such that all of the beige shapes were selected. However, the gradient fill shape also became 
part of the selection, since it is considered to be on the beige color layer. 
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When deleting a color layer 
In the previous example, suppose that the beige shapes have been deleted, and the gradient fill shape is the only 
remaining shape on the workspace. 

  

 
  

By double-clicking the beige color plate, the Edit Color dialog will open. If the Remove button is now clicked, 
then a warning dialog will prevent the color plate from being removed. 
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The Edit Color dialog for beige. Clicking the Remove button would normally delete the beige color plate. 
However, a warning dialog indicates that the plate cannot be removed. 

  

The beige color plate cannot be removed because the gradient fill shape uses beige as its original layer color. To 
delete the beige color plate, the gradient fill shape must be assigned a different (non-gradient) fill color from the 
Shop palette. 

Gradient Fills and Welds 
When creating a design that includes gradient fills, it is recommended that detailed editing of the gradient fills be 
postponed until after all welds have been completed. The problem is that when shapes are welded, their original 
color layers are reasserted, thereby losing any gradient fills. This is a common situation when working with foil 
colors, since the Inlay Weld is useful as a means of avoiding registration problems. 

For each shape that will eventually be applied with a gradient fill, assign an unique layer color instead. This will 
allow such shapes to remain distinct from the other workspace shapes. After all welds have been completed, the 
gradient fills may then be applied to the unique color shapes. If necessary, the unique color shapes may be selected 
by Shift-clicking their color plate on the Job palette.
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OPERATIONS ON SHAPES 
OPERATIONS ON SHAPES 

Selecting Shapes 
Select By Size 
General Nub Actions 
Other Shape Commands 
InstantReplay 
Decorative Border 
Stencil Tool 
Array 
Alignment and Align 
Start Sequence 
Stretch 

 

SELECTING SHAPES 
Selecting Shapes  

To select a shape, click within the fill area the shape. Selection handles will appear about the shape to indicate that 
it is selected. 

  

  
Unselected object Selected object 

  

Note: If the [ALT] key is used as a modifier key, then a shape will only become selected by clicking along the shape 
contour. This is a useful means of differentiating from between several clustered shapes. 

  

When a shape is selected, its properties may be edited from the SmartBar. By default, the contour of a selected 
shape will be highlighted, so as to improve the ease of working with small or complex objects. If the highlight 
border needs adjusting, then changes to the highlight appearance may be made in the Selection Tool Settings 
dialog.  

Handles will appear about a selected shape, which may be used to adjust the shape by clicking and dragging a 
given handle. Handles are also known as Control Nubs, and the available nubs are: 

  

�       Center Nub 

�       Corner Nub 

�       Edge Nub 

�       Rotate Nub 
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The following diagram indicates where these nubs are typically placed about the boundary of a shape: 

  

 
  
 
 

Center Nub 
Center Nub 

The Center Nub is used drag the position of a shape, which is equivalent to the Move command (Layout menu). 

�       Hold the cursor over the Center Nub until the cursor changes into a crosshair icon. 

�       With the crosshair icon, click and drag the shape. 

�       When the shape is in the correct position, release the mouse button. 

  
When dragging a shape, the [Control] key may be held to constrain the shape either vertically or horizontally. 
Also when dragging a shape, the [Alt] key may be pressed to create a duplicate of the shape. 

Nudge comment: When selected, the cursor keys may be used to "nudge" the object. The object will nudges one-pixel 
in the given direction, though holding the [Shift] key will perform a five-pixel nudge. 

  

Corner Nub 
The Corner Nub is used to scale a shape, while also maintaining the aspect ratio of the original shape. 

�       Hold the cursor over a Corner Nub until the cursor changes into a bi-directional cursor. 

�       With the bi-directional cursor, click and drag to scale the shape. 

�       When the correct scaling is achieved, release the mouse button. 

  
When scaling a shape, the [Shift] key may be held to prevent the aspect ratio from being maintained. Also, the 
[Control] key may be held to constrain the object to multiples of its original size (double-size, triple-size, etc.). 

  

Edge Nub 
The Edge Nub is used to resize a shape either horizontally or vertically. 

�       Hold the cursor over an Edge Nub until the cursor changes into a bi-directional cursor. 
�       With the bi-directional cursor, click and drag to resize the shape. 
�       When the correct size is achieved, release the mouse button. 

  
When resizing a shape, the [Shift] key may be used as follows: 

  

Shift + Left nub Change width of object, though maintain constant vertical axis 
of object 
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Shift + Top nub Change height of object, though maintain constant horizontal 
axis of object 

Shift + Bottom nub Maintain proportional width and height 

Shift + Right nub Maintain proportional width and height 

  

  

Rotate Nub 
The Rotate Nub is used to adjust the orientation of the shape. 

�       Hold the cursor over the Rotate Nub. 
�       Click and drag the Rotate Nub. The bounding box of the shape will be rotated to match the 

mouse movements. 
�       When the correct rotation is achieved, release the mouse button. 

  

EDIT MODE 
Double-clicking a parametric object will enter a special editing mode. The contour of the object may then be 
modified by clicking and dragging the nubs of the object. In some cases, the editing nubs behave similarly to the 
nubs that appear on a selected object. However, the precise usage of nubs when editing will depend upon the type 
of object. For instance, compare double-clicking a rectangle shape with that of a circle shape. 

  

  
Editing a rectangle Editing a circle 

  

When editing a rectangle, the available nubs are at the corner, edge and center of the shape outline. Notice that 
though no rotation nub is present, additional nubs exist for rounding the corners of the rectangle. When editing a 
circle, only a center nub and "radius" nub exist. These nub differences between rectangles and circles are typical, 
so as to improve the variety of shape combinations. 

  



Vision-Pro 7 Doc Files 

204 

 
Editing an arrow 

  

SWEEP SELECTING OBJECTS 
A sweep select is simply a quick means of selecting several objects by surrounding the objects with a marquee. 
Modifier keys may also be used as follows: 

  

Shift-sweep select 
Add the objects to the current selection 

  

Control-sweep select 
All objects that fall within bounds of the marquee will become selected. The current editing operation (if any) will 
be applied to the objects. 

  

Alt-sweep select 
For small objects that are within the area of a larger object, use [ALT] + marquee to select the small objects 
without selecting the larger object. 

  

SELECT BY SIZE 
Select By Size 

Workspace shapes may be selected according to their size. Under the Edit menu, choose Select By Size item, and 
the Select by Size controls will appear in the SmartBar. 
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At the far-left of the SmartBar are the Width and Height parameters, which are used for comparison with shape 
dimensions. If a shape had been selected when choosing the Select By Size item, then the Width and Height 
fields will be set according to that shape. If no shape had been selected, then the Width and Height fields will be 
set according to the sign plate. 

Next to the Width and Height parameters are checkboxes, which are used as follows: 

  

Width Height Behavior 

enabled enabled Both Width and Height fields are used when making 
comparisons. For example, if the Smaller Than button is clicked, 
then shapes will be selected only if both their widths and heights 
are less than the indicated Width and Height. 

enabled disabled Only Width is used when making comparisons. 

disabled enabled Only Height is used when making comparisons. 

disabled disabled Disables both the Smaller Than and Bigger Than buttons. 

  

Comparison buttons 
Comparison buttons 

The following buttons are used to choose the manner of comparison. These buttons use the Width and Height 
values as the basis for comparison. However, please note that the checkboxes next to the Width and Height fields 
are used to limit the comparisons. 

  

 
Smallest 

 
Biggest 

 
Smaller Than 

 
Bigger Than 

  

Reset 
Click the Reset button to clear the current selection. The Width and Height fields will be set to the sign plate 
dimensions. 

  

Inverse 
Click the Inverse button to perform an inverse selection. All the currently selected shapes be become deselected. 
The current selection will become all shapes that had not been selected. 

  

SELECT BY OPEN 
Select all shapes that are open paths. Use this tool to quickly select fragments after scanning images or importing 
vector files. 

  

GENERAL NUB ACTIONS 
General Nub Actions  

Nudge 
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Nudge 
Nudge 

Objects may be moved one pixel at a time, which is termed a "nudge." For a selection, pressing the cursor keys 
will move the selection by one pixel. Holding [Shift] will move the selection by 5 pixels. 

Shortcut to the Layout Menu 
If the mouse cursor is over an object nub, then the right-mouse button will open the Layout context menu. 

Move 
Objects may be moved with respect to either their previous workspace coordinates, or the origin of the sign plate. 

Size 
Drag the nubs of the shape to resize. When dragging, note that the fixed nub is indicated in the SmartBar (turns 
red). 

Rotate 
Using the Rotate feature, objects may be rotated by dragging their corner nubs. By default, the Center of Rotation 
is placed at the center of the object, but the Center of Rotation can be changed by dragging it with the mouse. 
When rotating, the Rotation Amount may also be entered in the SmartBar. 

Mirror 
The Mirror feature creates a mirror image of the selected object. Mirror images may be created in either the 
vertical or horizontal plane. 

Dragging either the side- or corner-nubs of an object may also be used to create a mirror image. However, the 
[Control] key must be pressed in order to constrain the object to its original dimensions. 

  

 
 

OTHER SHAPE COMMANDS 
Other Shape Commands  

Slant 
Measuring Objects 
Basic Tools for Operations 

Slant 
Slant 

The Slant feature skews or slants selected objects either horizontally or vertically. 

Grouping Objects 
The Group and Ungroup commands may be used to organize collections of workspace objects. 

Clear Transformations 
The Clear Transformations feature removes all Move, Rotate, Size, and Slant transformations applied to 
workspace objects without reversing any edits made to the object. For example, a line of text can be rotated and 
then edited to include an extra letter. Clear Transformations will remove the rotation from the text while the extra 
letter remains a part. 

MEASURING OBJECTS 
The Measure Tools are used to label workspace dimensions, and to place notes about workspace objects. 
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The available tools are: 

  

 
Measurement 

Measure the distance between two points by clicking on the 
workspace. The Desired Distance field may be set between 
these points, which causes the selected objects to be resized 
proportionally. 

 
Dimension Create a measure of the distance between two workspace 

locations. 

 
Object 

Dimension 
Create a measure of the height or width of the selected 
object. 

 
Arrow Draw 

The Arrow Draw tool is used to annotate the workspace. 
For each arrow drawn, a note may be created. The arrow 
attributes (thickness, termination style) may be edited from 
the Dimensioning Setup dialog. 

 
Notes Add descriptive notes to the workspace. 

  

 
 

BASIC TOOLS FOR OPERATIONS 

Cut and Paste 
The basic Copy and Paste commands are typical of Windows applications: 

  
Cut [Ctrl + X] Transfer the current object to the Windows clipboard. 
Copy [Ctrl + C] Store the current object on the Windows clipboard. 
Paste [Ctrl + V] Insert from the Windows clipboard to the Vision-Pro 

workspace. 
Clear [Del] Remove the selected object from the workspace. 
Duplicate [Ctrl + D] Create a copy of the selected object. The offset for 

duplicates is set from the General Preferences dialog. 
  

Note: Copying and pasting a shape will automatically simplify the pasted shape. 

  
  

Undo and Redo Navigation 
In addition to Undo and Redo commands, there are navigator windows for browsing multiple operations.  

  
Undo [Ctrl + Z] Reverse the previous operation. When node editing, only 

five levels of Undo is permitted. 
Redo [Ctrl + Y] Reverse the previously performed Undo operation. 
Undo Navigator   Open navigator dialog for choosing point after which all 
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operations will be reversed. 
Redo Navigator   Open navigator dialog to choose Undo operations to be 

reversed. 
Purge Undo   Remove all Undo and Redo information from memory, 

thereby freeing that memory for other uses. 
Repeat [Ctrl + R] Apply the previously performed operation to the 

currently selected object. 
  

Note: For advanced operation manipulation, please refer to the Instant Replay feature, which is discussed in the 
following section. 

  

Locking workspace objects 
Property locks are used to limit the types of operations that may be performed on workspace objects. Two types of 
restriction may be applied. An operation may be "locked," which prevents that operation from being modified for 
a given object. An operation may also be "restricted," which prevents the locked-status from being modified 
without authorization. 

  

Simplifying Objects 
As operations are applied to a shape, those operations are stored as part of the shape history. The InstantReplay 
feature displays this history as a list, where individual operations may be double-clicked and edited. 

For a shape composed of many different operations, the Simplify command will incorporate these operations into 
the shape. Simplified operations will not be displayed in the Instant Replay window, nor will they be editable. 
This feature is useful for aggregating a shape before applying new operations to it. 

For a shape that have been applied with a tool path, node editing the shape will automatically update the tool path 
to correspond with the new shape contour. However, applying the Simplify command to the object will break the 
association between the object and tool path, which will allow the object nodes to be edited without changing the 
tool path contour. 

To simplify a selected shape, choose Simplify from the Arrange menu. 

  

Simplify and Tool Paths 
After a tool path is applied to a shape, suppose that the shape is then node edited. When node editing is complete, 
the corresponding tool path will be updated to maintain consistency with the new shape contour. However, 
applying the Simplify command to the object will break the association between the object and tool path, which 
will allow the object nodes to be edited without changing the tool path contour. 

  

Use InstantReplay 
By default, the Use InstantReplay option is enabled, which causes operations to be updated when the base shape 
has been modified. To discard the association between operations and their base shape, disable the Use 
InstantReplay option. However, please note that the association between operations will be permanently lost. 

As an alternative to disabling the Use InstantReplay option, use Simplify from the Arrange menu. 

  

INSTANTREPLAY 
InstantReplay 

The Instant Replay feature is a graphical interface for editing and reusing operations, where an operation is any 
transformation or special effect that can be applied to a Vision-Pro shape. Use InstantReplay to edit or remove the 
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operations that have been applied to a shape. When a set of operations has successfully achieved a desired effect, 
those operations may be stored and applied to new shapes in future Vision-Pro sessions. 

Using InstantReplay 
Suppose that a couple of text shapes have been created on the workspace. Initially, no operations have been 
applied to these text shapes, so the InstantReplay window will indicate the basic operations that exist for all newly 
created shapes. 

  

 
  

For the first text shapes, a transformation operation was performed, followed by a gradient fill. When the shape is 
selected, the InstantReplay window indicates that a "Special Fill" has been applied, as well as a Perspective 
Transformation. 

  

 
  

To use the same fill settings on the second text shape, click and drag the "Special Fill" from the InstantReplay 
window. Drag-and-drop the "Special Fill" onto the second text shape, and the fill will be applied. 
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Similarly, drag-and-drop the "Perspective Transform" onto the second text shape. 

  

 
  

When the second text shape is selected, the InstantReplay window will show that both the Special Fill and 
Perspective Transform have been applied. 
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Using the Storage Bin 
At the top of the InstantReplay window is the Show Clipboard button. 

  

 
  

Clicking the Show Clipboard button will open the Storage Bin window. The Storage Bin is a convenient holding 
area for operations that you would like to reuse frequently. 

  

 
  

For a selected shape, operations may be dragged-and-dropped onto the Storage Bin. The operation will then be 
listed within the Storage Bin, regardless of the currently selected shape. 

  



Vision-Pro 7 Doc Files 

212 

 
  

Suppose that the "Special Fill" and "Perspective Transform" operations from the previous section had been 
dragged into the Storage Bin. By then selecting both operations within the Storage Bin, those operations may be 
dragged-and-dropped onto another text shape. 

  

 
  

The text shape will then be applied with both operations. 
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The Instant Replay Window 
The Instant Replay Window 

The Instant Replay window lists the operations that have been applied to the currently selected workspace shape. 
Individual operations may be edited, deleted, or copied to the Storage Bin for application to other shapes. 

Dragging an operation within the list can change the order in which operations are calculated for a shape. Further, 
an operation can be dragged from either the InstantReplay or Storage Bin windows and dropped onto a 
workspace object. 

  

 



Vision-Pro 7 Doc Files 

214 

  

The basic operations for any shape are the Line Style, Line Color, Layer, Page Range, and Sheet Layer. These 
operations are considered to be elemental to any shape. Though these basic operations may be edited, neither 
deleting them nor combining them with other operations is permitted. 

Editing an operation will activate the editing controls for that given operation. 

  

 
Copy to 

Clipboard 

Use this button to copy the selected operations to the Clipboard. 
Note that the Storage Bin is used to display operations that have 
been copied to the Clipboard. 

 
Paste from 
Clipboard 

Use this button to apply the selected Clipboard operations to the 
current shape. The Storage Bin is used to pre-select the desired 
operations for pasting. 

 
Show 

Clipboard 

Use this button to show the Storage Bin, where all the operations 
from the Clipboard are listed. Pressing this button again will hide 
the Storage Bin. 

 
Simplify 

Clicking the Simplify button will perform the same operation as 
choosing Simplify under the Arrange menu. Please refer to 
Simplifying Objects, discussed earlier this chapter. 

 
Edit 

Edit the currently selected shape. If no objects are selected, then this 
button will not be visible. 

  

 
 

Original List 
The Original List contains references to the shapes prior to their operations being performed. The Type of each 
shape is displayed for reference, such as Text objects, Paths, Polygons, Polyarcs, Notes, Dimensions, and Bitmaps. 

The Layer number indicates the color palette index that has been applied to the shape. By clicking the head of the 
Layer column, shapes may be ordered according to their palette number, which is a useful means of organizing 
related shapes. 

Intermediate List 
After applying certain operations, the original shape will no longer exist because it has been replaced by a new 
shape that represents the results of the operation. For example, applying an Outline will create a new shape that 
represents the outline, and unless the “Keep Original” option is used, the original shape will be deleted. The 
Intermediate List is used to store a reference to such original shapes, such that the operation may be edited. 

Screen List 
The Screen List displays all the screen shapes in terms of the types of objects that they represent. Click on a path 
type to isolate its shape from the surrounding graphics. 

Operations List 
For the selected shape, the operations that have been applied to this shape are listed here. The operations are listed 
in chronological order, though this order can be changed by dragging an operation with the mouse. To edit an 
operation, double-click the operation name. 

 
 

Show Storage Bin 
The Storage Bin is a convenient means of viewing and organizing the operations that have been copied to the 
Clipboard. With respect to Instant Replay, the Clipboard and the Storage Bin are synonymous. 

Note: As well as using the Instant Replay buttons, drag-and-drop operations are permissible between the Instant Replay 
window and the Storage Bin. 
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Open File 

Click this button to open a previously stored selection of operations. 

 
Save File 

To save operations for later use, select the desired operations and click 
the Save File button. Files are stored in an .SBN (Storage Bin) format. 

 
Copy to 
Clipboard 

For the currently selected shape, clicking this button will copy all of the 
shape operations to the Storage Bin. 

 
Paste from 
Clipboard 

Click this button to apply operations from the Storage Bin to the 
currently selected shape. If no operations are selected, then the entire 
list of operations in the Storage Bin will be applied. Otherwise, use the 
mouse in combination with shift and control keys to select the 
operations that should be applied. 

 
Clear 
Clipboard 

Click this button to delete the contents of the Clipboard and the Storage 
Bin listings. 

 
Combine 
Operations 

Click this button to combine a selection of operations into a single 
operation. The combined operations will be named “Combination,” but 
this name may be changed by double-clicking the combined operation. 
Once operations are combined, they can be selected and applied in the 
same manner as discrete operations. 

  

 
 

DECORATIVE BORDER 
Decorative Border 

The Decorative Border shape is used as a frame for the design. To create a Decorative Border, access this tool 
from either the Layout menu, or the Shape Tools flyout. 
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For a selection of one-or-more shapes, the Decorative Border will be centered on the shapes, and the inner 
contour of the border will be set equal to the bounding box of the selection. The outer contour of the border will 
then be set according to the Thickness of Border field. 

  

 
  

Tie Border To 
When no shapes are selected, the SmartBar provides a Tie Border To option that is set to "Plate" by default. In 
this case, the Decorative Border will be centered on the sign plate, and the outer contour will be set equal to the 
dimensions of the sign plate. The inner contour of the border will then be set according to the Thickness of 
Border field. 

  

 
  

If the Tie Border To option is set as "None," then the center nub may be dragged to change the coordinates of 
the Decorative Border. 
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Border Styles 
Border Styles 

There are four pre-defined decorative border styles, which may be chosen at the far-left of the SmartBar. 

  

 
  

The choice of style will determine the SmartBar controls that are available, as well as the nubs that appear about 
the decorative border shape. 

  

Decorative Border Nubs 
Editing nubs about the decorative border shape may be used to adjust the inner and outer contours of the border. 
When editing a "Single Path Border," nubs will only appear for the outer contour. When editing a "Border with 
Thickness," nubs will appear for both the outer and inner contours. 

  

 
  

These editing nubs are summarized as follows: 
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Nub Function 

1 Adjust the workspace coordinates of the border. These coordinates may only 
be changed when the Tie Border To setting is "None." 

2 Adjust the Thickness of Border value by varying the inner contour. Hold the 
[Control] key to maintain a constant thickness. 

3 Adjust the Thickness of Border value by varying the outer contour. 

4 Adjust the outer contour of the border, while maintaining a constant Thickness 
of Border value. 

  

  

 
 

Corner Nubs 
Except for the Square Border style, editing nubs are used to adjust the corners of the border. These nubs allow 
the outer corner radius to be adjusted independently of the inner corner radius. 

Note: The Inside Notched Border style does not have corner nubs for the outer contour. 

  

The following screenshot shows the editing nubs for the Rounded Border style. These nubs behave similarly for 
the Notched Border and Inside Notched Border styles. 

  

 
  

The values for the corner radius may also be set at the far-left of the SmartBar. 

  

 
  

To the right of the corner radius fields, the Radius Lock and Radius Unlock buttons may be used to lock the 
outer radius to the inner radius. When locked, the Outside corner radius will be assigned the same value as the 
Inside corner radius. 
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SmartBar Controls 
The available SmartBar controls will depend upon the style of border being edited. For a Square Border style 
placed upon the sign plate, the SmartBar controls will appear similar to the following: 

  

 
  

 
 

Inner Contour Option 
If the Single Path Border style is selected, then the border shape will be a filled object with no inner contour. If 
the Border with Thickness style is selected, then additional nubs are available for editing the inner contour of the 
border. 

  

 
Single Path Border 

 
Border with Thickness 

  

Thickness of Border 
This field is only active when the Border with Thickness option has been selected. 

For selected shapes, the Thickness of Border field is used to indicate the distance from the inner contour to the 
outer contour. If no shapes are selected, then the Thickness of Border field indicates the distance from the outer 
contour to the inner contour. 

  

Width and Height 
The Width and Height fields indicate the dimensions of the outer contour. If the Tie Border To setting is 
"None," then the Width and Height fields will be editable. 

  

 
  

Horizontal and Vertical Offsets 
For a border placed around one-or-more selected shapes, the inner contour of the border will be set equal to the 
bounding box of the shapes, and the outer contour will be set using the Thickness of Border field. 

For a border placed with respect to the sign plate, the outer contour will be set equal to the dimensions of the sign 
plate. The inner contour is then set using the Thickness of Border field. 
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The Horizontal and Vertical Offsets are used to set the outer contour with respect to its initial dimensions. When 
adjusting these offsets, the Thickness of Border field will remain constant. 

  

 
  

Lock Offset Values as Equal 
At the far-right of the SmartBar, the Horizontal and Vertical Offsets may be locked as equal. 

  

 
  

When locked, only one offset field will be active, and its value will be used for both offsets, as follows: 

  

 
Unlock offset values 

 
Lock offset values as equal 

STENCIL TOOL 
Stencil Tool  

The Stencil tool is used to apply a clipping style to one-or-more selected shapes. The resulting stencil bands will 
be like "windows" through which the underlying shapes may be viewed. 

For a given selection, choose Stencil from the Shapes Tool flyout. 

  

 
  

The Stencil tools will appear in the SmartBar. 
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Stencil Handles 
Stencil Handles 

When editing the stencil, workspace handles will appear about the shape. The following screenshots show 
horizontal stencil bands that are being edited for a square shape. Similar handles will appear for other stencil 
styles. 

  

  
Original object before applying 

stencil. 
Editing horizontal stencil that has 

three repeats. 
  

 
 

The function of each workspace handle is as follows: 

  

Handle Function 

1 Adjust coordinates of the stencil 

2 Adjust Spacing between each stencil line 

3 Adjust Thickness of each stencil line 

4 Adjust Angle of stencil 

  

  

Angle 
The Angle may be set from either the SmartBar or the workspace. 
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Angle field on SmartBar Angle handle on workspace 

  

Repeats 
The Repeats are set from the SmartBar. The number of repeats indicates the number of stencil lines that will be 
created. 

  

 
  

Note: If there appear to be fewer stencil lines than indicated by the Repeats field, then it may be the case that there is a 
large distance between each stencil line. In this case, try reducing the Spacing value, or increase the shape size. 

  

 
 

Stencil Origin 
The X and Y fields indicate the origin coordinates for the stencil. These coordinate may be set from either the 
SmartBar, or the workspace. 

  

  
Coordinate fields on SmartBar Coordinates handle on workspace 

  

To the right of each X and Y field is a Units button that determines the units of the coordinates. By default, the 
current workspace units are used (in this example, inches are used). However, clicking either Units button will set 
the value as a percentage of the object size. For example, the following screenshot shows the stencil origin set at 
50% of the width and height of a circle shape. 
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Radial stencil with seven repeats. The X 
and Y coordinate are set at 50% each, 
which centers the stencil on the shape. 

Circle with radial stencil preview. Note 
that the Coordinates handle is at center 

of the circle shape. 
  

 
 

Thickness 
The Thickness indicates the width of each stencil line. The Thickness may be set from either the SmartBar or the 
workspace. 

  

  
Thickness field on SmartBar Thickness handle on workspace 

  

To the right of the Thickness field, the Units button may be clicked to express the thickness as a percentage of the 
object size. 

  

Spacing 
The Spacing indicates the distance between each stencil line. The Spacing may be set from either the SmartBar or 
the workspace. 

  

  
Spacing field on SmartBar Spacing handle on workspace 
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To the right of the Spacing field, the Units button may be clicked to express the spacing as a percentage of the 
object size. 

  

 
 

Constant versus Accelerated Stencil 
If the Constant option is selected, then there will be one handle each for Thickness and Spacing on the 
workspace. 

If the Accelerated option is enabled, then additional red handles will appear over both the Thickness and Spacing 
handles. By adjusting these "acceleration" handles, the thickness and spacing of successive stencil bands may be 
made to "accelerate." 

Note: The Accelerated option is not available for Radial nubs. 

  

  

  
Workspace handles when the 
Constant option is enabled. 

When the Accelerated option is 
enabled, there are additional red 

handles for the Thickness and 
Spacing handles. 

  

  

Editing a Stencil Using InstantReplay 
Suppose that we have applied our horizontal stencil to a square shape, using three repeats. We later decide that a 
25 degree angle should also be applied to the stencil. However, if we select the stencil object, we find that the 
original square shape and stencil are now part of a group, and that choosing the Stencil tool will merely attempt to 
apply a new stencil on top of the group. 

As a solution, the InstantReplay feature may be used to edit the Stencil.  

  

First, verify that the InstantReplay window is open, by enabling the Show InstantReplay item under the View 
menu. 

 
 

In the InstantReplay window, you may choose the Group object that is within the Screen list. However, the 
Operations list will not provide access to the Stencil operation. 
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Instead, double-click the Group object that is within the Screen list. The Group object will be expanded to reveal 
that it is composed of a Rectangle shape and a Stencil shape. The Rectangle may then be selected to provide 
access to the Stencil operation. 

  

 
  

Within the Operations list, the Stencil operation may now be double-clicked to begin editing. The Stencil 
controls will appear within the SmartBar, and the Angle may be changed to 25 degrees. 

  

 
  

 
 

When finished editing the Stencil, click the Accept button to finish. The edited stencil will appear on the 
workspace. 
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ARRAY 
Array 

The Array feature is used to create patterns using selected shapes as a basis. Copies of the original shapes will be 
used to fill out the array. 

  

 
  

  

The available Array styles are as follows. Please note that the SmartBar controls are slightly different when 
creating arrays “on an arc.” 

  

 Vertical 

 Staggered 

 Horizontal 

 Grid 

 On arc 

 On arc with rotate 
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Spacing Method 
When spacing the copies either horizontally or vertically, the copies may be spaced either Object-to-Object, or 
Between Objects. If spacing Object-to-Object, then the copies are spaced with respect to the lower-left corner of 
each shape. If spacing Between Objects, then copies are spaced from the trailing edge of each shape to the 
leading edge of the subsequent shape. 

  

Spin Amount 
The array copies can be rotated by adjusting the Spin Amount. 
  

 
  

If the Spin Each option is enabled, then each subsequent shape will be rotated by the Spin Amount. For example, 
the first shape will not rotated, the second shape will be rotated by the Spin Amount, the third shape will be 
rotated by a further Spin Amount, and so on. 

If the Total Spin option is enabled, then the last array shape will be rotated by the Spin Amount, and intermediate 
array shapes will be rotated evenly from  

  

Arrays on an Arc 
When the Array Style is set to either On Arc or On Arc With Rotate, then the Spacing Method (space between 
shapes) does not apply. Instead, the shapes are spaced evenly over an arc, and this arc can range from 0° to 360°. 
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The Starting Angle indicates the beginning of the arc, the Ending Angle indicates the end of the arc, and the Arc 
Radius is the size of the arc. For example, by setting the Starting Angle to 0 and the Ending Angle to 360 will 
cause the shapes to be spaced evenly along the arc of a full circle. By setting angles of 0 and 180, then the shapes 
will be spaced along a half-circle. 

  

 
  

Arrays on Arc with Rotate 
The On Arc With Rotate is similar to the On Arc option, except that there are no Spin Amount setting, and each 
array copy will be automatically rotated to point away from the center of the arc. 

  

ALIGNMENT AND ALIGN 
Alignment and Align 

The Alignment command is used to access controls for precisely arrange the workspace objects, and the Align 
command is used to apply the most recent Alignment settings. 

  

 
  

Alignment Mode 
Alignment Mode 

Selected objects may be arranged according to: 

  

 
Align to sign plate Objects are aligned relative to the sign plate. 

 
Align to grid Objects are aligned relative the grid lines. 
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Align to last object For group selection, align the objects according to the 

last object in the group. 

 
Align to selected For a group selection, align the objects according to the 

bounding box that is around the selection. 
  

Text Options 
There are two additional tools for use when aligning text objects. 

 
Treat Text Line as an Object 

 
Ignore Descenders 

  

  

 Treat Text Line as an Object 
This option only applies to vertical alignment. When enabled, each line within a text paragraph will be aligned like 
a separate object. 

  

  
Three text objects, with the “Treat Text Line as 

Object” option OFF. 
The same three text objects, with the “Treat Text 
Line as Object” option ON. Note that each line 

within the second text object is treated as a 
separate object for the purpose of alignment. 

  

 Ignore Descenders 
This option only applies to vertical alignment. When enabled, the descenders of text will be ignored when 
applying alignment. Instead, text will be aligned according to its baseline. 

  

ALIGN TO BASELINE 
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For images that are imported into Vision-Pro, it may be the case that the objects are slightly misaligned with the 
sign plate. The Align to Baseline feature allows these objects to be aligned to either the horizontal or vertical 
plane. In addition, image can be aligned to a 45 degree angle, or a custom angle may be set. 

  

 
  

Before performing the alignment, a line must be defined along the edge the image. To define this line, two points 
must be set. Clicking within the workspace will set the Anchor Point (the point of rotation), and a clicking again 
will set the Second Point (the snap point). When a snap angle is applied, the line will be aligned to match the 
indicated angle, and the image will remain aligned with the line. 

  

VERTICAL AND HORIZONTAL SPACING 
The Layout | Arrange and Distribute | Spacing commands are used to space the selected objects out evenly. As 
an option, the amount of space to maintain between objects can be specified. 

  

 
  

START SEQUENCE 
Start Sequence  

The Start Sequence command has two uses. The first use is to arrange the order in which objects are processed 
when drawing, cutting, plotting, routing, engraving, or printing. The second use is to arrange objects graphically 
on-screen. In either case, reordered objects will be placed with respect to the original layer of the first color 
selected (see Order of workspace objects). 

 

Creating a Sequence 
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Creating a Sequence by Vector 

Creating a Sequence by List 

Creating a Sequence 
Creating a sequence  

To create a sequence for a collection of objects: 

 

1.        Select the first object of the collection. 

2.        From the Layout menu, choose Sequence, and Start Sequence. 

3.        Click each remaining object, one-by-one, until all the objects are included. As each object is included, a 
line is drawn from the previous object to the current object. 

4.        When finished selecting objects, click anywhere on the workspace that is empty of objects. 

 

The objects will now be ordered according to the chosen sequence. Each successive object in the sequence will 
appear to be on top of the previous object in the sequence. 

Alignment using start sequence  
1.        Select the first object of the collection. 

2.        From the Layout menu, choose Sequence, and Start Sequence. 

3.        Click each remaining object, one-by-one, until all the objects are included. As each object is included, a 
line is drawn from the previous object to the current object. 

4.       Right-click and drag over an area where the objects are to be arranged. 

As the mouse is dragged across the workspace, an outline of the shapes will appear, and a thin line between the 
shapes will indicate center alignment of each object. 

 

This alignment can be adjusted as follows: 

�       Holding the [Shift] key will align the shapes according to their lower-left bounding box corner. 

�       Holding the [Control] key will constrain the objects either vertically or horizontally. 

 

 
 

Creating a Sequence by Vector 
Creating a Sequence by Vector 
The Start Sequence by Vector command is similar to the Start Sequence command, except that multiple 
shapes are added to the sequence by drawing a line.  

1.  Select the first shape. 

2.  From the Layout menu, choose Sequence, and Start Sequence by Vector. 

3.  Click and drag the cursor to form a line. All shapes that are intersected by this line will become 
part of the sequence. 

4.  Click on an empty portion of the workspace to finish editing. 

Alignment Using start Sequence by Vector 
1. Select the first object of the collection. 

2.  From the Layout menu, choose Sequence, and Start Sequence by Vector. 

3.  Click each remaining object, one-by-one, until all the objects are included. As each 
object is included, a line is drawn from the previous object to the current object. 
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4.  Right-click and drag over an area where the objects are to be arranged. 

As the mouse is dragged across the workspace, an outline of the shapes will appear, and a thin line 
between the shapes will indicate center alignment of each object. 

 

This alignment can be adjusted as follows: 

�� Holding the [Shift] key will align the shapes according to their lower-left bounding box 
corner. 

�� Holding the [Control] key will constrain the objects either vertically or horizontally. 

 

Creating a Sequence by List 
The Start Sequence by List command will open the Sequence by List dialog, which provides a visual list 
of all the shapes that are on the workspace. Shapes at the front of this list will appear above other shapes, 
and shapes at the back will appear below.  
The mouse can be used to drag shapes within this list. Alternatively, select a shape and use the To Front, 
To Back, Forward One, and Back One buttons. To use the Reverse Order button, at least two shapes 
must be selected. 

STRETCH 
Stretch 

The Stretch feature is used to distort an object as if the object had elastic properties. Objects may be stretched in 
either an upward or rightward direction. 

 

Note: Performing a stretch operation may not be initially successful for complex objects. To solve this, perform a series 
of smaller stretches until the amount of desired stretch is achieved. 

Constant Stroke Stretching 
For text objects, script fonts may be enhanced by stretching the text either horizontally or vertically, which will 
not distort the opposing strokes. For example, consider the follow text that uses an Ajax font: 

  

 
  

Here is the same text after performing a 60% vertical stretch: 
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 SPECIAL EFFECTS 
SPECIAL EFFECTS 

Outlines and Inlines 

OUTLINES AND INLINES 
Outlines and Inlines 

Outlines and Inlines are workspace objects that are calculated to follow the contour of a selected, base object, 
such as a star or rectangle. An Outline will typically be "outside" the base object, and an Inline will be "inside" the 
object. 

  

Passes 
Implement more than one Outline or Inline pass at a time to any selected objects by using this option. For 
example, use multiple passes to achieve special effects, such as ripples on a pond, by applying a multiple pass 
Outline to the selected object(s). 

 

 
Star with five outline passes Modified star with two inline passes 

  

When a corner of an object is sharp, the resulting outline can extend well beyond the corner itself. Such corners 
may be clipped or rounded. The available options are as follows: 

  

 
Point Allow sharp corners 

 
Clipped 

Clip sharp corners as per the Miter Limit (see below) 

 
Round 

Round sharp corners 

  

Miter Limit 
The Miter Limit is a distance that is expressed as a percentage of the outline or inline thickness. 

For a sharp corner of the original object, the resulting outline corner may be quite steep. If the Clipped button is 
enabled, then the outline corner will be clipped as per the Miter Limit. 
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Outline with Point corners Outline with Clipped corners, where 

Miter Limit is 100% 

  

Only corners that are less than or equal to 90 degrees will be clipped. 

  

Create Mask 
Where several objects are selected, outlines will be created for each individual object. The Create Mask option 
will weld all the outlines into a single object. 

  

   
Original two objects Editing an outline for both 

objects 
The resulting outlines have 

been welded 

  

This mask creation process is particularly useful when you are laying a light-colored vinyl over a dark sign 
substrate, as it allows you to cut a single-piece mask of white to reduce the effect of the dark material. 

  

Contour Object 
The Contour Object command is used to create a single shape that matches the contours of the selected shapes. 
The Contour Object can be set to retain the inner contours of the original shapes, or it can be set to be a solid 
shape with no inner contours. 
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In the following example, the original shapes were composed of two lines of text and two clipart shapes. The 
resulting contour object (cyan) was set to fill the inside contours. 

  

 
  

Transformation 
Transformation 

Transformations are used to apply special effects and distortions to selected objects and text. 
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Select the desired effect, and then drag the transformation handles to modify the effect. When adjustments are 
complete, click within an empty portion of the workspace to finish editing the transformation. 

  

Adjusting the transformation handles 
Prior to applying a transformation, the appearance of the distortion may be adjusted. Suppose that a Fit to flag 
vertical distortion is being applied to some text. 

  

 
  

The placement of nodes varies according to the type of distortion that is being applied. In this Fit to flag vertical 
example, there is a single node that may be used to adjust the rise of the flag. As this node is adjusted, the outline 
of the distortion will show the final placement of the text. 

  

 
  

Other types of distortions are modified in a similar manner. 

  

Fit Text to Arc 
Fit Text to Arc 

The Fit Text to Arc feature is used to position text as if its baseline or topline were being fit to a circle. 



Special Effects 

239 

  

 
  

In addition to the SmartBar controls, editing handles will be available on the workspace. 

  

 
  

Arc Angle and Arc Radius 
The Arc Angle and Arc Radius fields are related controls, where adjusting one will affect the value of the other. 
The Arc Angle is the total arc through which the text is fit upon the circular path. The Arc Radius is the radius of 
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the circular path. So as can be observed, both the Arc Angle and Arc Radius fields affect the size of the circular 
path, and likewise they are dependent upon the size of this circular path. 

  

 
  

Arcing the Text Up and Down 
The text arc can be up or down from either the text baseline or topline. If arced from its baseline, then the text 
baseline will be flush with the circular path. Conversely, if arced from its topline, the text topline will be flush 
with the circular path. 

If the Invert button is clicked, then the text will be arced as if its baseline and topline were swapped. 

  

 
  

Setting the Custom Arc Length 
If the Custom Arc Length option is checked, then additional compression/expansion handles will appear on the 
workspace preview. These handles may be used to either compress or expand the text frame, which is the bounds 
of the text shape. 
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To set the compression/expansion rules for the text frame, click the Custom Settings button to open the 
Horizontal Compression dialog. This dialog determines how the text will be fit to its text frame. 

  

 
  

  

The four methods of compression/expansion are: 

  

�       Width – Constrain text by modifying the character width. 

�       Height – Constrain text by modifying the character height. 

�       Kerning – Constrain text by modifying the distance between characters. 

�       Word Kerning – Constrain text by modifying the distance between words. 

  

If the Word Wrap option is NOT checked, then text will be fit within a single line. If the Word Wrap option IS 
checked, then text will be wrapped onto two-or-more lines when the indicated limit on compression has occurred. 

  

Wrap Multiple Lines 
If there are multiple lines of text when applying the Fit Text To Arc command, then the Wrap Lines button will 
be available from the SmartBar. 
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Clicking the Wrap Lines button will break each line into a separate text object, and the text objects will be spaced 
evenly around the circular path. 
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Fit Text To Path 
Fit Text To Path 

The Fit Text To Path command is used to fit a text shape to a line art shape. Any line art shape is considered to 
be a “path,” where the line art can be either a “closed path” or an “open path.” A closed path is merely that has a 
contiguous, unbroken contour, such as a circle or a square shape. An open path is one that is not contiguous, such 
as a straight line or a drawn curve. 

The SmartBar controls are slightly different according to whether text is being fit to a closed or open path. For an 
open path, there are “Starting Position” buttons that indicate whether the text should begin at the left, right, top, or 
bottom of the closed shape. 
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In comparison, the SmartBar controls for an open shape concern the justification of the text, being either left-, 
right-, or center-justified. For either case, there is a button to allow a custom starting position for the text. 

  

 
  

Fitting text to a custom position 
For both open and closed paths, a custom starting position may be set along the object contour. To set a starting 
position, click the Custom Starting Position button in the SmartBar. At this point, clicking anywhere along the 
object contour will place a special start position handle, which appears as a tiny circle. Clicking the Apply button 
will show a preview of the text at that position. 

 
  

Path Alignment 
The Path Alignment determines how closely the text baseline is aligned with the path. This alignment is further 
modified by the Text To Path Distance field. 
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�       Text Inside Path – The path will be aligned along the very bottom of the text, including descenders. 

�       Text On Path – The path will be aligned with the text baseline, which excludes descenders. 

�       Text Through Path – The path will cross directly through the middle of the text. 

�       Text Outside Path – The path will be aligned along the topline of the text. 

  

Editing a previous Fit Text to Path operation 
Suppose that a Fit Text to Path operation has been previously applied, where some text had been fit to a 
rectangle. Depending upon which shapes are selected, the Fit Text to Path operation may be used to either edit 
the existing operation, or to add more text shapes to the contour. 

Case 1: Editing an existing Fit Text to Path operation 
If both the text and rectangle shapes are selected, then choosing Fit Text to Path from the Transform menu will 
activate an editing mode for the existing Fit Text to Path operation. The SmartBar will have both Apply and 
Accept buttons. After editing the SmartBar settings, click the Apply button to update the workspace preview. 
However, when the SmartBar settings are correct, click the Accept button to save the settings. Otherwise, clicking 
the Close button will discard any edits. 

  

 
  

Case 2:Adding a new text shape to the contour 
If only the rectangle shape were selected, then choosing Fit Text to Path from the Transform menu will allow a 
new text shape to be added to the contour. The SmartBar controls will appear normal for a Fit Text to Path 
operation, except that the Apply button will have been replaced with an Add Text button. Once the SmartBar 
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controls are set for the Fit Text to Path operation, click the Add Text button to activate text editing mode. The 
new text shape may then be edited, and the text will added at the indicated location along the contour. 

  

 
  

When the new text shape has been entered, click within an empty portion of the workspace to finish editing. The 
SmartBar will again display controls for the Fit Text to Path operation, and the location of the text along the 
contour may be edited. When editing is complete, either the Apply button may be clicked to begin editing a new 
text shape, or the Close button may be clicked to finish editing. 

 
 

Case 3:Adding a separate text shape to the contour 
Suppose there is an existing text shape that must be added to the rectangle contour. 

  

 
  

With both the new text shape and the rectangle shape selected, the Fit Text to Path item may be chosen from the 
Transform menu. The SmartBar controls may then be edited to position the text shape along the rectangle 
contour. 
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Fit Object To Path 
With two line art shapes selected, the Fit Object To Path command will fit multiple copies of the smaller shape 
to the larger shape. This is a common tool to use when creating a border decoration. 

  

 
  

In the Fit Object To Path dialog, the Object Placement determines how many of the smaller shapes will be 
created. 

The Number option indicates the total copies of the smaller shape that will be created. These copies will be 
evenly spaced around the larger shape. 

The Distance option is a measure of how far along the larger shape contour before a copy of the smaller shape is 
created. Further copies will be created until the entire contour of the larger shape has been filled. The Offset 
indicates an initial distance within which objects will not be placed along the contour. 

The Nodes option refers to the editing nodes that the larger shape is composed of. For example, double-clicking a 
polygon rectangle shape reveals that there is a node at each corner. If a star shape is fit to this rectangle using the 
Nodes option, then a star shape will be created at each corner. 
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Metamorphosis 
Metamorphosis 

For two selected shapes, the Metamorphosis tool is used to create multiple intervening shapes that represent the 
transformations from the first shape to the second. The transformation takes into account the shape of the two 
original objects, their colors, and the colors of any thick lines that might have been applied to the objects. 

  

  
Two text shapes, each assigned a different 

spot color. 
After applying a Metamorphosis 

operation. 
  

The metamorphosis may then be combined with other shapes to enhance the effect: 
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The Mode options determine how colors will be assigned to the intervening shapes. 

  

 
  

Target Layer 
The Target Layer option causes intervening shapes to be assigned the currently selected color in the Shop Palette. 

  

Match Layers 
The Match Layers option causes the intervening shapes to be assigned transitional colors. These colors are 
selected according to the closest matches that are available in the Shop palette, regardless of the type of colors 
used for the original shapes. For example, even in cases where the original shape colors were spot colors, process 
colors may be assigned as transitional colors. 

  

New Layers 
The New Layers option causes the intervening shapes to be assigned transitional colors. These colors are selected 
according to the closest matches that are available in the Shop palette. If a given color does not exist within the 
Shop palette, then a new color plate will be created. 

If the original two shapes had been assigned spot colors, then the transitional colors will be duotones of the 
original two spot colors. 

  

Morphing to the Background Color 
When morphing gradients from one color to the background substrate color, the target color should be neither 
process white, nor spot white. Process white will cause the intervening shapes to be assigned process colors, 
whereas spot white will cause duotones to be assigned. 

To create gradients that will fade to the background color, the target color should be either Clear Color, or a 0% 
tint of the spot color. 

  

Group All 
When using a high Count value to create multiple intervening shapes, enable the Group All option to group the 
resulting shapes. This aids the process of selecting and moving the shapes. 

  

Shadow 
Shadow 
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The Shadow option allows for creation of quick shadow effects to one-or-more shapes. Once the type of shadow 
has been selected, editing handles will appear about the shapes, and the shadow attributes can be edited from the 
SmartBar. 

By default, the shadow is centered on the shape at coordinates (0,0). As an alternative to adjusting these 
coordinate values, the SmartBar also provides Angle and Depth attributes. 

  

  

 
  

Block Shadow 
The Block Shadow is used to give objects the perception of depth. 

  

 
  

Perspective Shadow 
The Perspective Shadow is used to give objects the perception of distance.  

The furthest portion of the shadow is a percentage of the shape size, as indicated by the Cast value. For example, 
if the Cast value is 50, then the furthest portion of the shadow will be 50% smaller than the shape size. To have 
the shadow extend to an infinite point, set the Cast value to 100 (i.e. 100% smaller than the shape size). 
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Drop Shadow 
The Drop Shadow is similar to the Block Shadow, though the perceived space between the original shapes and 
their shadows is not filled. 

  

 
  

Cast Shadow 
The Cast Shadow is used create the perception of a light source, such that the objects project a shadow as if onto a 
nearby surface. 
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Shadow Outline 
An outline amount can be applied to the shadow, so as to create a heavier shadow effect. The Thickness setting is 
used to adjust the outline amount. 

  

 Point Allow corners to remain sharp 

 Miter Clip sharp corners instead of rounding 

 Round Round sharp corners 

  

  

 
  

Relief Shadow  
As an alternative to applying an outline to the object, click the Relief Shadow button to create a gap between the 
shape and its shadow. The size of the gap is determined by the Thickness setting. 
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Shadow with outline Using a relief shadow 

  

About the Minimum Shadow Hole 
When creating a shadow for small letter shapes, it may be the case that the inner contours of the letters are being 
filled when the shadow operation is applied. This occurs for inner contours that are approximately 0.1 inches in 
diameter, such that very small "slivers" do not occur in the finished work. 

If it is desired that such inner contours be retained, then scale the text by 100% prior to applying the shadow 
operation. After applying the shadow operation, the text and shadow may then be reduced by 100% to obtain the 
desired size. 

  

Round Corner 
Either the inner or outer corners of objects may be rounded. Inside corners are corners which face back into the 
body of the object, while Outside corners are corners which face away from the body of the object. For example: 

  

   
Original object Rounded outside corners Rounded inside corners 

  

Using a circle as a model, rounding is performed by mapping each corner along the circumference of the circle. In 
this fashion, the amount of rounding is determined by the radius of the circle. 

  

 
Rounding performed to an arrow shape. Note that the circles drawn here are for example only. 

  

Fillet Round Corner 
The Fillet Round Corner feature is similar to the Round Corner feature, except that rounding may be applied to 
individual corners. 
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For a selected shape, choose Fillet Round Corner from the Transform menu. The Fillet Round Corner controls 
will appear in the SmartBar. 

  

 
  

For the selected shape, click the corner that will be rounded. From the SmartBar, the Corner Radius field may be 
used to adjust the amount of rounding. 

To apply rounding to a different corner, simply select another corner of the shape, and then adjust the Corner 
Radius amount. 

For example, two corners of the following pentagram have been applied with different amounts of rounding: 

  

  
Original pentagram. No corners 

are rounded. 
After applying rounding to two 
corners. The lower-left corner 

has been clipped. 

  

If the Miter option is enabled, then the corner will be clipped instead of rounded. 
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PRODUCTION TOOLS 
PRODUCTION TOOLS 

Introduction 
The Production Tools are signmaker tools that help manage and improve the signmaking process. Detailed 
information can be organized about each work assignment, and initial designs can be quickly previewed by 
customers. Customers may also request changes or additional info, and confirmation may be obtained prior to 
initiating a job. 

Job/Cost Notes 

TimeSign 
Templates 
Clip Art 

JOB/COST NOTES 
Job/Cost Notes 

The Job Notes Summary dialog is used to record the relevant information about a given job. This information is 
stored with the workspace, so that it is always available for review. In addition, contact information that is stored 
here can be used to fill out wizard information when using the Generate Quote, Generate Proof, or Generate 
Portfolio commands. 

Individual company records may be stored for later use, such that this information need not be specified more than 
once. In addition, job information may be indexed on a per company basis.  

  

 
  

Checkboxes 
On the Job Notes Summary dialog, a checkbox is provided beside each field. If a given checkbox is disabled, 
then its field will not be included when printing the job/cost notes, nor when using the E-Mail Preview feature 
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(Web menu). This is a useful means of preventing sensitive information from being included as part of the 
documentation. 

Note: Changes to these checkbox settings will be stored as part of the general Vision-Pro settings, such that they will 
not be reset when a new Vision-Pro session is started. 

  

 
 

Company 
Company  

The company for which the job is being designed. Either choose an existing company from the drop-list, or enter a 
new company name. If a new company name is entered, then the Add button must be clicked. 

  

 
  

In some cases, a job request is made by an individual that does not belong to a company. This is not a problem, 
since their contact information may be entered as normal. However, enter their name as the "company" name as 
well, such that their record may be located in future jobs. 

When a Company has been specified, then the Job Ticket field will become active. 

  

Edit Address 
Click the Edit Address button to specify the address information for the company. 

  

 
  

Edit Contact 
Click the Edit Contact button to enter information about the company representative. 
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First and Last name 
Enter the name of the person responsible for contracting and accepting the finished job. 

Contact Information 
Enter the Telephone number, Fax number and E-mail address for the contact person. 

  

Job Ticket 
The Job Ticket is the collection of design information about the current job. When a Company has been selected, 
the Job # field will become active. To maintain an inventory of jobs by number (or by any other alphanumeric 
code for filing purposes), enter the appropriate Job # code and then click the Add button. 

  

 
  

The Job # will also displayed on the Edit Job dialog. If the Job # had not been entered on the Job Notes 
Summary dialog, then the Job # may be entered on the Edit Job dialog. In this case, the Add button must then be 
clicked on the Job Notes Summary dialog to confirm that the job is valid. 

  

Edit Job 
Click the Edit Job button to enter specific production information about for the Job Ticket. 
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Job # 
The Job # field corresponds to the Job Ticket field on the Job Notes Summary dialog. 

The Job # field only becomes active when a Company has been chosen. If an inventory number has already been 
entered in the Job Ticket field, then the Job # will be displayed as a static (non-editable) field. 

  

Date 
The Date field can be used to note the date the job was started or the order taken. Click the Date field to activate a 
calendar popup. 

  

 
  

Material Type 
Enter the type of material and quality of material that will be used for rendering or cutting. 

  

Complexity 
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Many designers use a complexity rating in order to help set pricing on certain types of work. Rate each job for 
complexity and enter the complexity value in this field. 

For Example, consider letter welding in conjunction with intricate weeding. A graphic using script lettering would 
require significantly more time than had a sans serif font been used. Therefore, using the script lettering would be 
deemed a more complex job. 

  

Cutting Time 
This box may be used to track the amount of time required to cut a given job, which can aid in calculating job 
costs. This is particularly useful for routing and engraving, where machine time is a billable expense. Values are 
entered manually, since there is no automatic time calculation available for this function. However, use TimeSign 
to record the time required to complete the job. 

  

Production Time 
Enter the required production time in this field. It may reflect the estimated time required for pricing purposes, or 
actual time required for job costing. Values are entered manually, there is no automatic time calculation available 
for this function. 

  

Weeding Time 
This field is designed to reflect the amount of time required to weed the current job. It is typically used either to 
note the estimated weeding time (for pricing purposes) or the actual weeding time (for reference in pricing future 
jobs).  Values are entered manually, there is no automatic time calculation available for this function, however, it 
can be used in combination with TimeSign to calculate bill-able time accurately. 

  

Travel Time 
Enter the amount of time required to get to and from the current job site in this field. This feature can be 
particularly useful where travel time is a factor in the final cost of the sign. 

  

Computer Time 
Use this box to track the amount of computer time spent on a given job. This can be useful information when 
calculating the cost of a given job. Enter the value in this box manually, there is no automatic time calculation for 
this function. 

Used in combination with TimeSign, available through the Help Menu, the Computer Time field can be a crucial 
aid in calculating bill-able time accurately. 

  

  

  

The TimeSign feature is discussed in a later section. 



Vision-Pro 7 Doc Files 

260 

  

Printing Time 
Enter the amount of time required to print the current job. This field is primarily designed as an aid for estimating 
or costing jobs which specify large-format digital printing, but is also useful for those jobs which require printed 
previews. It may be used to note estimated printing time for pricing, or actual printing time for job costing. Values 
are entered manually, there is no automatic time calculation available for this function, however, it can be used in 
combination with TimeSign to calculate bill-able time accurately. 

  

Material Cost 
Enter the actual or estimated cost of materials for the current job. 

  

Labor Cost 
Enter the cost of labor for the current job. 

  

Selling Price 
For future reference, and as an aid to job pricing and accounting, include the selling price of the current job in this 
space in the Job/Cost Notes dialog. 

  

Delivery Date 
Enter the due date scheduled for the current job. 

  

  

 
 

Order Number 
If Purchase Orders are required prior to starting a job, then enter the Job or Customer Order number. 

  

Order Taken By 
Enter the name or employee number of the person who took the order for the job. With more than one salesperson, 
attribute each job to a specific employee. This provides the ability to clarify details with the appropriate person on 
staff, or to track sales by employees. 

  

Job Notes 
A brief description of the job should be entered into this field. This will help identify a given job quickly and 
easily. 

  

Material, Vinyl, Color Notes 
Enter any additional notes that pertain to the manufacturer, vinyl, grade of materials, etc. used in the job. This 
facilitates repairs to, or reproduction of, the job in the future. 

  

  

Set Default Database 
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When Vision-Pro is installed, the Job/Cost Notes database is placed in the Vision-Pro install directory. If there is 
a common database that must be used on a network, then click the Set Default Database button. A browse dialog 
will open, which allows you to choose the database file that must be used. 

  

Printing the Job Report 
Click the Print button to create a Job Report printout. Much of the Job Report fields correspond to fields on the 
Job Notes Summary dialog, though the printout also provides additional statistical information about the job. 

  

 
  

Each count is automatically calculated and updated each time that the Job Notes Summary dialog is opened. The 
counts are described as follows: 

  

Graphics Size 
The Graphics Size indicates the finished size of the current job, including all elements of the job, except the Sign 
Plate Size. 

  

Bitmaps 
The Bitmaps count indicates the number of bitmaps currently contained in the job. 

  

Shapes 
The Shapes count indicates the number of polygon, polyarc, parametric, and other non-text objects contained in 
the current job. This count includes all text objects that have been converted to graphics. 

  

Characters 
The Characters count indicates the number of text characters contained in the current job – excluding both text 
objects that have been converted to graphics, and characters that are generated by the Dimensioning feature. 

Note: Any text character converted to graphics will be recognized as graphic objects and included in the Shapes count. 
This includes all text that has been transformed, welded, converted to graphics, or has had the path broken or the 
corners rounded. In all cases, a warning dialog will appear before the text is converted, unless the warning dialog has 
been previously disabled (see General Preferences dialog). 

  

Colors 
The Colors count indicates the number of colors used in the current job. 
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TIMESIGN 
TimeSign is a timer application that tracks elapsed time during a job. The current system time is shown at the top-
right of the dialog. 

  

 
  

Start 
Click the Start button to activate the stopwatch. Once activated, the Start time will appear beside the Start button. 
The traffic light icon will signal green to indicate that the timer is active. 

  

 
  

Stop 
Click the Stop button to pause the timer. The time at which the Stop button was clicked will be displayed next to 
the Stop button. The traffic light icon will signal red to indicate that the timer has paused. The elapsed time is 
displayed at the bottom of the dialog box beside the Continue button. 
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Continue 
Elapsed time is displayed next to the Continue button. Click the Continue to recommence timing without 
resetting the elapsed time. For situations where the job is frequently interrupted, the Continue button is helpful for 
timing the total expended work. 

  

 
  

Reset 
Clicking the Reset button will set the elapsed time to zero. 

  

 
  

TEMPLATES 
Templates 

A Template operation is used to convert a text object into a variable workspace element, which is then saved 
with the workspace. Later, when the workspace is again loaded into Vision-Pro, the text object will be converted 
into the type designated by the Template operation. For example, a template may be set to display the current date 
when the workspace is loaded. 

When a text shape is selected, the Templates flyout may be accessed under the Layout menu. 

  

 
  

File 
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File 
The File Template operation will cause the text object to be replaced with an imported data file, such as a 
company logo or other image. The original text object may be used to determine the size and placement of the 
imported file. 

For a selected text object, choose File from the Set Template flyout. The Template File dialog will open. 

  

 
  

File / Prompt at Run Time 
The file to be imported may be selected before saving the workspace, or the file may be chosen by the user when 
the workspace is loaded. 

If the "Prompt at run time" option is disabled, then click the Browse button to choose the file that will be 
loaded. 

If the "Prompt at run time" option is enabled, then the user will be queried for a file when Vision-Pro 
workspace is opened. 

  

Stretch 
The Stretch options are used to determine the size and placement of the imported file. 

The To fit option indicates that the width and height of the file will be set equal to the replaced text object, such 
that the entire text frame is filled. However, the aspect ratio of the imported file will not be maintained. This 
option assumes that the text object was originally set to the desired width and height of the anticipated file. 

The Proportional option will scale the file to fill the text frame. Since the aspect ratio of the file is maintained, it 
is likely that not all of the text frame will be filled. 

The None option will cause the file to be imported and placed at its full size. The file will be neither scaled nor 
resized. 

  

Orientation 
The Orientation is used to indicate where the file should be placed within the text frame. This option is relevant 
when the Stretch has been set to either Proportional or None. 

  

Date 
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Create a text object and set it to the appropriate size for any artwork proofs. Select the text object and choose the 
Date option from the Set Template flyout. When the workspace is loaded, this text object will be replaced with 
the current date, as per the system clock of the workstation. 

Time 
Create a text object and set it to the appropriate size for any artwork proofs. Select the text object and choose the 
Time option from the Set Template flyout. When the workspace is loaded, this text object will be replaced with 
the current time, as per the system clock of the workstation. 

Text 
Create a text object and set it to the appropriate size for any artwork proofs. Select the text object and choose the 
Text option from the Set Template flyout. When the workspace is loaded, the user will be prompted for 
replacement text. The original text object will then be substituted with the replacement text. 

Note: The original text object will be used as part of the prompt for replacement text. Creating a meaningful text object 
will help as a reminder when the workspace is opened. 

  

Clear Template 
For a selected text object that has been previously applied with a Template operation, use the Clear Template 
command to remove the Template operation. The Clear Template command may not be applied to a group 
selection. 

Edit Template 
The Edit Template command is available through the File menu. The Edit 
Template command is similar to the File menu >> Open command, except that 
any template objects within the file will not be automatically completed. This 
allows the template file to be modified without losing any of its previously set 
template operations. 
 
When changes to the template file are complete, use the Save or Save As 
commands to store the revised template file. 

CLIP ART 
Clip Art  

Vision-Pro is provided with a Clip Art viewer that is a quick means of browsing and selecting clip art. Either 
bitmap (.BMP) or  Vision Drawing files (.CDL) are valid formats that may be imported as clip art. 

The Clip Art features are accessible under the Layout menu. 

 

 
 

Clip Art Viewer 
Clip Art Viewer 

To browse for clip art, choose the Clip Art Viewer item under the Layout menu. The ClipArt dialog will open. 
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When Vision-Pro was installed, an option was provided to install several clip art folders within the Vision-Pro 
install directory. The ClipArt dialog may be used to navigate these clip art folders, as well as other clip art that are 
on the workstation. 

Navigating the clip art folders 
Double-clicking a folder will show the contents of that folder. To exit a folder, click the Up One Level 

 button. 

At the top-right of the dialog, the View  button may be used to toggle between small and large previews of 
the clip art. 

Opening the clip art 
To open a clip art object, double-click its preview in the ClipArt dialog. Alternatively, drag-and-drop the preview 
onto the Vision-Pro workspace. In either case, the Vision-Pro cursor will become an angle bracket, which is used 
to position the clip art on the workspace. 

 

Clip Art Go To 
As a shortcut, the Clip Art Go To flyout lists folders that contain clipart. When a folder is selected from the 
flyout, the ClipArt dialog will open, and the contents of the folder will be displayed. 

To edit the folders that are listed in the flyout, choose the Clip Art Categories Setup item under the Layout 
menu. 

Note: Vision-Pro is installed with default folders for Arrows and Automobiles clip art, as well as bitmap fill patterns. 
Additional clip art is available on the Fonts and Sign Clip-art CD. 
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CUTTING AND PLOTTING 
CUTTING AND PLOTTING 

Engraving workspace objects 
Creating Tool Paths 
Engrave Preview 
Engraving Defaults 
Plotter Setup 
Tool Library 
Output Tool Usage 
Output Spooler 
Output Spooler As A Stand Alone Application 
Remote Spooling 

ENGRAVING WORKSPACE OBJECTS 
This chapter discusses the Engrave menu commands, which includes controls for configuring most routers and 
engravers (Engraving Defaults). 

  

 
  

Before beginning a job, please note that newly created shapes do not automatically have cutting paths applied to 
them. Instead, a selected shape may be applied with a tool path from the Create Tool Path flyout. The Output 
command may then be used to activate the Engrave Preview mode, whereupon cutting data may be output to the 
given device. 

As an alternative to the Output command, the Output Tool on the Tools toolbar will also activate the Engrave 
Preview mode. 
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Note: Prior to generating output, the correct driver must be installed for the make and model of the device being used. 
See the Install Drivers command under the File menu to determine if the correct driver has been installed. 

  

CREATING TOOL PATHS 
Creating Tool Paths 

Tool paths are special cutting/engraving/plotting operations that are applied to workspace shapes. In addition to 
being a visual workspace description of the tool movements, each tool path contains specific information about its 
cutting parameters, such as cutting depth and bit type. 

By default, newly created workspace shapes do not have cutting paths. Instead, apply a cutting path to a selected 
shape by choosing from the Create Tool Path flyout (Engrave menu). 

  

 
  

These tool paths are arranged into the following classifications: Online, Male, Female, Fill, and Drill. Though 
these tools are accessible from the Engrave menu, and they are also accessible from the Tool Path Tools flyout. 
Please note that the Drill tool is only available from this flyout. 

  

 
  

For the tools chosen from the Engrave menu, the setup dialog will always open. However, when choosing a tool 
from the Tool Path Tools flyout, right-clicking will always open its setup dialog, whereas left-clicking will 
assume that the previously used settings should be used. The exception to this interface behavior is the Drill tool, 
which is discussed later. 

Delete Tool Path 
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Remove the tool path from the selected shape. 

  

Edit Tool Path 
For a shape that has been applied with a tool path, open the editing dialog for that tool path. 

  

Online 
Online 

 
Defines a basic cutting path for which the tool will follow the edge of a designated shape. The resulting cut will 
have an offset of zero. The Online tool path is often used to trace shapes in artwork without filling the shapes with 
an engrave pattern. 

  

 
  

The Online setup dialog appears as follows: 

  

 
  

Tool 
Use the Tool drop-list to set the tool that will be used to cut the shape. To the right of the Tool drop-list, the 
ellipsis button is a shortcut to the Tool Library dialog, which was discussed earlier in this chapter. 

Depth 
Set the maximum cutting Depth. To the right of the Depth field, the ellipsis button may be clicked to open the 
Engrave Parameters dialog (discussed later in the Drill tool section). 
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Color 
Specify the Shop Palette color layer to which this tool path will be assigned. 

There is an Vision-Pro feature that allows all objects on a color layer to be disabled. For example, an organized 
design will have tool paths arranged on different color layers, which allows a specific group of tool paths to be 
hidden by disabling their color layer. For more information about disabling color layers, please refer to Inactive 
Color Layers in the index. 

Male 
Male 

 
Defines a basic cutting path on a selected shape, such that the resulting cut shape will fit within a corresponding 
female shape. The tool path will fall to the outside of the shape contour, such that the offset equals one-half of the 
bit width. The Male tool path is typically used to cut shapes out of a material. 

  

 
  

For example, consider a polygon shape that is cut using a Male tool path. Suppose that the same polygon shape is 
also used to a Female tool path within a larger, supporting piece. The male cut can then be fit within the inner 
contour of the female cut. 

The Male setup dialog appears as follows: 
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Tool, Depth, and Color 
For a description of these fields, please refer to the Online tool path descriptions. 

Inlay 
Though a tool bit can cut an outer-corner effectively, the tool bit diameter can cause an inner-corner to be 
rounded. This is especially a problem when shapes are intended to be flush, such as when using a shape to produce 
both male and female cuts. 

  

 
Compare how the path is cut for outer- and inner-corners. Due to the tool diameter, 

the inner-corner (Inlay Channel) will be rounded. 

  

For two pieces that must be flush, enable the Inlay option to cause both the outer- and inner-corners to cut with 
rounded corners. The resulting pieces with then fit. 

  

 
  

Gap 
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The Gap value is the size for the inlay. 

Clockwise / Counter-Clockwise 

 
The tool bit spins with a clockwise rotation. However, the cutting of the bit should always be in the direction that 
the tool is traveling, such that a smooth-edged cut is produced. In the following diagram, the tool bit is following 
the outer-contour of the shape in a clockwise direction. Notice how the spinning action of the tool is in the same 
direction as the tool direction. 

  

 
  

As a specific rule, a Female tool path should cut the contour in a clockwise direction, and a Male tool path should 
cut the contour in a counter-clockwise direction. To toggle the direction, click the Clockwise / Counter-
Clockwise button. 

  

  Cut the shape contour in a clockwise direction. 

 Cut the shape contour in a counter-clockwise direction. 

  

As an example, inspect the following donut shape. The donut shape must be cut along both an inner- and outer-
contour. Try to visualize the spinning tool as it follows the donut shape contours. 

  

 
Donut shape being cut along both inner- and outer-contour. The inner-contour 

is like a Female tool path, where the contour should be cut in a clockwise 
direction. The outer-contour is like a Male tool path, where the contour 

should be cut in a counter-clockwise direction. In both cases, the tool bit is 
spinning with clockwise rotation. 

  

An Online tool path does not provide an option for setting the Clockwise / Counter-Clockwise direction. Instead, 
the Online tool path will simply use the most recent setting. 

Lead In 
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A Lead In is an additional portion added to the start of the tool path before the shape contour is cut. In this 
fashion, the Lead In prevents distortions to the shape contour that could have been caused by the tool bit as it 
plunged into the material. 

The shape and position of the Lead In are governed by the following rules: 

  

�       Lead Ins are only applied to paths that define the edge of the object being routed (i.e. they are not 
applied to fill strokes) 

�       When performing an outside rout, the Lead In will be added from the outside of the shape 

�       When performing an inside rout, the Lead In occurs from inside the shape 

�       If the first contour edge being cut is a straight line, then the Lead In will also be straight 

�       If the first contour being cut is a curve, then the lead in will be curved 

�       If a Lead In is specified but will not fit within a given shape, or will not fit without making contact with 
any other shape to be routed, then the Lead In will not occur 

Note: When a Lead In is specified, the Bridge function is disabled. 

 
 

Clean-Up/Flange 
When cutting an object to a deep, final depth, there is an advantage to using several cut passes at progressively 
deeper cut settings. Multiple passes are used to avoid burning the material or stressing the bit, to ensure that the 
corners being cut are sharp, and to reduce the amount of time required to complete the cutting process. However, 
multiple passes often leave a “stepped” appearance to the finished object, usually because of a progressively worn 
bit, or minute shifts in the material. 

 
A Clean Up pass is used to finish the job by tracing the edge of the object, such that a consistently smooth surface 
will result. 
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Specify the offset for the clean-up pass in the edit field. Specifying a positive value will cause the tool bit to cut 
along a path nearer to the object being cut than the regular tool path, while a negative offset will cause the tool bit 
to step away from the object (i.e., create a Flange). 

Note: Under some circumstances, you may wish to specify an additional depth for your cleanup pass. This can be 
particularly useful for generating a glue channel underneath an inlaid object which is to be set flush with the surface of 
the sign substrate. 

  

 
 

Flange 
The Flange option only become active when the Clean Up/Flange option is enabled. 

The Flange controls are used to define how a “tab” (also known as a “shoulder”) is applied to a piece that is being 
cut. The flange is added to either the male and/or the female fitted pieces to prevent the male piece from falling 
through its mating female piece as shown below. 

  

 
  

Female 

 
Defines a series of cutting paths on a designated shape, such that the resulting cut shape may contain a 
corresponding male shape. 

For example, consider a polygon shape that is cut using a Male tool path, thereby producing a male cut. Suppose 
then that the same polygon shape is cut using a Female tool path, thereby  producing a female cut. The male cut 
will then fit within the inner contour of the female cut. 
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The tool path will fall inside of the shape, with an offset equal to one-half the width of the tool bit. The Female 
tool path is typically used when filling or cutting out a shape. 

The Female setup dialog is as follows. For an explanation of these controls, please refer to the Male tool path 
descriptions. 

  

 
  

Fill 
Fill 

 
Defines a series of cutting paths designed to remove material from inside a selected shape. 

For much of the Fill dialog controls, please refer to the Male tool path descriptions. The Fill setup dialog appears 
as follows. 
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Filling a Nested Shape 
Note that when simply placing one object within another, a fill operation will engrave the outer object without 
consideration of the inner object. The correct technique is to combine two such objects into a single path, and then 
the fill tool path operation may be applied. The following steps show how this is done: 

1)       Assume that a logo must be placed within a star shape, all of which must then be filled without losing 
the logo. 

2)       Create the text for the logo. With the text selected, choose Text to Graphics from the Arrange menu. 
This will convert the logo into a graphic that can be routed. 

3)       Create a star shape that is large enough to contain the logo, and then center the logo within the star. 

4)       Select both the star and the logo, and then choose Make Path from the Arrange menu. Both objects 
will now have been combined into a single object. 

5)       Apply a Fill operation to the combined object. The result will be a filled star shape that correctly retains 
the logo that was placed within it. 

  

Calculate the Largest Tool Diameter 
The Fill dialog has a button that will automatically calculate the largest tool diameter that should be used for the 
selected shapes. This tool diameter is for informational purposes only, but it is a good hint when choosing the tool 
size. 
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Using a Fine Tool 
A concluding pass with a fine tool is a useful means of removing any rough or leftover material from the initial fill 
pass. Enable the Fine Tool option, and then choose the tool and depth that should be applied. 

  

 
  

Fill Styles 
The choices of Fill style are as follows: 

None 
None indicates that there is no fill style. The edges of objects will be traced, but no fill will occur. 

  

 

S-Sweep 
The S-Sweep style will generate a series of fill lines that are similar to the Line Sweep fill, except that the line 
paths are joined wherever possible. This is a relatively quick fill, since the number of lift and drop movements is 
minimized. 

The S-Sweep (nose cone) is similar to S-Sweep, except that this option is more appropriate for machines that use a 
floating nose cone to control depth. 

  

 

Line Sweep 
The Line Sweep style will generate a series of separate and discrete fill lines. This fill pattern is designed for those 
machines that have a short maximum path length, which requires short fill paths. The disadvantage is that the 
cutting head lifts and drops for each fill path, which increases the amount of time required to fill the given object. 
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Spiral 
The Spiral style will trace around the edge of a given object and then cut the fill area on the same pass. This is a 
fairly traditional style that reduces the lift and drop movements of the tool. However, this style may not be suitable 
for machines that either require a short tool path, or that use a floating nose cone to control depth. 

The Spiral (corner fill) style is more thorough at hogging than the Spiral style, since Spiral passes are repeated 
for each corner of the object. 

  

 

Reverse Spiral 
The Reverse Spiral style will cut outward from the center of the object until the edge of the object is traced. 
Because cutting occurs from the center of the object outward, this style is well suited for machines that use a 
floating nose cone to control depth. Another benefit is that the edge of the object is cut last, which results in a 
cleaner edge cut. 

The Reverse Spiral (corner fill) style is more thorough at hogging than the Reverse Spiral style, since Reverse 
Spiral passes are repeated for each corner of the object. 

  

 

Island 
The Island style is similar to the Spiral style, except in that discreet paths begin at the edge of the object and then 
work toward the center. Use this style to create a spiral-like fill when the machine does not support long tool 
paths. A tool lift and drop is generated for each pass, which implies that this style requires more time than an 
equivalent spiral style. 

  

 

Reverse Island 
The Reverse Island style is similar in effect to Reverse Spiral, except that paths are cut from the center in 
progressively wider paths. This style is suited for a machine that requires short tool paths, and which is fitted with 
a floating nose cone. Another benefit is that the edges of the object is cut last, which results in a cleaner edge cut. 
A tool lift and drop is generated for each pass, which implies that this style requires more time than an equivalent 
Reverse Spiral style. 

Fill Parameters 
The fill parameters are described as follows. The available parameters will depend on the type of fill being routed. 

  

Overlap % 
Overlap % is the percentage amount that each successive hogging pass should overlap the previous pass. Overlap 
is used to ensure that all material is removed between contiguous passes of the tool. The overlap is expressed as a 
percentage of the tool diameter. 
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Angle 
Angle is used to specify the angle of fill strokes when hogging out the material with parallel passes of the tool. 
The angle of zero degrees corresponds to the x-axis. 

  

 
        Fill Angle 0°                            Fill Angle 45° 

  

Specify an angle when cutting artwork that leans in a specific direction. Proper setting of the angle can result in 
significant reductions in production times. 

 

Drill 

 
The Drill tool is used to place drill points upon the workspace. Simply left-click on the workspace to place a drill 
point. For a selected drill point, its Depth is editable from the SmartBar. 
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To specify multiple passes for a selected drill point, choose Edit Tool Path from the Engrave menu, and the 
Engrave parameters dialog will open. Set the desired Depth per pass, and Vision-Pro will calculate the number 
of passes that will be performed. Alternatively, set the number of Passes, and the Depth per pass will be 
calculated. 

  

 
  

ENGRAVE PREVIEW 
Engrave Preview 

The Engrave Preview mode will display the workspace shapes as they will be cut upon the material. The SmartBar 
displays the current cut settings, as per the Engraving Defaults item under the Engrave menu. The Engrave 
Manager toolbar provides additional functions that can be applied to the job before cutting. 

Except where noted, any settings made using the SmartBar controls or the Engrave Manager toolbar will not 
change the default values. Instead, such changes will only apply to the current job. 

  

 
  

Note: In order to perform Plotter Jog operations, registration marks must be included as part of the job. 

  

A convenient cutting feature is that only those objects with currently active colors will be cut. This allows for the 
cutting of specific workspace objects, while leaving other objects uncut. For more information about active and 
inactive colors, please refer to the Shop Palette descriptions. 

Assuming that all the SmartBar and Engrave Manager settings are correct, the job may then be sent for cutting. 
The entire job can be sent by clicking Output All, or selected portions of the job can by output by clicking the 
Sort and Cut by Color button. 
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Sort Cut Order by Color 
Sort Cut Order by Color 

If only selected portions of the job are being output, then the Sort Cut Order by Color dialog will list the color 
layers that are available for output. If defined, then the name of the color will also be listed. 

Next to each color is a checkbox that is used to indicate whether that color layer is output. In addition, the order of 
the jobs being output can be changed by dragging the color layers. 

To output the active color layers, click the Engrave button. Each color layer will be sent as a separate job. 

  

 
  

SmartBar Preview Controls 
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When first entering the Engrave Preview mode, the SmartBar settings will indicate the current default settings. 
Except where noted, changes to the SmartBar controls will apply to the current job, and leaving the Engrave 
Preview mode will cause such changes to be lost. 

  

 
  

Device 
The Device drop-list indicates where the cutting data will be sent. 

To the right of the drop-list, clicking the Device Setup button will open the Engraver Setup dialog. Edits to the 
Engraver Setup dialog will be saved as changes to the default settings. 

Note: The Engraver Setup dialog is discussed later in this chapter. 

Tool 
The Tool drop-list indicates the available tools for the currently selected device. 

To the right of the drop-list, clicking the Tool Setup button will open the Tool Options dialog. The Tool Options 
dialog is used to adjust the driver options for the given cutter. Edits to the Tool Options dialog will be saved as 
changes to the default settings. 

Note: The Tool Options dialog is discussed later under the Engraving Defaults section. 

  

Repeats Setup 
Indicates multiple copies of the current workspace shapes. Clicking the Repeats Setup button will open the 
Repeats dialog. 

  

Media Size 
The Media Size indicates the available cutting area of the machine. By default, these values are taken from the 
Engraver Setup dialog. 

  

Position 
The Position indicates the coordinates of the shapes on the media. Initially, the objects can only be moved as a 
group. However, if the shapes are nested, then individual shapes may be selected and moved. 

  

Size 
The Size indicates the width and height of the shapes on the media. Initially, the shapes are moved as a group. 
However, if the shapes are nested, then individual shapes may be selected, and the Size fields will apply to the 
currently selected object. 

When scaling by a fixed percentage, the Proportional Scaling button may be clicked to lock the aspect ratio. 
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Engrave Preview 
At the far-right of the SmartBar is the Engrave Preview button. Clicking the Engrave Preview button will toggle 
the Tile Preview, which shows how tiles will be rendered upon the media. 

Tiles will be stacked in an attempt to reduce wasted media. However, individual tiles may be selected and moved. 
Clicking the Engrave Now button will send the job to the cutter. 

Clicking the Tile Preview button will return to the Engrave Preview mode. 

  

Cut Toolbox 
The Cut Toolbox provides additional commands that may be applied to the job. 

  

 
  

Customize the Toolbox 
The toolbox buttons can be customized. This is done by right-clicking one of the buttons that does not have a 
setup dialog associated with it. For example, right-click a rotation button to open the Cut Tools dialog. 

The Cut Tools dialog lists all of the available toolbox buttons, and only the checked buttons will be displayed. 

Note: Changes to the toolbox will not take effect until the preview state is exited. 

  



Vision-Pro 7 Doc Files 

284 

 
  

  

Rotation  
Rotate the shapes by either 90 or –90 degrees. Perform a rotation to help minimize wasted material. 

  

Mirror  
Mirror the shapes either vertically or horizontally. Typically, mirror is used where the media is to be reverse-
applied, such as the inside of a window pane. 

  

Nesting  
Opens the Nesting dialog. Nesting will rearrange the layout of shapes on the media, so as to minimize wasted 
material. 

With respect to grouped objects, nesting can remove objects from their groups in order to nest individual objects. 
However, a query dialog will confirm whether grouped objects should be broken up. 
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Note: The Nesting controls are described under Advanced Cutting and Plotting. 

  

Tiling  
Workspace shapes may be organized into tiles, which is a useful method of sub-dividing the job into manageable 
sections. In addition, the amount of wasted material may be reduced by "stacking" tiles on the media. 

Note: For more information about tiling, please refer to the Advanced Cutting and Plotting chapter. 

Registration Marks  
On the Engrave Manager toolbar, left-clicking the Registration Marks button will open the Registration 
Marks popup. Click the style of registration marks that are required, and the registration marks will be placed 
about the workspace shapes. 

  

 
  

To set the default locations of the registration marks, right-click the Registration Marks button. The 
Registration Mark Setting dialog will open, which may be used to indicate the default Positions, Size and Offset 
of the registration marks. 
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Note: For more information about registration marks, please refer to the Advanced Cutting and Plotting chapter. 

 
 

Weed  
Left-clicking the Weed button will activate the weed border, and the preview will show the border that is created 
around the shapes. 

The Weed offset value from the General Preferences dialog will be used. To use a different Weed offset value, 
right-click the Weed button, and the Weed Setup dialog will open. Changing the Weed offset value will apply to 
the current job being cut, but the default value will not be changed. 

  

 

Note: For more information about creating weed lines, please refer to the Advanced Cutting and Plotting chapter. 

  

Zoom  
The Zoom tools are used to change the perspective of the shapes being previewed. In addition to these buttons, the 
keyboard shortcuts may also be used. 

  

Sort  
Sort settings may be applied to any non-routing object. Clicking the Sort button will open the Sort dialog. 

Note: The Sort dialog settings are described under the next section, Engraving Defaults. 

  

Poll Plotter  
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Where supported, query the plotter for information about the dimensions (Width and Height) that are available for 
output. 

  

Enable Jogging  
Vision-Pro supports Plotter Jog functionality. When the Enable Jogging button is clicked, the Jog Modes dialog 
will query for the type of jogging that is required. 

  

 
  

To use Single point jog, there must be one registration mark on the workspace. With the Single point jog option 
enabled, starting a job will position the tool at the registration mark, and the job will then proceed as if the 
registration mark were the origin. However, the Single point jog feature is supported by a relatively few number 
of cutters. 

For most cutters, the Full axis jog will be used, which is discussed within the Advanced Cutting and Plotting 
chapter. 

  

Pounce  
During the cutting or plotting job, the Pounce setting may be used to create shapes that have either a perforated or 
broken line pattern. This pattern is created by lifting and lowering the tool during the job. 

If the Pounce button is depressed, then pounce is enabled. Right-click the Pounce button to edit the pounce 
defaults. 

  

 
  

The Dash field indicates the length of the perforation or drawn line. The Plate field indicates the spacing between 
each perforation or line. 

  

Filter by color  
Use the Filter By Color option to send only one color layer as output to the cutter. When enabled, the Filter By 
Color dialog will open. 
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Clicking the Filter Layer color picker will display all the color layers that have been assigned to shapes on the 
current workspace. Choose the color that will be output and click the Select button. The preview will display all 
shapes of the indicated color. 

If the Filter Registration Marks option is enabled, then registration marks will be cut with all layers. 

Note: If any thick lines are present in the drawing, then their colors will appear within the Filter Layer color picker. 

  

Selection mode  
The Selection mode determines which parts of the workspace should be sent as output. If the Selection mode is 
Page, then all shapes on the given sheet layer will be valid for output. If then Selection mode is Sign Plate, then 
only shapes that are on the sign plate will be valid for output. 

The engrave preview will only display shapes that are valid for output, as per the Selection mode. 

  

Banner Fill  
Usually, tool paths will be applied to workspace shapes prior to entering the cut preview state. However, the 
Banner Fill button may be used to apply a default fill, such as a thick pen fill. 

After a default fill has been applied, the cut preview will show the path that will be used to fill the shape. If the 
path is not visible, then verify that the Show Tool Diameter item (View menu) is unchecked. 

  

 
  

Right-click the Banner Fill button to open the Fill dialog. These settings are used to customize the banner fill 
settings. 
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The None fill style indicates that there is no fill style. The edges of objects will be traced, but no fill will occur. 

The S-Sweep fill style will generate a series of fill lines that are similar to the Line Sweep fill, except that the line 
paths are joined wherever possible. This is a relatively quick fill, since the number of lift and drop movements are 
minimized. 

The Line Sweep fill style will generate a series of separate and discrete fill lines. This fill pattern is designed for 
those devices that have a short maximum path length, which requires short fill paths. The disadvantage is that the 
cutting head lifts and drops for each fill path, which increases the amount of time required to fill the given object. 

The Fill overlap field indicates the amount that each successive pass should overlap the previous pass. This 
overlap is used to ensure that there are no gaps between contiguous passes of the pen. The overlap is expressed as 
either a fixed value (in the current workspace units), or a percentage of the Pen diameter. 

The Angle field indicates the angle of pen strokes as objects are filled. An angle of zero degrees corresponds to 
the x-axis. When working with an object that "leans" in a given direction, proper setting of the Angle can result in 
significant reductions of production time. 
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Output  
Begin sending the job to the plotter/cutter device. 

ENGRAVING DEFAULTS 
Engraving Defaults 

The Engraving Defaults are used to configure the given device that will be used for cutting or plotting. These 
defaults will be used during the Engrave Preview mode, though most settings may be overridden on a per job 
basis.  

To edit the cutter defaults, choose Engraving Defaults under the Engrave menu. The Output dialog will open. 

  

 
  

The Output dialog controls are described here. In some cases, it may be necessary to refer to the Advanced 
Cutting and Plotting chapter. 
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Copies 
Where more than one copy is being cut, the distance between jobs may be specified. The Xspace represents the 
space between jobs cut side-by-side. If Stack Copies is enabled, then the YSpace represents the space between 
jobs above one-another. The distance is measured in current workspace units. 

  

 
  
The “Use Driver Copies” option is an engraver-friendly copy command. As each engraver copy is 
completed, load the next sheet of material for the subsequent copy. Each copy will be engraved using the 
same series of tool movements. 
  

Options 
Options 

This section is used to take advantage of some of the advanced features available with the Vision-Pro cutting 
routines. 

  

 
  

Mirror 
Plot a mirror image of the job. This is used for a graphic that is to be reverse-applied, such as cutting from the 
inside of glass. 

  

Sort 
The Sort option is used to optimize cutting for a number of different situations, depending on the current needs 
and the modules installed with Vision-Pro. Depending on the type of work being done, there are two possible 
ways in which the Sort option will operate. 
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�       Case 1: In the Output dialog, the Output Tool Paths option is active, and then the Sort option is 
activated. This will indicate that prior to beginning any engraving job that the Sort Tool Paths dialog 
will be used to customize the priority by which tool paths should be routed. 

�       Case 2: In the Output dialog, the Output Tool Paths option is inactive, and then the Sort option is 
activated. Immediately, the Sort dialog will open, so that non-routing objects may be cut in a specified 
order. 

  

 
 

The Sort Tool Paths dialog 
The settings of the Sort Tool Paths dialog apply to any routing or engraving object. This dialog will only open if 
the Output Tool Paths option (Output dialog) for the current driver is active, and the Sort option is also active. The 
dialog will appear prior to starting any routing or engraving job. 

  

 
  

Sort priority is used to indicate an order in which tool paths will be routed. There are four drop-down fields, each 
of which may potentially be set to one of the following: Tool, Material, Depth, X by Y, Y by X, Nearest, and 
Current. The Sort priority fields are numbered, with field number one being of higher priority than number two, 
and so on. Depending on the selection within the currently active Sort priority field, the Sort order list will allow 
additional customization. List here are how the Sort order list is used with each type of sort priority. 

  

�       Tool priority will cause all the tools in the current job to be listed. The list of tools is itself ordered by 
the sequence in which the tools will be used. To adjust this order, use the mouse button to drag the tools 
within the list. A tool may also be deleted from this list by selecting it and pressing the Delete key, 
which prevents the tool from being used in the current job. 

Note: When a tool is selected, the Turret field will become active, which is used to adjust the Turret Number that has 
been assigned to this tool. 

  

�       Material priority will cause all the different materials in the current job to be listed. The list of 
materials is itself ordered by the sequence in which the material will be routed. To adjust this order, use 
the mouse button to drag the tools within the list. 
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�       Depth priority will cause two further options to be listed: “Cut The Deepest Last” and “Cut The 
Deepest First.” The first option will give priority to shallow cuts, after which the deeper cuts will be 
completed. To reverse this priority, use the mouse button to drag the “Cut The Deepest First” option to 
the top position. 

�       X by Y priority will cause objects to be routed according to their placements from left-to-right within 
the workspace. 

�       Y by X priority will cause objects to be routed according to their placements from bottom-to-top within 
the workspace. 

�       Nearest priority can be set to either “Cut in user selected order” or “Nearest to (X,Y)”, where X and Y 
represent a workspace location based on the existing objects. 

�       Current priority is used to that objects be cut according to their user defined order, as set by the Start 
Sequence command under the Layout menu. 

  

 
 

The Sort dialog 
The settings of this dialog apply to any non-engraving object. This dialog will only become active when the 
Output Tool Paths option (Output dialog) for the current driver is inactive, and the Sort option is then selected. In 
this case, the Sort dialog will appear immediately upon selecting the Sort option. 

  

 
  

�       Nearest Sort forces Vision-Pro to sort the objects that are closest to each other and cut them first. For 
example, two objects that are one inch apart will be cut in the same pass, whereas objects that are five 
inches apart will be cut separately. 

�       Database Order sort is the Vision-Pro default for cutting, which forces objects to be cut according to 
their layering order. Layering order indicates the ranking of screen objects as they overlap one another 
on-screen. For example, an object that has a high layering order will appear to be “on top” of other 
objects. To adjust the Database Order, refer to the “To Front” and “To Back” commands that are 
available under the Arrange menu. 

�       Horizontally sorting causes Vision-Pro to cut objects as they appear in the graphic from left to right. 
Vision-Pro will cut those objects whose extreme left edges are farthest right first, and then cut those 
whose left edges are farthest left last. This sort order is most useful when cutting a long file on a 
friction-fed plotter, as it reduces the required amount of travel back and forth along the length of the 
vinyl. 

�       Vertically sorting causes Vision-Pro to first cut objects whose extreme upper edges are lowest along the 
Y-axis. The higher on the Y-axis the object appears, the further in the order it will be cut. 

�       Normally, a paragraph of text will be considered as a single object that is assigned its own sort priority. 
The Sort within paragraph option will cause each distinct letter to be assigned its own position in the 
sort order. For example, if two paragraphs of text, one above the other, are then sorted horizontally, then 
the sort order will proceed with the first letters of each paragraph, followed by the second letters, and so 
on. This has the benefit of reducing the back-and-forth motion of the cutter. 
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Axis Swap 
Enabling this option will rotate the axis by ninety degrees (90°) counter-clockwise (CCW). This is a convenient 
way to save vinyl, especially when cutting long strings of single line text. 

  

Weed Border 
If the Weed Border option is enabled, then the Weed button will be automatically enabled during the Cut 
Preview mode. 

  

Engrave by Color 
If this option is enabled, then entering the Cut Preview mode will automatically open the Filter By Color dialog. 

  

Output Tool Paths 
Enabling this option will open the Tool Path Options dialog. The Output Tool Paths option is used to output 
tool paths that have been applied to workspace shapes. The Engrave Default Tool Path option will create a 
default tool path for all workspace shapes. 

  

 
  

If the Engrave Default Tool Path option is enabled, then clicking the Edit Default Tool Path button will open 
the Fill dialog. The Fill dialog indicates the parameters of the default tool path. 
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�       Tool lists all the available tools in the Tool Library, including the current selection. New tools may be 
added by clicking the ellipse button, which will open the Tools Library dialog. 

�       Depth indicates the overall vertical movement of the tool into the material in relation to the surface of 
the material. 

�       Inside indicates that the tool must cut the object along the interior of the object at a distance equal to 
one-half the tool diameter. This option is equivalent to cutting a Female tool path. 

�       Online indicates that the tool must cut along the object contour. There is no deviation of the tool from 
the object contour, and this option is equivalent to cutting an Online tool path. 

�       Outside indicates that the tool must cut the object along the exterior of the object at a distance equal to 
one-half the tool diameter. This option is equivalent to cutting a Male tool path. 

  

 
�       Tool rotation is counter-clockwise. Click this button to toggle tool rotation between clockwise and 

counter-clockwise rotation. 

�       Fill style allows the selection of a variety of style or patterns that the tool can follow during the hogging 
operation. The available styles are None, S-Sweep, Line Sweep, Spiral, Reverse Spiral, Island, and 
Reverse Island. 

�       Fill overlap indicates the amount by which each successive hogging pass should overlap the previous 
pass. Overlap is used to ensure that all material is removed between contiguous passes of the tool. The 
overlap is expressed as a percentage of the tool diameter. 

�       The Engrave Parameters button opens the Engrave parameters dialog, which is used to control the 
number of passes that must occur before the full depth is cut out. 
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Jog 
If the Jog option is enabled, then the Enable Jogging button will be automatically enabled during the Engrave 
Preview mode. 

  

Origin Jog 
The Origin Jog feature is supported by a relatively few number of cutters. 

To use Origin Jog, there must be one registration mark on the workspace. When the Origin Jog option is enabled, 
starting a job will position the tool at the registration mark, and the job will then proceed as if the registration mark 
were the origin. 

  

Tool 
The Tool section is used to define the tool parameters for the present cut or plot.  

  

 
  

This list box contains a complete list of all tools available for the specified driver. Examples of these tools include: 

  

Air Brush Both Spindles Drill 

Drag Knife Knife Engraver 

Left Spindle Manual depth Multi-pass 

Multi-pass depth No depth Pen 

Pounce Pounce Wheel Racer Blade 

Right Spindle Router Single-pass depth 

Spindle off Trailing Blade   
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Depending on the currently installed driver, only a limited selection of these tools may be available in the list. For 
the cut or plot job, select the appropriate tool from the list. 

  

Trailing or Drag Knife 
Select the Trailing or Drag Knife tools if: 

1. There is a CADlink Racer Blade tool in the Gerber tool holder. 

2. The plotter is equipped with a Trailing Blade or Drag Knife. 

Choosing this tool invokes a routine that allows for the movement of the knife-edge, which is offset from the 
center of the tool. Without this routine, the objects would not be cut properly, and corners would not be cut sharp. 
However, be aware that most cutters that support a Drag Knife also have their own routines that compensate. In 
light of this fact, never set Drag Knife mode for both the cutter and Vision-Pro, as this will result in a poor quality 
cut. 

  

Multi Cut 
Certain materials, such as sandblast film, require multiple passes of the vinyl cutting blade because the material is 
extraordinarily durable. Once the Multi Cut option is enabled, the # Passes field is used to specify the number of 
passes that should be performed. 

Please note that the value set here is dependent upon the material in question, and that an experienced operator 
will know the correct number of passes. 

  

Pounce 
During the cutting or plotting job, the Pounce setting may be used to create objects with either a perforated or 
broken line pattern. This pattern is created by lifting and lowering the tool during the job. 

  

 
  

Select the Pounce option to activate the Dash and Space fields. The Dash field indicates the length of the 
perforation or drawn line, and the Space is the break in the perforation. 

  

Move 
This section specifies where the cutter will begin to plot on the X- and Y-axis. By default, the plotter will normally 
begin cutting a graphic file at the lower left-hand corner of the vinyl. The current unit of measurement will be used 
when setting these fields. 
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Xmove Movement along the length of the vinyl (the X-axis). 

Ymove Use this field to adjust the origin for plotting across the width of the vinyl (the Y-
axis). This feature is particularly useful when cutting an “upper” section of some 
used vinyl. 

  

 
 

Smoothing 
Smoothing refers to the number of vectors or arcs that are used to represent the actual curves when cutting. A 
higher smoothing setting will increase the number of vectors that represent a curve, thereby producing a smoother 
appearance to the finished work. The consequence of higher smoothing is that the greater amount of cutting data 
requires a corresponding amount of computation, which increases the time to complete a given job. 

  

 
  

Low  Results in a faster cut, though perhaps at the cost of some drawing resolution. 

Medium  Results in a marginally slower cut, but a reasonable amount of smoothing is applied. 
This is an optimal setting that is recommended for most cutting operations. 

High  Applies a maximum amount of smoothing to the original drawing. Cutting will be slow, 
but accurate. 

  

Engrave 
The Engrave section determines which parts of the workspace are going to be output. 

  

 
  

Page Plot all objects on all active layers of the workspace. Objects will be shifted from the 
lower left of the page. 

Sign Plate Cut only those objects that appear on the sign plate. Objects that are partially on the 
sign plate will be partially cut. 

Selected Only selected objects will be cut. The Selected option is applied in addition to the 
other Machining settings. 
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Object Start Point 
As each object is cut, the position at which cutting begins may be specified here. Setting this option is used to 
introduce consistency in tool movements as each shape is cut. 

  

 
  

Current This is the usual default, which uses the mouse click positions when the 
object was originally constructed. 

Bottom Use the lowest point on each object as a starting point. 

Top Use the highest point on each object as a starting point. 

Left Use the left-most point on each object as a starting point. 

Right Use the right-most point on each object as a starting point. 

  

  

PLOTTER SETUP 
Plotter Setup 

The Plotter Setup dialog is used to configure the plotter or cutter. 

From the Engrave menu, choose Engraving Defaults to open the Output dialog. Then choose Setup to open the 
Plotter Setup dialog. 
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Plotter tab 
Plotter tab 

The Plotter tab lists the available drivers. A driver is a human-readable text file that Windows uses when 
communicating data to a connected device, which in this case is for a cutter or plotter. Each cutter or plotter has its 
own driver, which should have been installed during the Vision-Pro installation. More drivers can be installed 
from the File menu: 

  

File | Install | Cutting Devices… 

  

The version of the driver is listed at the top-right corner of the tab. 

  

Custom Driver Copies 
This is an advanced option for use in unusual device issues. 

In most cases, there is no need to edit the driver file. However, if there is a need to edit the driver file, it is 
advisable to create a backup copy of the original driver file. 

  

Machine Limits 
These dimensions represent the range of motion over which the tool movements are restricted during the job. Set 
these values to correspond with the physical limits of the router, engraver or plotter that is being used. For 
example, a fifteen inch plotter cannot accommodate a thirty inch wide roll of vinyl. When setting these size 
options, consult your operator manual for any special setting requirements. When using plotters, be aware of two 
important facts: 
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1)       The ability to accept a given width of vinyl does not imply that the device is capable of cutting across 
the full width. The effective width of plotters is typically at least one inch narrower than the vinyl width 
it can accommodate, and the plotter manual must be consulted for exact maximum-width dimensions. 

2)       Some plotters will reset or stall when the maximum length is exceeded during a job. To be cautious, the 
maximum length setting should always be at least one-half inch (12mm) less than the maximum settings 
that are suggested by the plotter manufacturer. Consult the plotter manual for exact maximum length 
dimensions. 

  

The Length and Width dimensions set the default size of the tiling lines. 

  

Get Page Size 
Selecting the Get Page Size button causes Vision-Pro to communicate with the plotter and determine the page size 
set for the plotter. This option is not available with all plotters. 

Plotter ID 
Selecting the Plotter ID button causes Vision-Pro to communicate with the plotter and determines the identity set 
for the plotter. This option is not available with all plotters. 

Notes 
Clicking the Notes button will display device specific information. Important configuration information is 
displayed here. 

  

  

Port tab 
Port tab 

The Port tab is used to specify the method of sending the cut data to the cutter. 

  

Method 

�       Direct to port – Send cut data directly to a device that is connected to this workstation 

�       Plot Spooler – Use the Output Spooler to manage cut jobs  

�       Print and Cut Manager – Use a cut-only version of the Print & Cut Manager to manage cut jobs 
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Port Location 
This drop down menu is used to specify the port through which the plotter is connected. To select a port, click on 
the required choice. There are several types of port available: 

  

�       Serial ports are known as COMM Ports, and vice-versa. These are the recommended type of port to use. 
The serial port has several features which make it the best choice, including the fact that it is designed to 
handle bi-directional communications (i.e., it allows the computer to communicate with the device, 
while also allowing the device to communicate with the computer at the same time). To use the serial 
port to drive the plotter, set up the serial port properly from within Windows Control Panel. For more 
information, consult the plotter manual. 

�       LPT Ports, or parallel ports are essentially printer ports. They will often work with a given plotter or 
cutter, but, unless there is some compelling reason to use an LPT port, a serial port is always a better 
choice. 

�       File, redirects the plot data to a file on the hard disk. 

  

Set Path 
This option is only available when the Port selection is "File." Clicking the Set Path button is used to specify the 
path and filename to which output will saved. 
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Use a meaningful extension, such as PRN, PS, or PLT. 

  

Data Rate 
This is an advanced option for use in unusual device issues. 

The Default data rate will be acceptable for most uses. However, adjusting the Data Rate can potentially improve 
the buffer efficiency when sending packets of cut data over a network. As a suggestion, consult your network 
administrator when trying to determine the impact of sending cut data over your network. If there are no issues, 
then the Default data rate is likely satisfactory. 

  

DOS option 
This is an advanced option for use in unusual device issues. 

The DOS option is used to compensate for the high rate of data transmission that can occur through Windows to 
the cutter. A symptom of this is where the plotter moves in a series of small increments and pauses (alternating 
every half second). In a typical case, straight lines will be cut at a reasonable speed, but the cutting slows 
dramatically on curves. 

By enabling the DOS option, the transmission rate will be slowed slightly, but this communication problem will 
be eliminated. 

Note: Supporting comments can be found through the CADlink web site, Tech Note 1474 of the Knowledge Base. 

  

Use Plot Spooler 
This will cause all output, regardless of the port, to be processed by the Vision-Pro Output Spooler. The Output 
Spooler is optimized for transmitting data that matches the specific requirements of the given router, engraver, or 
plotter. Sending simultaneous jobs to multiple output devices is supported, and once a job is sent, Vision-Pro is 
free to continue editing other workspace projects. 

  

Remote Spool 
If the Spool option has been enabled, then the Remote Spool option will become available. The Remote Spool 
option is used to plot files across a network to a device that is attached on a different computer from the design 
station 

  

Use Print & Cut Manager 
The Print & Cut Manager is a job management interface that allows print and/or cut jobs to be queued before 
being sent to the output device. The Print & Cut Manager is similar in purpose to the Plot Spooler, except that the 
Print & Cut Manager is designed with more functionality for archiving, previewing, and tracking jobs. 
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In a sense, the Print & Cut Manager can be thought of as an output destination that can be on another computer of 
the network. However, even when sending jobs to another network computer, please set the Port Location to 
indicate the port that the device is connected to on that computer. 

At the time of writing, Vision is providing a cut-only version of the Print & Cut Manager that can be installed on 
network computers without the need for a supporting security dongle. Each installation of the Print & Cut 
Manager includes context-sensitive help that explains how the controls are used. 

  

Plotter Options tab 
Plotter Options tab 

  

 
  

  

Origin 
This option determines the location of the plotter Origin. Options include Upper Left, Center, or Lower Left. 

End Point 
This option determines the final resting position of the tool after drawing or cutting an image. It can be set to End 
or Origin. The End option causes the cutter, upon finishing a given cut, to come to rest at the origin of the next 
section of vinyl to be cut (the extreme lower right of the job just finished). Choose Origin to cause the cutting head 
to return to the origin of the cut just completed. An exception to this rule is when the plotting area is tiled, in 
which case the tool will return to the origin of the last tile cut. 

  

Origin Adjust 
This is an advanced option for use in unusual device issues. 
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These edit fields are used to change the coordinates of the plotter origin point. This is typically used where it is 
desirable to send a job with adjusted origin coordinates, without needing to manually change the origin from the 
plotter control panel. 

  

Resolution 
This is the factory-set resolution for the number of stepper-motions that constitute one inch. In the vast majority of 
cases, there is no need to adjust this value. Indeed, setting the wrong value here will cause jobs to be wildly 
inaccurate. 

  

Manual Calibration 
These manual calibration fields are provided as a means of compensating for a cutter that has undergone 
significant usage, such that the cutter movements have lost some precision. Calibration is simply done by 
outputting a square shape and then measuring the resulting output. 

  

1) Draw a square of at least 10 inches (or 250 mm) per side, and send it as output through the cutter. 

2) Measure the cut square as accurately as possible using a ruler or caliper. 

3) In the Manual Calibration fields, indicate the original size of the square, and the size of the square as it 
was actually output. 

4) Click the Calculate Scale button, and a new scale factor will be calculated to ensure that cut jobs are 
performed correctly. 

  

At any time, the Reset button can be clicked to restore the original values. 

  

Tool Options 
Each engraver has driver options that control the movement of the tool head. The Tool Options dialog is used to 
adjust these options according to the currently active driver, and the dialog fields will change to represent the 
options that are actually available for the driver. As an example, the Apex Cutter driver will cause the Tool 
Options dialog to appear as follows: 

  

 
  

The controls that appear on the Tool Options dialog are specific to the given cutter. For full details about these 
controls, consult the Operator Manual that was provided with the cutter. 

  

CONTOUR CUT LINES 
Contour Cut Lines 
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Contour Cutting  
Contour Cut On/Off 
Die Cut 

Contour Cutting 
Contour Cutting 

Contour Cut 
Contour Cutting a Vector Shape 
Contour Cutting a Bitmap 
Finding a Useful Threshold Value 
Contour Cutting a Shape and Bitmap 

Contour Cut  
The Contour Cut feature traces a hairline outline around a scanned image or graphic, which is used to indicate an 
engraving line. Both inner and outer contours can be traced. 

 

 
 

Corner 
There are three styles available for tracing the corners of a selected object: 

 

Style Effect 

Point Trace all corners to a sharp point. 

Round Soften the corners to a rounded edge. 

Miter Crop or square the corners. 

 

 
 

 

Pointed corners Rounded corners Mitered corners 

 

Contour Style 
There are two options for Contour Style: 

 

 
Cut outer contours only. 

 
Cut both inner and outer contours. 

 

Offset 
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The Offset amount indicates the distance that is to be maintained between the object contour and the resulting 
contour cut. The current units of measurement will be applied (see General Preferences dialog). 

 

Layer Color 
When selecting the color that will represent the contour, use a color that is not otherwise being used in the graphic. 
In so doing, the contours and original objects may be easily discerned when using the Cut by Color option (Plot 
dialog). 

 

 
 
Miter Limit 

The Miter Limit is applied between the corners of the original object and the contour cut. 

 
 

This limit is expressed as a percentage of the Offset amount. 

 

Contour Cutting a Vector Shape  
Suppose that contour lines must be created for a vector image that has inner contours. For example, consider the 
following shape: 

 

 
 

Select the shape and then choose Contour Cut from the Cut menu. The contour cut controls will appear in the 
SmartBar. 

 

 
 

The follows SmartBarsettings were used: 

 

Type of Contour Outside/Inside Contour Cut 
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Contour Style Round Corner 

Offset Zero 

Color Black 

 

To finish editing the contour cut lines, click within an empty portion of the workspace. 

 
 

By moving the original shape aside, the contour cut lines will be visible. Note that contour cut lines have been 
created for the inner contours as well. 

 

 
 

 

Contour Cutting a Bitmap  
To contour cut a bitmap, Vision-Pro will analyze a monochrome (i.e. black-and-white) version of the bitmap and 
determine the discrete boundaries of the bitmap. This is done by comparing each bitmap pixel with a threshold 
value. Pixel colors that fall below the threshold will become black, and those exceeding the threshold will become 
white. Contour lines are then created based on the boundaries between white and black sections of the bitmap. 

The contour lines that are created will vary according to the threshold value used. For example, select a bitmap 
and then choose Contour Cut from the Cut menu. 

 

 
 

Using the SmartBar, set the contour cut settings as appropriate for the job. In this example, the following settings 
were used: 

 

Type of Contour Outside Contour Cut 

Contour Style Round Corner 

Offset Zero 

Color Blue 

 

When the Apply button is clicked, the Monochrome Filter dialog will open. 
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For this example, we chose 50 as a Threshold value and then clicked the OK button. In this case, the results were 
quite good, as shown in the following screenshot: 

 

 
 

However, we had previously tried using a threshold value of 150, which produced the following results: 

 

 
 

The problem is that the boundaries between light and dark areas of the bitmap was less well defined, so "artifacts" 
(small contour cut objects) were created in these boundary zones. Though such artifacts may be deleted, it is easier 
to choose a threshold value that minimizes the amount of artifacts. 

 

 
 

Finding a Useful Threshold Value  
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To quickly find a useful Threshold value when contour cutting a bitmap, it is useful to create multiple copies of 
the bitmap. In this case, five duplicates of the original bitmap were created. 

 

 
 

Select the first bitmap, and then choose Contour Cut from the Cut menu. 

In the SmartBar, choose the SmartBar settings and then click the Apply button. The Monochrome Filter dialog 
will open. 

Set the Threshold value to zero and click the OK button. The contour cut lines will be created for the first bitmap. 

However, Vision-Pro is still in the contour cut mode for the first bitmap, and it is possible to select a different 
bitmap without leaving the contour cut mode. 

Click on the edge of the second bitmap, and the Monochrome Filter dialog will open again. 

This time, set the Threshold value to 50 and click the OK button. The contour cut lines will be created for the 
second bitmap. 

Continue to select each subsequent bitmap and apply a different Threshold value. For this example, the following 
Threshold values were used: 

 

Bitmap Threshold value 

1 0 

2 50 

3 100 

4 150 

5 200 

6 255 

 

Once contour cut lines have been created for all of the bitmaps, click within an empty portion of the workspace to 
return to the Select state. 

Select each bitmap and move it aside. However, take care not to move the cut lines. 

Once the bitmaps have been moved, the remaining contour cut lines will indicate the best Threshold value for the 
bitmap. In this particular example, a Threshold of zero was too low and produced no cut lines, whereas a 
Threshold of 255 was too high and produced a vague outline around the bitmap perimeter. The most balanced 
result occurred when a Threshold of 150 was used. 

 

 
 

 

 
 

Contour Cutting a Shape and Bitmap  
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More than one shape may be selected when using the Contour Cut tool. In addition, it is possible to mix vector 
shapes with bitmap images. For example, consider the following cat shape that is supplemented with a fish bitmap 
pattern. 

 

 
 

Select both objects and then choose Contour Cut from the Cut menu. The contour cut controls will appear in the 
SmartBar. 

 

 
 

The follows SmartBar settings were used: 

 

Type of Contour Outside/Inside Contour Cut 

Contour Style Round Corner 

Offset Zero 

Color Blue 

 

 

To finish editing the contour cut lines, click within an empty portion of the workspace. 

 
 

By moving the original objects aside, the contour cut lines will be visible. 
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Contour Cut On/Off 
This command will convert a line art shape into a contour cut line, and vice-versa. This command is typically used 
where the contour has been drawn freehand. 

  

Die Cut 
Use the Die Style drop-list to create a tool path based on preset shapes. 

 
  

The available styles are: 

�       Square 

�       Rectangle 

�       Circle 

�       Oval 

�       Triangle 

�       Polygon 

�       Star 

�       Pointed Gear 

�       Blunt Gear 

  

  

TOOL LIBRARY 
Tool Library 
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The Tool Library is used for organizing pre-defined sets of tools that will be used with the connected engraver. 
As new engraving paths are created, tools may be selected from the library instead of setting new tool parameters. 
The Tool Library dialog is opened from the Engrave menu. 

  

 
  

The available tools will be listed at the top-left of the dialog. When a given tool is selected, a diagram that 
illustrates the tool type parameters will be displayed to the right of the list. 

Type 
This list box includes all of the available tool types. The Types of tools available for use with Vision-Pro are End 
Mill, V-bit, Conical, Double Conical, Round, Round bottom, Flat bottom, and Engraver. This list cannot be edited 
or added to. The following diagrams describe the relevant dimensions of the each tool type. 

  

    
End Mill V-Bit Conical Double Conical 

    



Vision-Pro 7 Doc Files 

314 

Round Round Bottom Flat Bottom Engraver 

  

Tool Parameters 
Tool Parameters 

At the bottom of the dialog, the Tool parameter values will be displayed for the selected tool. Some bits have 
irregular parameters, such that they have either two diameters and/or two height values. 

  

 
  

Diameter 1, Diameter 2 
The Diameter settings can be edited to within 1/1000th of a measurement unit. Diameter 1 is the total width value 
for any given bit, and if there are two width values, then Diameter 1 will always be the greater value. Diameter 2 
is the end width value for any given bit. 

 

 
  

Height 1, Height 2 
The Height scroll boxes can be edited to within 1/1000th of a measurement unit. Height 1 is the total height value 
for any given bit, and if there are two height values, then Height 1 will always be the greater value. Height 2 is 
the point height value for any given bit. 

 

 
  

Add 
To create a new tool, choose a similar tool from the list, and then set the parameters of the new tool. Type a unique 
Name for the new tool, and then click the Add button. 

Change 
To edit an existing tool, select that tool from the list, set the new parameters for that tool, and then click Change 
to accept the parameters. 

Delete 
To remove an existing tool, choose that tool from the list and click the Delete button. 
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OUTPUT TOOL USAGE 
Output Tool Usage 

Output Tool Usage is an estimation tool that collects statistical information about the performance of the tools 
being used in cutting or plotting. A variety of data is gathered about each tool, such as the overall distance 
traveled, the number of jobs completed, and the date of the last tool change. Using this data, comparisons between 
successive tools may be used to make an informative decision about when tools are likely to decline significantly 
in performance. Tools may then be replaced in advance of this decline, thereby preventing materials from being 
wasted by an old tool. 

Under the Engrave menu, selecting the Output Tool Usage item will open the Tool Tracking dialog. Tracking 
will be set for the current device that is set in the Engraving Defaults, though other tools may be chosen. 

Show Traveled Distance 
Show Traveled Distance 

If the Show Traveled Distance option is enabled, then after each cut job, a dialog will state the total distance that 
the tool moved during the job. 

Estimate time for current job 
After this option is first enabled, the next job that you complete will require that you record the approximate time 
to complete the job. Before the job begins, the Estimated Time dialog will open. This is simply a reminder that 
you need to record the cutting time. 

  

 
  

Once you click OK, the job will continue as expected. After the job is complete, you will be asked to enter the 
time that was expended in completing the job. 

  

 
  

If the estimated time must be updated later, then return to the Tool Tracking dialog and click the Setup Machine 
Time button. For the next job that is performed, you will be asked to estimate the job time again. 

Once a time estimate has been set, use the Show Traveled Distance item (Engrave menu) to display the time that 
will be required the current workspace design. By using this estimate, you can better manage your own time, since 
you will be able to work on other tasks and return when the current job is complete. 

  

History of Tool Changes 
Tools are indexed in sequence, from the first tool that statistics were ever gathered for, to the tool that is currently 
loaded into the machine. 
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Whenever a tool is changed, click the Replace Tool to indicate that statistics are being collected for a new tools. 
The Replacement number will automatically increment, and the statistics fields (Days used, Jobs done, etc.) will 
be reset.  

The replacement number indicates the tools for which statistics are available. The scroll arrows can be used to 
navigate through all the previously used tools.  

  

Reminders 
The Reminders are used to prompt when a tool should be changed. Reminders may be set to occur after the 
number of days used, the number of jobs done, the total distance traveled, as well as the total time expended as the 
tool was in use. 

Click the Set Milestones button to specify the parameters for a given reminder. 

During the regular process of cutting or plotting a job, if a milestone is encountered, then a warning dialog will 
prompt you before the job occurs. 

  

 
  

In cases where the tool must be replaced:  

  

1) Replace the tool 

2) In the Reminders dialog, click the Tool replacement option 

3) Click OK to close the Reminders dialog 

  

By doing this, the Replacement number will be automatically incremented in the Tool Tracking dialog, and the 
job will proceed using the new tool. Statistics will be collected for this new tool. 

  

OUTPUT SPOOLER 
Output Spooler 

The Output Spooler is a stand-alone application that is designed to make routing and engraving more efficient. 
The Output Spooler operates in the background independently of Vision-Pro, which allows new projects to be 
edited while waiting for the current job to finish. Additionally, Output Spooler allows cutting to machines on 
different ports simultaneously. Use the Output Spooler to send ASCII files from sources other than Vision-Pro. 

If a device requires non-standard handshaking or data-encryption like those from Anagraph or Gerber, the Output 
Spooler is of particular value, since it will allow for spooling of jobs to these devices. The drivers for these devices 
do not support the use of third party plot caching programs such as the Windows Print Manager. 
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Using The Output Spooler In Vision-Pro 
The Output Spooler is enabled from the Port tab of the Plotter Setup dialog. Enabling the “Use Plot Spooler” 
option will cause cut jobs to be sent to the Output Spooler on the local computer. If the Remote Spool option is 
enabled, then a directory on another network computer may be specified as the output destination. 

  

 
  

The Output Spooler can also be run by itself. For more information on this mode of operation, see the section 
entitled “The Output Spooler As A Stand Alone Program.” 

  

Spooler Controls 
Spooler Controls 

 
When a job managed by the Output Spooler begins, the Output Spooler will appear as a minimized application. 
When maximized, the Output Spooler window appears as follows: 
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Job Queue 
Within the Output Spooler window, the status of each job is displayed in a queue: 

  

 
  

The order, from top to bottom, indicates the priority in which jobs will be completed. The order may be modified 
by dragging an inactive job to a different row in the queue. 

The status fields are described as follows: 

Color 
Indicates the color currently being plotted if the Engrave by Color option is used. When cutting by color, each 
color corresponds to a separate job, which allows jobs to be sorted by color. 

Status 
This column indicates the current status of each print job. Possible types of status are: 

Receiving: Indicates that the Output Spooler is currently receiving a new job from Vision-Pro 

Ready: Indicates that the selected job has been completely received and is ready to be cut. To begin sending this 
job, select it and press the Start button. This status will only appears when “Auto Start” is not selected under the 
Options menu. 

Pending: Indicates that the selected file has been added to the queue, but is not yet sending because the required 
port is busy. This is different from the Ready status, since a Pending file is automatically sent to the output device 
as soon as device becomes free, whereas a Ready job must be manually started. 

Sending: Indicates that the job is being sent through the port to the device. 

Paused: Indicates that the job has been paused either by pressing the Pause button, or from a pause command in 
the file (such as for a manual tool change). 

Done: Indicates that the entire file has been sent to the device. The job may be either deleted, or saved for later 
spooling. 

% -- Percent Complete 
Indicates the percentage of job that has been completed. 

Copies 
Indicates the number of copies remaining to be sent to the device. 

Port 
Indicates the port through which data will be sent. 

File 
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If Vision-Pro began the job, then this parameter indicates the name of the Vision-Pro CDL file associated with the 
job. Otherwise, this parameter will display the DOS filename that was manually opened for spooling. 

Device 
Displays the name of the output device as selected in the Engraver Setup dialog. 

  

 
 

Job Control Buttons 

 
  

Above the Job Queue are several context-sensitive buttons for controlling the spooling process. The possible 
button are described as follow: 

  

All Stop 
Stops all jobs. Data transfer from Output Spooler to the ports is halted, 
pending further instructions. Note that devices may appear to be continuing 
because they maintain a buffer of data. 

Continue Send output to ports that had been interrupted by the All Stop command. 

Pause Stop the selected job. 

Resume Send output to the port that had been interrupted by the Pause command. 

Abort Abort the selected job. 

Delete Remove the selected job from the queue. 

Start Send the selected job data to its designated port. 

  

OUTPUT SPOOLER AS A STAND ALONE APPLICATION 
Output Spooler As A Stand Alone Application 

The Output Spooler can be launched independently of Vision-Pro and utilized to manage plotting, routing and 
engraving jobs. Jobs can be managed simultaneously between multiple devices on separate ports. 

File Menu 
The File menu commands are used to open files and designate ports for sending output. 

  

 
  

 
 
Open 
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Selecting this option brings up the Open a Spool File dialog box. 

  

 
  

Spool files (.SPL) are used to store Vision-Pro jobs. Choose the Vision-Pro file and click the Open button. If the 
opened file is not a Vision-Pro type, then the port for sending the file will need to be specified. 

Save As 
This option allows for saving the currently selected job as a spool (*.SPL) file through the following dialog box. 

  

 
  

A spool file is a file containing the commands necessary to make the output device cut/rout/print an image or file. 
The Save Spool File is a standard Windows dialog box, with the ability to change drives, directories, and file 
types. When saving a file as a spool file, it should be noted that spool files often require more disk space than 
standard application files. 
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Set Default Port 
Use the Port dialog to set the default port that jobs will be sent to. 

  

 
  

Set Spool Directory 
The data for jobs may be stored to file and then sent to the device at a later time. The Spool Directory dialog is 
used to set the default directory to which job files will be saved. 

  

 
  

Refresh 
The Refresh command forces the Output Spooler to update the status of all pending jobs. 

Options Menu 
The Options menu controls how jobs are processed. 
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Auto Start 
If the Auto Start option is active, then jobs will commence as soon as they are received by the Output Spooler. 
Otherwise, jobs will be paused until they are started manually. 

Keep Job 
If the Keep Job option is active, then jobs will remain listed in the Output Spooler window after they have been 
completed. Depending on requirements, jobs may then be either saved or discarded. 

Signal Job Completion 
If the Signal Job Completion option is active, then a popup dialog will appear as each job is completed. This 
feature is most useful when cutting by colors. 

Always On Top 
If the Always On Top option is active, then the Output Spooler window will visible over all other windows. 
When this option is activated, the Output Spooler will be shifted to the lower-right of the screen by default. 

Sort Colors 
When cutting by color on a plotter, the Sort Colors feature is used to group jobs according to the color of vinyl 
required. This minimizes the number of times that the plotter must be loaded with a different color of vinyl. 

As an example, the following image of the Output Spooler shows several jobs that are differentiated by the color 
being used. But the jobs are ordered according to when they were received by the Output Spooler. 

  

 
  

From the Options menu, the Sort Colors option was chosen. The jobs have now been sorted according to their 
individual colors, as the following screen shot shows: 
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Start All 
The Start All command will initiate all jobs, causing Output Spooler to begin sending each job to its indicated 
port. 

Delete All 
The Delete All command will clear all jobs from the Output Spooler queue. 

 
 

Status Menu 
The Status menu item opens the Job Status dialog: 

  

 
  

This Job Status dialog provides the following information about the current job. 

Status 
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This field displays the current status of the file. This status corresponds to the Status field on the Output Spooler 
queue. 

Port 
This field displays the port through which the file is being sent. 

Job Filename 
This field displays the name and path (drives and sub-directories) of the source spool file. This is the name of the 
file as it was generated on disk. 

CDL Filename 
This field displays the name of the CDL file from which the output file originated. If Vision-Pro did not generate 
the file, then this field will be blank. 

Device 
This field displays the name of the device to which the output file is being sent. This is the same as the Device 
field in the main Output Spooler window. 

Copies 
This field displays the number of copies of the file to be sent to the port. The arrow buttons  to the right of 
this field can be used to increase or decrease the number of copies. 

File Size 
This field displays the size of the file being sent. 

Bytes Sent 
This field displays the number of bytes sent to the port. 

Elapsed Time 
This field displays the amount of time that has elapsed since the Output Spooler began sending the job to the 
output device. 

Waiting For 
This field is used when Output Spooler is waiting for a of signal from the output device. If the spooler is waiting, 
then this field will display the anticipated signal. 

 
 

Last Error 
If Output Spooler receives an error message from the device, then the numeric code for this error will be displayed 
in the Last Error field. The term “error message” is a misnomer because it can also refer to messages that indicate 
that output is being processed normally. 

To view a description of the error message, click the Error button. 

  

 
  

Dimensions 
This field displays the physical dimensions of the job. 
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Under the Dimensions field is a button that indicates the units of measurement. Clicking this button will toggle the 
units between inches, millimeters, and centimeters. 

A Note About Multiple Copies 
From the Output dialog in Vision-Pro, it is possible to set more than one copy to be sent to the Output Spooler. 
However, the job will arrive at the Output Spooler as a single job, but with instructions to cut the file multiple 
times. As a result, the Output Spooler must be told to repeat a job by pressing the Start button. 

The exception to this is when the stack command is used in the Vision-Pro Output dialog. When specifying that 
multiple cuts are to be stacked, the entire file, including all copies and stack information will be sent as a single 
file. For example, a job with six copies stacked will always yield six copies stacked when the Start button is 
pressed in the Output Spooler. 

REMOTE SPOOLING 
Remote Spooling 

Remote spooling is a process by which data is sent to a device that resides on a computer other than the one that is 
running Vision-Pro. The Spooler program resides on a remote computer connected to a network. Several remote 
machines may be addressed by having multiple device drivers installed and their remote spool file directory set to 
the same directory that the remote spooler is using to pick up spool files. 

Using the Remote Spooling Feature 
To use the Remote Spooling Feature, both the remote and local computers must be prepared. Each is discussed in 
the following sections. 

The Remote Computer 
The Remote Computer 

The Remote Computer will be the computer that receives the cutting data, and which has an attached device that 
will render the data. To prepare the Remote Computer for receiving cutting data, follow these steps: 

1)       On the Local Computer (the one which Vision-Pro has been installed), search the Vision-Pro directory 
for an executable file called “spooler.exe”. 

2)       Copy this executable onto a floppy disk. 

3)       Using the floppy disk, copy the executable onto the Remote Computer. 

4)       From the Start menu on the Remote Computer, choose the Run command to execute “spooler.exe”. 

5)       The Output Spooler application will open. 

6)       From the File menu, choose Set Spool Dir and set the common directory to which files will be stored 
for spooling. 

7)       From the File menu, choose Set Default Port and set the port to correspond to where the device is 
connected on the Remote Computer. 

8)       From the Options menu, verify that the Auto Start option is active. 

  

 
 

The Local Computer 
The Local Computer will be the design computer that has been installed with Vision-Pro. In Vision-Pro, remote 
spooling is enabled from the Engraver Setup dialog. 

1)       Under the Engrave menu, choose Engraver Setup. The Engraver Setup dialog will open: 
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2)       On the Engraver Setup dialog, select the Remote Spool option. 

3)       The Browse for Folder dialog will open. 

 
4)       Using the Browse for Folder dialog, locate the Remote Computer on the network. Then open the Spool 

Directory that was chosen in step (6) when setting up the Remote Computer. 

5)       Click OK to accept this spool directory. 

6)       In the Engraver Setup dialog, click OK to accept the remote spool. 
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At this point, both the Local and Remote computers are configured to funnel cutting data to the device that is 
connected to the Remote Computer. 

Furthermore 
With the Local and Remote computers connected over a network, the Spooling directory can actually be placed on 
either machine. Where the Spooling directory is placed has advantages and risks, which are summarized as 
follows: 

�       If the Spooling directory is on the Local Computer, then the cutting process will begin marginally faster 
over a network. However, a network failure would interrupt data being sent to the device. 

�       If the Spooling directory is on the Remote Computer, a network failure would not interfere with data 
being sent to the device. However, the Local Computer must have the proper read and write permissions 
for the Spooling directory. 
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 SENDING PRINT JOBS 
SENDING PRINTJOBS 

The Print Command 
Printer Page tab 
Preferences tab 
Page Setup tab 

THE PRINT COMMAND 
The File | Print option sends the current drawing on the screen to a Windows supported printer. In Vision-Pro, the 
Print command can be used to send raster fill and hairline cut data to a laser engraver. Click the Print command 
to open the Print dialog: 

  

 
  

PRINTER PAGE TAB 
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Printer Page tab 
Within the Printer Page tab are options to select the Printer, Preview, and Setup. 

  

Printer 
The current printer selected will be shown directly under the title of the Select Printer Options dialog. A list of 
available printers is shown inside the Printer list box, which correspond to the drivers that have been currently set 
up using the Control Panel. Click on the required printer to select it. 

Note: If a printer is not displayed in the printer list, the printer driver must be loaded using the Windows Control Panel. 

  

Preview 
When the Preview option is checked and OK is selected from the Printer Page tab, the Print Preview screen 
appears. The objects to be printed are displayed on screen along with the default tiling lines in place. Adjust the 
tiles where necessary, and select Print to begin printing. Select Cancel to abort the print job 

  

 

Note: On the Preferences tab of the Print dialog, if the print mode is set to Plate Size, then the preview will identify the 
sign plate as the object to be printed. This can be disconcerting when scaling because the nubs will be arranged about 
the sign plate instead of the image. To eliminate confusion, the Include Edge of Sign Plate (also available on the 
Preferences tab) can be activated to reveal the sign plate boundaries. 

 
 

During print preview, the SmartBar is used to adjust the preview settings. 
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Clicking the Setup button will return to the Print dialog. In addition, information is displayed about the image 
and/or tiles of the image, including: 

�       the position of the object relative to the edge of the page 

�       the size of the selected objects to be printed 

�       the unit of measurement of scale for relative sizing on screen 

�       the percentage or ratio by which to scale the objects 

�       the number of tile rows and columns (for reference only) 

  

 
Align Images tool 

Use the Align Images tool to adjust the placement of the image upon the page, such as centering the image. 

 
Fit To Page tool 

The Fit To Page tool will recalculate the image size, so as to maximize the image upon the page. The aspect ratio 
of the image will be preserved. 

Zoom tools 
The only other active tools available within the Print Preview window are the Zoom tools. They function in the 
same manner as upon the Vision-Pro workspace.  

.  

 
 

Moving Objects Within the Tiles 
Objects can be moved to avoid breaking up intricate work (e.g., small text) by simply dragging the objects up or 
down with the cursor. However, there is a maximum tile size based on the paper size used by the printer. If the 
paper size is exceeded, a new tile automatically appears where required. 
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Scaling the Objects to be Printed 
The objects in the Preview screen can be scaled up or down in size to adjust the number of tiles required to print 
the entire image. To resize the objects: 

�       Pass the cursor over one of the corner nubs 

�       When the cursor changes to a bi-directional arrow, click and drag the nub to either enlarge or reduce the 
size of the objects 

  

When objects are resized in this manner, then all of the tiles are re-activated. 
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Activating and De-Activating Tiles 
Once the objects have been positioned, any of the resulting tiles may be printed. Only activated tiles are printed. 
Tiles that are de-activated are set to gray, though a blue outline will remain to signify the inactive tile boundaries. 
Clicking within the tile boundary re-activates the tile. 
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Two comments about activating tiles are that: 

�       Overlapping sections are displayed, but cannot be selected.  

�       Right-clicking within a tile will display the outer region of the tile. 

  

 
 

Setup 
From the Printer Page tab, clicking the Setup button will open the Properties dialog for the selected printer. The 
layout of the Properties dialog will depend upon the version of Microsoft Windows being used. 

Changes made to the Properties dialog, as well as all controls that are accessed though the Properties dialog, are 
system-wide. All changes will be applied to the Windows Print Driver for the selected printer. Therefore, changes 
made here will be in effect for other Windows applications. 

  

PREFERENCES TAB 
Preferences tab 

Within the Preferences tab are options to select the number of Copies, as well as the option to Fit to Printer and to 
Print Badges. 
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Copies 
This entry box is used to specify the number of copies to be printed. This box is edited by sweep-selecting the 
entry and typing in a new number. By default, the entry in this box is “1”. 

  

Print As Shown On Screen 
This option prints the image as it is shown on screen. Functionally, this option allows printing the image either:  

�       as wire frames (no fills) if Show Fill is turned off 

�       without thick lines if Show Line Style is turned off 

  

Printing Mode 
Specify the images to be printed according to the following options: 

  

Selected Objects Only Print only those objects that are currently selected. 

Sign Plate Area Print everything that is within the confines of the sign plate. 
Any objects outside the sign plate are not printed. Note that 
objects that are partially on the sign plate will be printed 
accordingly. 

Entire Area Print everything within the open workspace, which comprises 
all objects both inside and outside the confines of the sign plate. 
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Include Bitmaps 
Select this option to print bitmap files from Vision-Pro (i.e., *.BMP, *.PCX, or *.TIF files). 

Include Dimensions and Notes 
This option prints any dimensions created in the file. Dimensions include any size notations or notes generated 
using the Dimensioning tools from the Measure tool in the tool bar. 

Include Guidelines 
With this option selected any Guides placed on screen will be printed along with the Guide Labels. The Guides 
must be set as visible in order to be printed. 

Include Grid Lines 
With this option selected, the Grid placed on screen will be printed. The Grid must be set as visible in order to be 
printed, and will be printed as set to view (i.e. the Show Grid as Lines option). 

Separate Colors 
Use this option to create color separations, where each color will be printed as a separate job (e.g. print red shapes 
as one job, blue shapes as the next job, and so on…). 

Clip Separated Colors 
For overlapped shapes, enabling this option will clip those shapes according to their overlying shapes. 

Fit to Printer 
This option will scale the image to the media that is currently loaded into the printer. 

TrueType Hinting 
TrueType hinting is a font technology that allows small text sizes to be legible on low resolution devices. In 
addition, TrueType hinting improves the results from scaling and rotating the text. 

  

Print By Color 
Print By Color 

The Print By Color option is used to activate the Print By Color dialog, which contains specialized controls for 
sending print jobs to a laser engraver. From the Print dialog, clicking OK will open the Print By Color dialog. 
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Using the Print By Color dialog, the laser engraver will interpret grayscale gradients as speed and power settings, 
such that blacker portions of the gradient will cut deeper than the lighter portions. For shapes that have been 
applied with a hairline stroke, these hairlines can be interpreted as cutting lines. Hairline colors can be set to 
different colors (red, green, yellow, etc.) to correspond with the specific speed and power settings within the laser 
engraver driver. 

Shape fills, including their grayscale gradients, are interpreted by the laser engraver as raster fills. Some general 
tips when creating grayscale gradients for line art and bitmaps are: 

  

For Line Art: 
�       The Gradient Fill tool can create grayscale blends by using black and white as the gradient colors. 

�       The Metamorphosis tool can create grayscale blends between black and white shapes. 

�       Line art can be converted into a grayscale bitmap using the Render Contour Bitmap command. If the 
original line art is retained, then it can be used as a Clipping Path on the bitmap. 

  

For Bitmaps: 
�       An imported image can be converted into a grayscale by applying the Image menu | Mode | Grayscale 

command. 

�       To invert the white and black portions of a grayscale image, use Image menu | Color Adjustments | 
Invert command. 

�       To adjust the tonal range of the grayscale image, use the Image menu | Color Adjustments | Curves 
command. 

�       Under the Image menu are collections of Color Adjustment and Filters that can be applied to 
grayscale images. 
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Raster Data 
The raster data is the fill (including grayscale gradient) of each shape, whereas hairlines are interpreted as cutting 
lines. The Raster Data options are used to specify how raster data will be sent. 

  

�       The Send None option indicates that only hairline data will be sent, and no raster fill data will be sent. 

�       The Send All option will send the raster fill data, followed by the hairline cutting data. 

�       The Send By Hairline option is used to group raster data according to each hairline color. For all the 
objects that have the same hairline color, the fills of those objects will be sent as a single raster data fill, 
which is then followed by the given hairline color. For each subsequent hairline color, the raster data 
will be similarly grouped. 

  

Cut Data: Hairlines 
This list shows the hairline colors that are present, and their order within this list represents the cutting priority. 
Note that these priorities can be changed by dragging each hairline to a new position within the list. 

  

 
  

�       The Send None option indicates that no hairline cutting data will be sent. Only raster fill data will be 
sent. 

�       The Send All Checked Colors option will only send fill and/or cutting data according to the hairline 
colors that have been checked. 

�       The “Send Checked Colors One At A Time” option will cause each hairline color to be sent as a 
separate cutting pass. 

  

Sort Cut Data 
Each hairline color represents a cutting path, and the Sort Cut Data options are used to specify the order in which 
each hairline will be cut. The best sorting method will depend upon the job in question. If the sort order is None, 
then hairlines will be cut according to the order in which the shapes had been drawn on the workspace. 
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The sorting methods are summarized as follows: 

  

�       Nearest – Calculate the objects that are closest to each other and cut them first. For example, two 
objects that are one inch apart will be cut in the same pass, whereas objects that are five inches apart will 
be cut separately. 

�       Horizontally – Shapes will be sorted according to how they are arranged within the horizontal (x-axis) 
plane. 

�       Vertically – Shapes will be sorted according to how they are arranged within the vertical (y-axis) plane. 

  

  

Driver Settings – Color, Power and Speed 
From the Printer tab of the Print dialog, click Setup to access the driver settings for the laser engraver. The 
following screenshot is typical of the Power and Speed settings that can be set for the hairline colors. In this 
particular example, note that the GCC color palette (provided with Vision-Pro) has been created to correspond 
with the driver settings of the GCC laser engraver. 
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Driver Settings – Vector Sorting Option 
In order to sort the job by hairline color (see Cut Data: Hairlines option), there is a critical setting in the device 
driver. On the Advanced tab, set the Vector Function to Vector Sorting. If this option is not set, then it will not 
be possible to prioritize the job by color. 

  

 
  

Example of Printing By Color – Gradient Fills 
The following example has three stars, some text, and a warped border that is above and below the text. Each of 
these shapes has a grayscale pattern that was applied using the Gradient Fill tool (by creating gradients from black 
to white). In addition, the stars have been given a blue hairline stroke, and a red hairline stroke has been given to 
the text and border. 
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When printing this job to a laser engraver, we want the raster fill data to be grouped according to the hairline cut 
color, and we want shapes with a blue stroke to have the higher priority. We also want the red hairlines to be 
interpreted as cutting lines, but we do not want to cut the blue hairlines. In the Print By Color dialog, we used the 
following settings: 

  

A) We clicked the “Send By Hairline” option, which will cause the raster fills to be grouped according to 
their hairlines colors. 

B) In the “Cut Data: Hairlines” list, we used the cursor to drag the blue hairline higher in the list, such that 
the blue hairline shapes will have the higher priority. 

C) The “Send all checked colors” was clicked, and we then unchecked the blue hairline color. The checkbox 
for red is still checked, so only the red hairlines will be interpreted as cutting lines. 

D) And before sending the job, we set the Sort Cut Data to Nearest, so that the shapes will be cut in the 
order of their relative proximity to one another. 
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Anti-Aliasing 
Anti-Aliasing is the smoothing of the jagged, "stair stepping" appearance that can appear in low-resolution drafts. 
Anti-aliasing is achieved by blurring the color of adjoining pixels to improve the transition between light and dark 
pixels. 

The available Anti-Aliasing options are None, Coarse, Medium, and Fine. A setting of Fine will produce the 
highest quality smoothing, though this will incur slower printing. 

Note: Anti-Aliasing should be used for dye-sublimation printing only – NOT wax, resin, or wax/resin. 

  

 
 

PAGE SETUP TAB 
Page Setup tab 
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Margins 
Some printer drivers do not account for the non-printable areas, or margins of the page. In those cases, Vision-Pro 
provides for the margin settings, by accessing the Margins tab. Enter margin specifications in the entry boxes in 
this dialog box as required. 

Overlap 
Overlap 

The Overlap options permit establishing settings for tiling large printed images. If the file to be printed is too large 
for the printable area, use the Overlap options to set the Horizontal and Vertical Tile Overlaps as well as the Tile 
spacing.  

Horizontal and Vertical Overlap 
These options specify the amount of overprint each tile will contain. Each tile actually ends with the beginning 
portion of the next tile. For example, if an overlap of a half-inch is set the last half-inch of a given tile will be 
identical to the first half inch of the proceeding tile. This function is useful for particularly intricate graphics, as it 
provides a guide for laying the pieces of the printed file together. Each of the Horizontal and Vertical options can 
be set individually. 

Spacing 
The Spacing setting is used to specify the amount of material to be left blank between tiles when printing a job. 

Units 
The Units of measurement are displayed for reference only, the unit of measurement cannot be changed from the 
Print window. 
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ADVANCED CUTTING AND PLOTTING 
ADVANCED CUTTING AND PLOTTING 

ClippingShapes 
Rubber Stamp 
Nesting 
Badges 
Creating Plate Objects 
PhotoLaser 
Weed and Power Weed 
Registration Marks 
Plotter Jog 
Tiling 

CLIPPING SHAPES 
A line art shape can be used as a clipping path for images and other line art shapes. Position the line art shape 
above the shapes that are to be clipped, select all of the shapes, and then choose Arrange menu | Clipping. The 
shapes will then be grouped as a “clip group.” 

To reverse a clipping operation, select the clip group and choose Arrange menu | Clipping Clear. 

  

When clipping shapes, a common design technique is to convert text into a bitmap, and then use the original text 
as a clipping path on the bitmap. For example, here is a blue text shape the we want to convert into a nice 
grayscale image: 

  

 
  

Selecting the text, we then applied the Transform menu | Render Contour Bitmap tool. For our initial settings, 
we chose Constant Slope with a screen resolution of 100 dpi: 

  

 
  

When editing the SmartBar settings for the Render Contour Bitmap tool, we enabled the Keep Original option, 
so that the original text shape will be retained after creating the bitmap. We also clicked the curve to open the 
Tone Reproduction Curve dialog. The curve was adjusted to produce darker shades along the edges of the text. 
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After applying the Render Contour Bitmap operation, the image will be the selected object, but our original text 
is below the image. With the image still selected, we can apply the Arrange menu | Order To Back command, 
which will place the image behind the original text shape. 

If we then marquee select both the image and text, the Arrange menu | Clipping command can be applied to 
create the final grayscale image. 

  

 
  

RUBBER STAMP 
This tool is used to layout a rubber stamp design, as follows: 

  

1) Create a shape that represents the border of the rubber stamp. 

2) Add shapes and text to fit within the border, such as the design should appear when a stamp impression is 
made by the customer. 

3) If necessary, apply a Make Path operation to the shapes that are arranged within the border. 

3) Select all, and choose the Rubber Stamp tool. 

  

The resulting shape will be flipped in the horizontal plane. 
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On the right is the design that should appear when a customer applies the stamp. Applying the Rubber Stamp 

command will create the design that is on the left, which will be used when cutting the stamp design. 

  

NESTING 
Nesting  

The Nesting feature rearranges objects on the cutting material with the purpose of minimizing wasted material. 
Objects can be flipped and grouped on the Plate Size, as well as rotated to achieve an optimum usage of the 
cutting material. 

To nest the individual letters of a sentence, the Text to Graphics command must first be used. Otherwise, the 
sentence as a whole will be nested without rearranging the individual letters. 

To use nesting, select the objects that will be cut, and then choose Nesting from the Arrange menu. The Nesting 
dialog will open. 

 

 
 

If Nesting is activated during the Cut Preview mode, then an abridged version of the Nesting dialog will be 
available. However, the available controls are used in the same fashion as on the full Nesting dialog. 

Starting Corner 

Starting Corner 
Starting Corner 

Choose the corner from which rearranged objects will be placed. Nesting will begin in that corner and expand 
across the sign plate. 

Direction 
Choose the direction in which rearranged objects will be spread across the sign plate. The available choices are 
horizontally and vertically. 



Vision-Pro 7 Doc Files 

348 

Rotate While Nesting 
Objects may be rotated as well as rearranged. Select the Allow Increment Rotation button to activate the rotation 
capability. Objects will then be stepped through 360 degrees of rotation in order to find the optimum rotation. The 
Increment Angle field will indicate the amount of rotation that will occur for each step. For example, if the 
Increment Angle were 20 degrees, then objects will be rotated as many as 18 times in an attempt to find the 
optimum rotation for each object. 

Margins 
By default, objects will be nested to the very edge of the Plate Size. Use the Nesting Border field to indicate a 
minimum distance that must be maintained between nested objects and the edge of the Plate Size. 

Space Between Shapes 
By default, nested objects will be placed in tight proximity to one-another. Use the Clearance Between Objects 
field to specify a minimum distance that must be maintained between objects. 

Error Factor of Clearance 
During the nesting process, approximations are made that are based partly on the magnitude of the objects being 
nested. Setting a small Error Factor will produce more consistent spacing between the objects, but at a cost of 
more processing time. The following chart provides suggested Error Factor values, which are qualified by the 
broad categories of Fine, Medium, and Coarse. The table is based on the average dimension of the objects that are 
being nested. 

  

Average Object Dimension Fine Medium Coarse 

0 < Dimension < 100 0.1 0.2 0.5 

100 < Dimension < 1000 0.2 0.5 1.0 

1000 < Dimension < 3000 0.5 1.0 2.0 

Dimension > 3000 1.0 2.0 5.0 

  

Allow Mirrored Parts 
In addition to rearranging and rotating objects, the Nesting feature can also flip objects to improve the final 
placement of objects. Select the Allow Mirrored Parts button to allow objects to be flipped. 

  

Keep Groups Intact 
Unless this option is active, then grouped objects will be separated during the nesting process. Allowing objects to 
be separated is useful when the final arrangement of cut shapes is unimportant, though the configuration of objects 
is somewhat awkward for ungrouping. 

  

BADGES 
Badges 

The Badges feature creates a series of workspace objects based upon a basic design and data file. For each badge 
that is produced, the data file contains one set of text data that is applied to the template. For example, badges may 
be used to create nameplates for doors, identification cards for employees, or adhesive labels for schematics. 

  



Advanced Cutting and Plotting 

349 

 
  

Setting the Number of Badges 
Setting the Number of Badges 

The Number Of Copies is used to specify the total number of badges that will be created. Taking the badge sizes 
into account, the Max Copies Per Page field will indicate the maximum number of badges that can be fit onto a 
single piece of material. 

If there are more badges than will fit on a single piece of material, then additional pages of material will be 
created, which can be viewed using the Paging Tool. On the Badge Setup dialog, the Total Number of Pages 
field indicates the number of these pages that will be created. 

Using Score Lines 
Score lines are inserted between each badge, so as to improve the ease of separating the badges after production. 
Use the Color field to set the score line color. 

Use Plate 
By default, badges are distributed to maximize usage of the plate size area. Activating the Use Plate option will 
force each badge to a single sign plate. Individual badges may then be printing according to their given page 
number. 

Note: For the Use Plate option to work, the Margins must all be cleared to zero. 

  

Plate size and margins 
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Specify the Plate Size and its margins. If the Plate Size is equal to the badge size, then a single badge can be 
printed per plate. 

  

 

Routing Or Engraving... 
It is recommended that the Height and Width be set to the exact dimensions of the plate. 

Rendering A Sign In Vinyl... 
Set Height and Width to match the page size set for the plotter. 

Margins 
These margins are applied to the cuttable area of material, not necessarily the actual size. As mentioned 
previously, these margins must be cleared to zero when the Use Plate option is active. 

  

Spacing 
When spacing multiple badges per plate, the distance between each badge is indicated by the Vertical and 
Horizontal fields. 

  

 
  

Compress Equally Over Copies 
For the text frame that is being used as a badge template, suppose that compression rules have been applied to the 
text frame. When replacement text is inserted during the badge creation process, the indicated compression rules 
will be applied to any badge text that exceeds the text frame. Since it is good practice to set the text frame equal in 
size to the badge, the text compression will consequently prevent the text from exceeding the badge dimensions. 

If the Compress Equally Over Copies option is enabled, then all badges will be evaluated to determine the badge 
that requires the most text compression. All badges will then be applied with the same amount of text 
compression. Naturally, if no given badge had required text compression, then none of the badges text would be 
compressed. 

Page Preview 
The Page Preview controls are used to specify how multiple badges will be arranged upon the Sign Plate. If the 
Use Plate option is checked, then the badge dimensions will be set equal to the Sign Plate, and the preview will 
indicate that each badge fills the entire plate. 
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If the Use Plate option is unchecked, then multiple badges will be arranged either Vertically or Horizontally, 
depending on the chosen Page preview setting. For example, consider six-dozen badges that are arranged on a 6” 
by 10” plate. In this case, an entire plate was filled with badges, so the Page preview displays badges on the 
second plate. Notice that where the plate is not full, a grayed-out badge will be drawn to indicate that additional 
badges will fit on the plate. 

  

  
Badges arranged Vertically, from top-to-

bottom. 
Badges arranged Horizontally, from left-to-

right. 

  

Total Number of Pages 
Once the number of badges have been set, and the Plate size and margins have been specified, then the Total 
Number of Pages field will indicate how many “pages” will be filled with the resulting badges. 

  

 
  

Replaceable Items 
The Replaceable Items list displays all valid text objects for substitution. The text of each item will correspond to 
the text that had been entered on the workspace. Select the text objects that will undergo substitution. 
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Note: The order of fields in the Replacement Data File should correspond to the order of text shapes on the Vision-Pro 
workspace. This will allow the Badge Setup dialog to substitute text in the correct order. 

  

 
  

For text objects that are not selected, no substitution will take place. 

 
 

Replacement Data File 
The Replacement Data File contains the text that will be substituted for each badge. 

  

 
  

Any text editor may be used to create this file. Within the text file, each line represents a set of data for one badge. 
If the badge has multiple fields, then each field must be separated by a delimiting character, such as a comma, a 
space, or a tab character. For example, tab-delimited data might appear as the following: 

  

Text Field 1             <press Tab>           Text Field 2             <press Tab>           Text Field 3 

  

Next to the Browse button, the drop-down list may be used to choose the delimiting character that is used in the 
text file. 

Note: If there are more badges being created than there are sets of data, then the extra badges will be filled with empty 
data. 

  

Text Substitution 
Text Substitution 

From the Badge Setup dialog, press the OK button to continue. If one-or-more text fields were selected within the 
Replaceable Items list, then the Text Substitution dialog will open: 
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Each column represents one of the elements that was previously selected within the Replaceable Items list. If a 
Replacement Data File had been specified, then the column entries will be completed using the data from that 
file. For empty cells, select the given cell and type data within the Edit Text field. 

 
 

Serialization 
Badges may be indexed using the Serialize dialog. From the Text Substitution dialog, select the range of fields 
for which indexing will be set, and the Serialization button will become active. Only contiguous cells may be 
selected, and all selected cells must be within the same column. Note that an entire column may be selected by 
clicking the column header. 

When the given cells are selected, click the Serialization button to open the Serialize dialog: 

  

 
  

Start 
The initial text data from which serialization will build an index for the badges. The value here may be either 
numeric, alphabetic, or alphanumeric. 
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Increment 
This is the numeric value that must be added to the value used on the previous badge. In most cases, set this value 
to one. 

Note: For alphabetic series, the ASCII character set is used. If the badges have incremented through the entire ASCII 
character set, then subsequent badges will continue from the beginning of the set. 

Type 
Use the radio buttons to indicate whether the series is composed of numeric or alphabetic data. 

Set Base 
When serializing badge data, the value in the Start field is used as the base, to which the Increment is added for 
each subsequent badge. However, by using the mouse to select only part of the Start field data, then only the 
selection will be incremented. In this case, unselected portions remain constant. For example, suppose a series of 
booth labels must be created for a trade show. 

  

 
  

As in the screen shot, the value “Booth A” is entered. Using the mouse, only the “A” was highlighted, and then the 
Set Base button was clicked. This indicates that the word “Booth” will remain constant, while the highlighted 
portion will be incremented for each badge. 

 
 

Click OK to close the Serialize dialog, and the Text Substitution dialog will be updated as follows: 
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Paging Tool and Page Control 
When badges are created, Vision-Pro will attempt to fit each badge within the bounds of the sign plate (the 
dimensions of the sign plate are set using the Layout | Plate Size command). If there are more badges than will fit 
on the sign plate, then additional pages of the Vision-Pro workspace will be created, each with its own sign plate. 
These additional pages may be viewed using the Paging Tool, which is at the bottom-right corner of the Vision-
Pro workspace. 
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After additional pages have been created, the objects on each page may still be edited individually, and the basic 
Copy & Paste commands may be used to move selected objects between pages. The Page Control dialog provides 
further editing functionality for deleting pages, or moving objects between pages. 

To access the Page Control dialog, at least one object must be selected on the current page. The Page Control 
dialog options are described as follows: 

  

Number of Pages 
The “Number of Pages” field indicates the total number of pages that have been created. 

  

Delete Pages Above 
If the “Delete Pages Above” option is checked, then clicking OK will delete any pages after the “Number of 
Pages” field. 

For example, suppose that there are initially nine pages created. In the Page Control dialog, set the “Number of 
Pages” field to 7, and then click OK. The 8th and 9th pages will be deleted. 

  

Use on All Pages 
For a selected object, the “Use on All Pages” option is used to make duplicates of that object on all of the pages. 

For example, suppose that several pages have been created, and that a bitmap is then added to one of the badge 
pages. The placement of the bitmap looks good, and it is desirable to have that bitmap on all of the pages. This is 
done as follows: 

  

a) Select the bitmap 

b) Open the Page Control dialog 

c) In the Page Control dialog, note that the “Use on All Pages” option is automatically checked 

d) Click OK, and a duplicate of the bitmap will be placed on all of the pages 
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Use on Page 
The “Use on Page” field is used to move the selected object to another page. However, the “Use on All Pages” 
option must first be unchecked, which will allow the “Use on Page” field to be editable. 

For example, suppose that some new text was created on page 6, but the text was meant to be on page 5. 

  

a) On page 6, select the text object 

b) Open the Page Control dialog 

c) Uncheck the “Use on All Pages” option 

d) Set the “Use on Page” field to 5 

e) Click OK to move the text object to page 5, and the current view will automatically shift to page 5 

  

 
 

CREATING PLATE OBJECTS 
Creating Plate Objects 

The Plate Objects feature is used to create individual text engraving plates for short production runs. These plate 
objects are similar to what can be produced using the Badges serialization feature, and plate objects will be 
automatically fit within the available space of the sign plate. As such, plate objects can be created in addition to a 
larger job, making use of material that would otherwise be wasted. 

Where a large number of plate objects are being created, it is possible that the entire sign plate becomes filled. 
Any excess plate objects will be automatically arranged onto additional sign plates, which can be viewed using the 
Paging Tool. 
  

Create a set of plate objects 
Create a set of plate objects 

From the Layout menu, choose Plate Object | Create Plate to display the SmartBar controls for customizing the 
plate objects. The key settings are the Width and Height of each plate, and the text margins (left, right, top and 
bottom) that will be applied. These margins will be used when adding text to the plate. 

Secondary settings are the initial number of plates (more can be added later), and the color of the score lines. 

  

For example, suppose that the following settings are used: 

  

�       Plate size = 24” width by 16”, portrait, top-left origin 

�       Plates = 9 total, 4” width, 2.5” height, black score lines, ¼” margins 

�       Plates = 3 total, 8” width, 8” height, black score lines, ½” margins 

  

The Vision-Pro workspace would appear similar to the following, where nine small plate objects would populate 
the top 
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Nine small plates, and two large. Though we created three large plates, the third plate 

was placed on a new sheet, which can be viewed using the Paging Tool. Also note that 
the initial ¼” margins have been replaced with the ½” margins used when creating the 

large plates. 

  

Adding Text to a Plate 
To add text to a plate, first choose the text compose tool, and then click within the plate. The text frame will match 
the plate dimensions. 

  

Creating More Plates 
After creating a set of plates, there are two methods of adding more plates.  

  

1) Select the set of plates, and then choose Layout | Plate Object | Add Another Plate 

2) Select the set of plates, and then press the [Page Down] key 

  

Conversely, plate objects can be removed by using either the Remove Last Plate command, or by pressing the 
[Page Up] key. 

  

PHOTOLASER 
PhotoLaser 

The PhotoLaser feature is used to convert an image into a laser-ready monochrome image. A laser engraver is 
essentially a monochrome device (laser on or laser off), so any color information retained in the image is not 
usable. As such, before using PhotoLaser, we recommend that the Image menu > Mode > Grayscale tool be used 
to convert the image to a grayscale. 

When the grayscale image is selected, choose PhotoLaser from the Transform menu. The Interactive tool is used 
to adjust the PhotoLaser settings, whereas the Automatic tool will apply the previously used settings. 

The PhotoLaser dialog displays the original image on the left, and the resulting monochrome image is on the 
right. 

Between the original and monochrome images are the different filters that can be applied to refine the 
monochrome image. Any of these filters can be toggled ON/OFF by right-clicking the filter name. Below the list 
of filters are the controls for the currently selected filter. 
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At the bottom-left of the PhotoLaser dialog are buttons for saving and loading preset PhotoLaser settings. There 
are several suggested preset settings available, which are named according to the type of material that is being 
engraved. 

  

Histogram 
A histogram is a chart consisting of horizontal or vertical bars, the widths or heights of which represent the values 
of certain data (in this case, the data represents pixel brightness across the bitmap). 

Using the histogram, adjust the distribution of color intensities throughout the bitmap, either to correct a scanned 
image, or to create an artistic effect. Increasing the Black level will equate the darkest portions to black, whereas 
decreasing the White level will equate the lightest portions to white. Increasing or decreasing the Gamma will 
modify the overall intensity of the bitmap. 

The End Limits are used to adjust the White and Black values, which is an effective means of removing speckles 
from a scanned image. 

  

Edge Enhance 
Edge Enhance 

An “edge” refers to portions of an image where there is a transition between light and dark pixels. These edges can 
be enhanced by applying emboss, blur, or sharpen filters. 

Two Edge Enhance filters can be applied. The possible filters are: 

  

Emboss 
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Applies an emboss effect to the image, per the specified depth and direction of the effect. The Depth indicates the 
apparent depth of the emboss effect. 

  

Gaussian Blur 
Smooth or blur pixels with respect to their surrounding pixels. The Radius determines the surrounding area that is 
considered when blurring a pixel.  

  

Sharpen 
Increase or decrease the sharpness of the bitmap. 

  

Unsharp Mask 
The Unsharp Mask feature is actually considered to be a sharpening function because it increases the contrast 
between light and dark areas of the bitmap. Wherever there is a brightness transition between light and dark, the 
light area is made lighter, and the dark area is made darker, such that the transition becomes more distinct. The 
software accomplishes this as follows: 

  

1) A blurred copy of the bitmap is created, where the amount of blurring depends upon the Radius setting 

2) The blurred copy is then subtracted from the original (the resulting difference bitmap is referred to as the 
“mask”) 

3) The Threshold setting is then evaluated. The Threshold setting varies from 0 to 255, which corresponds 
to the range of possible brightness levels of each pixel within the mask. 

4) Pixel-by-pixel, where the difference from step (2) exceeds the Threshold setting, the difference is 
multiplied by Amount and then added to the original bitmap 

5) Where the difference does not exceed the Threshold setting, the original pixel value remains unchanged 

  

Threshold 
Creates an effect that mimics the accidental exposure of photographic film to light. This is done by inverting all 
color intensities that exceed the Threshold value. 

  

Dither 
Dither 

Dithering methods create the appearance of more subtle shades by mixing in pixels of different colors. This is 
similar to the way newspaper pictures produce the appearance of shades of gray, even though the only actual 
colors are black and white.  

  

Error Diffusion 
Except for Ordered dithering, all of these dithering methods use error-diffusion algorithms. In error diffusion, 
the error is the difference between the original pixel color and the nearest match, and diffusion of this error is what 
the algorithm accomplishes. For example, Floyd-Steinberg is a fast, high-quality error-diffusion method. 

All of the alternative error-diffusion methods are slower than Floyd-Steinberg, and the quality may or may not be 
better, depending on the original image. Choosing an alternative dithering method is a subjective, trial-and-error 
decision. Stevenson and Arce dithering, the slowest of the alternatives, is most likely to produce a higher quality 
result. 

Ordered dithering is not an error-diffusion algorithm, but rather it is a method used when painting to a display 
device that is 256 colors or less. Ordered dithering is a fast method that takes advantage of the fact that the colors 
in most palettes are ordered so that similar shades are next to each other in the palette. This method avoids 
blotches of color by adding to or subtracting from the nearest-color value of each pixel to ensure that adjacent 
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pixels do not have exactly the same color. However, if the colors in the palette are not ordered, then the results of 
this algorithm are poor. 

  

Halftone 
Convert the bitmap to a halftone bitmap, which is useful for creating an artistic effect. The Angle setting is used to 
rotate the halftone pattern. 

  

Intensity Detect 
Pixel intensities within the bitmap range from 0 to 255 for each color plane (red, green, and blue). The Intensity 
Detect filter compares each pixel intensity with the Low and High values, and the pixel intensity is set as follows: 

  

Pixel Intensity Result 
Between Low and High Increase intensity to 255 

Less than Low Clear intensity to zero 

Above High Setting Clear intensity to zero 

  

  

Mixing 
To use this feature, both the Dither and Mixing filters must be ON. 

For the image that results from the Dither setting, the Mixing filter is used to apply the resulting image as an 
additive mask to the original image. The Blend setting is used to adjust the percent intensity of the additive mask 
(i.e. 0% will be the original image, whereas 100% is the full intensity. 

  

Invert 
Inverts the colors in the bitmap, making it like a photographic negative. This feature can also be used to invert the 
color of a grayscale image, making the black white and the white black. 

  

Flip 
Flip the image horizontally. This feature is typically used when the image is to be reverse-applied to transparent 
media, such as a clear acrylic. 

  

Simulation 
Simulate the image as it would appear when laser engraved into the given material. Set the “Burnt Color” to 
represent the absolute darkest portion of the expected output. 

From the drop-list, the available materials correspond to bitmap BMP files that are within the Vision-Pro \ 
PhotoLaser directory. If additional bitmap files are placed within this directory, then they will be available for 
selection from the drop-list (i.e. bitmaps created by color scanning the material that will be etched). 

WEED AND POWER WEED 
Weed and Power Weed 

After cutting a vinyl shape, the shape must be peeled away from its backing. However, problems may occur when 
the shape doesn't pull away easily from the surrounding vinyl, in which case stretching of the vinyl may occur. To 
avoid stretched vinyl, a weed border may be created, which is essentially an extra rectangular cut around the 
shape. Once cutting is done, the rectangular cut may be peeled away first, followed by the inner shape. 

Weed Border 
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Weed Border  
To create a rectangular cut around the selected shapes, choose Weed Border from the Shape Tools flyout. 

  

 
  

In the SmartBar, the Border Offset value indicates the distance that will be maintained between the shapes and 
the weed border. 

Note: The default Weed Offset value is set on the General Preferences dialog. The terms Weed Offset and Border 
Offset are used interchangeably. 

  

Power Weed  
A power weed is like a weed border, except that mid-weed lines (horizontal and vertical) may also be created. 
These mid-weed lines will improve the ease of pulling the finished vinyl from its backing, especially where text 
shapes are being cut. 

To apply a power weed to selected shapes, choose Power Weed from the Shape Tools flyout. 

  

 
  

As with the weed border, the Border Offset value indicates the distance that will be maintained between the 
shapes and the border. 

To create a horizontal mid-weed line, hold the cursor over the bottom edge of the weed border. When the cursor 
appears as an up/down bi-directional arrow, left-click and drag to form the weed line. Similarly, a vertical mid-
weed line is created by dragging from the left edge of the weed border. 

 

In the SmartBar, the Line Overlap indicates how close the mid-weed lines will cut towards the shapes. A Line 
Overlap of zero will cause the weed lines to cut flush with the shapes, whereas a negative value will leave a gap 
between the weed lines and the shapes. 

Note: Any part of the design that is bisected by the weed is left uncut. 
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Weed Border in Cut Preview  
If weed lines have been applied on the workspace, then they will be indicated as cut lines during the Cut Preview 
or Print and Cut Preview modes. However, a weed border may also be added during the Cut Preview mode. 

During the Cut Preview mode, the Weed button is available on the Cut Manager toolbar. 

  

 
  

Left-clicking the Weed button will activate the weed border, and the preview will show the border that is created 
around the shapes. 

The Weed offset value from the General Preferences dialog will be used. To use a different Weed offset value, 
right-click the Weed button, and the Weed Setup dialog will open. Changing the Weed offset value will apply to 
the current job being cut, but the default value will not be changed. 

  

 
  

REGISTRATION MARKS 
Registration Marks 

Registration marks are placed on the workspace to aid in arranging color layers, such as when producing a full 
color lay up. Registration marks can be cut or printed as part of the overall graphic. However, operations like 
scaling may not be applied to registration marks. 

Where a graphic is to be printed and then cut on a stand-alone cutting device, registration marks are needed to 
ensure that the media is correctly aligned. For more information about the usage of registration marks, please refer 
to Plotter Jog in the following section. 

Filtering Registration Marks 
Filtering Registration Marks 

There may be situations wherein it is not desirable to print or cut registration marks for all color layers. Whenever 
the Filter by Color dialog is used, disabling the Filter Registration Marks option will cause current registration 
marks to not be included with the output. 

  

 
  

To later include existing registration marks again, open the Filter By Color dialog and enable the Filter 
Registration Marks option. 
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Registration Mark tool 
To create a single registration mark on the workspace, choose Registration Mark from the Shape Tools flyout. 

  

 
  

Different registration marks styles may be chosen from the SmartBar. At the far-right of the SmartBar, the 
dimensions of the registration marks may be set. 

  

 
  

Create registration marks by clicking on the workspace. When finished creating registration marks, pressing 
Spacebar will return Vision-Pro to the Select mode. Individual registration marks may then be selected, and their 
positions may be precisely set using the horizontal and vertical position fields in the SmartBar. 

Multi-Registration Marks 
To create a set of registration marks for the currently selected shapes, choose Multi-Registration Marks from the 
Shape Tools flyout. 

  

 
  

As when creating a single registration mark, the style may be chosen from the SmartBar. The Offset amount 
indicates a rectangular distance about the shapes, along which the registration marks will be placed. Up to eight 
registration marks may be placed, as indicated by the Positions checkboxes. 

  

 
  

Adding Registration Marks during Cut Preview 
During the Cut Preview mode, registration marks may be added using the Registration Marks button on the Cut 
Manager. 

  

 
  

When the Registration Marks button is right-clicked, the Registration Mark Setting dialog will open. This 
dialog may be used to set the positions, size and offset of the registration marks, as described in the previous 
section under Multi-Registration Marks. 
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Click OK to save the settings, and the Registration Mark Setting dialog will be closed. On the Cut Manager 
toolbar, the Registration Marks button may be left-clicked, which will cause the Registration Marks popup will 
appear. The popup may be used to select the style of registration marks. 

  

 
  

When the style is selected, the registration marks will be placed about the workspace shapes. 

  

 
  

PLOTTER JOG 
Plotter Jog 

Vision-Pro supports Plotter Jog. This feature is designed to reduce wasted material by cutting new objects in 
unused sections of a vinyl sheet. Objects may be placed precisely into areas of vinyl that were left unused by a 
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previous job. Additionally, elements of a current job can be placed into different sections of the same vinyl for 
optimum use of space. 

In order to perform Plotter Jog, it is necessary that Registration Marks be included as part of the job. Registration 
marks are discussed in the previous section. 

Enabling Plotter Jog 
To enable jogging by default, choose Plotting Defaults under the Cut menu. The Plot dialog will open, and the 
Jog option may be enabled for the given device. 

  

 
  

If jogging is not enabled by default, then it may be activated during either the Cut Preview, or Print and Cut 
Preview modes by clicking the Enable Jogging button. 

  

 
  

Note: If jogging has been enabled by default, then the preview modes will show the Enable Jogging button as 
depressed. 

  

  

Jogging Controls 
Jogging Controls 

When a job is sent for plotting, the Jog dialog will open. 
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When using vinyl scraps from a previous job, move the artwork origin to fit into the specific area. For example, if 
the leftover vinyl is oddly shaped... 

  

 
  

...then shift the artwork origin to fit the remaining vinyl. 

  

 
  

While this task can be accomplished by setting an X- and Y-move from within the Jog dialog box, jogging the 
plotter head offers a more precise setting. This is because the head of the cutter can be physically moved to the 
desired position before committing to the cut. Also, use the Jog option to change the angle of the baseline for a 
given cut. 

  

Registration 
The Registration options are used to set the Reference Point, Skew Point, and Stretch Point. Click the Walk Points 
button  to alternate the plotter position between the different points. 

If Registration Marks exist on the artwork, the Reference Points (described below) will be set to the Registration 
Marks. 

  

 Reference Point  
The first step in jogging the plotter head is to set the Reference Point. This includes both defining a target point for 
the group of objects to be cut, and defining where on the material that point is to be placed. 
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To set the Reference Point, click Reference Point in the Registration area of the Jog dialog box. This setting 
enables of the Reference Point’s target to be defined, as well as its actual position on the vinyl. 

  

The next step in setting the Reference Point is to define the Reference Point’s target on the graphic on screen. The 
default Reference Point is the origin of the artwork (i.e., lower left point). This point can be moved graphically on 
screen to suit specific needs. Move this Reference Point to anywhere on the artwork by clicking with the left 
mouse button at the desired position. 

  

 
  

Once the Reference Point is set on the artwork, set the actual position on the vinyl for the Reference Point for 
cutting. This involves moving the head of the plotter to the point where the target should be placed. The plotter 
head may be moved in five ways: 

1)       Holding the right mouse button while moving the mouse. 

2)       Positioning the mouse and pressing the right mouse button. 

3)       Pressing the cursor keys (hold the Shift key to move the plotter head in larger increments). 

4)       Entering the coordinates manually. 

5)       Moving the plotter head with the plotter controls. 

  

Skew Point 
If there is only a Reference Point set, Vision-Pro will cut the graphic with a horizontal baseline. Use a Skew Point 
to either cut a pre-printed piece of material accurately, or improve usage of the available vinyl by changing the 
angle of the baseline. 

�       The procedure for setting the Skew Point is identical to setting the Reference Point. Click on Skew 
Point in the Registration section of the Jog dialog box to begin. 

  

Stretch Point 
The Stretch Point is used to adjust the horizontal and/or vertical perspective of the graphic. This tool is used with 
printers that may resize the image during the print process, in which case a Stretch Point is required to cut a pre-
printed piece of material accurately. 

�       The procedure for setting the Stretch Point is identical to setting the Reference and Skew Points. Click 
on Stretch Point in the Registration section of the Jog dialog box to begin. 
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Registration Mark 
Pressing the Registration Mark button causes the plotter to move around to the next registration mark location on 
the vinyl, which is useful when Contour Cutting print jobs. The plotter head will remain in the up position during 
this movement. This feature is particularly useful to ensure that registration is accurate for contour cutting pre-
printed graphics. 

When the Registration Mark button is clicked, this will also change the currently selected registration mark on the 
workspace, which allows the registration mark to then be defined as either the origin, skew, or slant mark. 

  

Walk Points 
Pressing the Walk Points button causes the plotter to move through the Reference, Skew, and Stretch Points on the 
vinyl. The plotter head will remain in the up position during this movement. This feature is particularly useful to 
ensure that registration is accurate for contour cutting pre-printed graphics. 

  

Set Position 
The Set Position button (computer jogging) is used to define the origin coordinates. 

  

Get Position 
The Get Position button (machine jogging) is used to poll the plotter for the current coordinates of the tool. 

  

Move The Cutting Head With The Mouse 
To move the cutting head with the mouse, simply drag the target to the appropriate position using the right mouse 
button. Note that as the mouse moves, the cutting head of the plotter mimics the movements. 

Guide the cutter to the position for the first reference point, and release the right mouse button when the plotter 
head is in position. The cutting head can also be moved by [Shift] clicking the right mouse button at the first 
reference point position. 

To check the exact position of the pen or knife, the cutting head of the plotter can be dropped to the surface of the 
vinyl by pressing the [Page Down] key on the keyboard. To return the head to the up position, press the [Page Up] 
key. 

  

Move The Cutting Head With The Keyboard 
Moving the cutting head with the mouse is generally a coarse adjustment. To supplement this type of movement 
with a finer control, choose to direct the cutting head to the required position from the keyboard using the Left, 
Right, Up, and Down arrow keys. Click in the main Vision-Pro view screen before using the cursor keys in order 
to activate this function. To increase the speed at which the cutting head is traveling, press and hold the [Shift] key 
while moving the head.  

  

To check the exact position of the pen or knife, the cutting head of the plotter can be dropped to the surface of the 
vinyl by pressing the [Page Down] key on the keyboard. To return the head to the up position, press the [Page Up] 
key. 

Note: The arrow keys on the keyboard can only be used to move the cutting head to the position of the Target. The 
Target itself can only be moved using the mouse. 

  

Move The Cutting Head To An Absolute Position 
To move the cutting head with a very high degree of precision to an absolute position on the vinyl, type the 
required X-axis and Y-axis coordinates in the X and Y entry boxes to set the target position. Once the first target 
point is specified, press the Set Position button to lock in the coordinates. This button, available only in Remote 
Jog mode, will immediately move the plotter head to the position set in the X and Y boxes. 
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TILING 
Tiling 

Workspace shapes may be organized into tiles, which is a useful method of sub-dividing the job into manageable 
sections. In addition, the amount of wasted material may be reduced by "stacking" tiles on the media. 

  

  
Large shape organized into three tiles. 

When printed from left-to-right, 
notice that half the material is wasted. 

By stacking the tiles, wasted material 
may be reduced. 

  

Default Tile Settings 
Default Tile Settings 

The placement of tiles is performed during either the Cut Preview or Print and Cut Preview modes. Default tile 
settings are accessible through the Tiling dialog (Cut menu). 
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The Tiling dialog settings are described as follows: 

  

Pause 
This option stops the plotter between each tile. However, not all plotters can be paused between page boundaries. 
Page boundaries are set in the Plotter Setup dialog. 

Stack Tiles 
Tiles are created during the either the Cut Preview, or Print and Cut Preview modes. Enabling the Stack Tiles 
options will cause tiles to be automatically rearranged prior to output, such that material waste is reduced. 

During the Cut Preview mode, the arrangement of tiles may be previewed by clicking the Tile Preview button on 
the SmartBar. The button may be clicked again to return to the Cut Preview mode. 
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Cut Horizontal and Vertical Edges  
These options are used to cut the edge between adjacent tiles, which is useful when overlapping adjacent tiles. 

If the Cut Vertical Edge option is not used, then the plotter will automatically index past the page boundary 
without breaking the continuity of the cut. 

Note: If the Horizontal Spacing is zero, then do not use the Cut Vertical Edge option. By doing so, this will allow 
effective cutting of objects that are much larger than the maximum plotter page size. 

  

Overlap 
The Overlap specifies the amount of over-cut that each tile will contain, such that the end of each tile will include 
a portion of the adjacent tile. For example, consider a ½ inch overlap, where two tiles are being cut in sequence. In 
this case, the trailing ½ inch of the first tile will be identical to the leading ½ inch of the second tile. 

  

 
  

Overlapping adjacent tiles is beneficial when preventing gaps that may appear between panels due to material 
shrinkage. 

Spacing 
Spacing indicates the amount of material left uncut between tiles during the cutting job. Vertical spacing refers to 
tiles that are side-by-side. Horizontal spacing refers to tiles that are above one another on the sheet. 
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Note: This Tiling box is the same box as where the tiling parameters for printing are specified. Therefore, the rules that 
are set regarding Tiling in this dialog box will also be applied to the Tiles generated when printing a file. 

  

Creating tiles 
Creating tiles 

Tiles can be created during either the Cut Preview or Print and Cut Preview modes. In either preview mode, tile 
editing is begun by clicking the Tile button. 

  

 
  

By default, shapes will be placed upon a single, main tile. For example, consider the following screenshot of some 
shapes and text. 

  

 
  

Horizontal Tiles 
To create tiles horizontally, hold the cursor over the left edge of the main tile, such that a left/right bi-directional 
cursor appears. 
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When the bi-directional cursor appears, left-click and drag the tile line, such that it subdivides the main tile. There 
will now be two tiles, which may be further subdivided to create more tiles. However, avoid dragging a tile line 
over a previously created tile line, since this will delete the previous tile line. 

 
 

If a Horizontal Overlap amount has been set on the Tiling dialog, then the tiling line will be drawn "thick" 
indicate the overlap. Similarly, a Vertical Overlap amount will be shown when creating vertical tiles. 

  

 
  

In the above screenshot, a tiling line has subdivided the main tile into two horizontal tiles. The SmartBar indicates 
that the "Number of tiles" is two. In addition, the "Number of tiles on" field indicates that both tiles are active. 

  

 
  

Vertical Tiles 
To create vertical tiles, hold the cursor over the bottom edge of the main tile. An up/down bi-directional cursor 
will appear, which may be dragged to form a tile line. 
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Selecting Tiles 
By default, all tiles will be sent as output to the given device. However, if one-or-more tiles are selected, then only 
the selected tiles will be sent as output. For example, consider a design that has been arranged into four tiles. 

  

 
  

Clicking one of the tiles will cause it to be "crossed out." In the above screenshot, no tiles have been "crossed out," 
so it is assumed that all tiles should be sent as output. This is verified in the SmartBar, where the "Number of 
tiles" is four, and the "Number of tiles on" is also four. 
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Now suppose that three of the tiles are clicked, such that they are crossed out. The tiles would appear as follows: 

  

 
  

The bottom-left tile is not crossed out, so it will not be sent as output. As confirmation, the SmartBar indicates that 
the "Number of tiles on" is three. 

  

 
  

For the most recent tile that was clicked, the SmartBar displays the coordinates and dimensions of the tile. This 
information is displayed at the far-left of the SmartBar. 
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HOT KEYS 
HOT KEYS 

Hot Key Summary 
Functions Keys 

HOT KEY SUMMARY 
 

The following is a summary of the hot keys that are available within Vision-Pro. These shortcuts can be modified 
by choosing Customize Shortcuts from the Options menu. 

 

 
 

Generic Hot Keys 
These Hot Keys have general application within Vision-Pro: 

[Arrow key] Nudge selected object by one pixel 

[Shift+arrow key] Nudge selected object by five pixels 

[Tab] Change current focus to next object in sequence 

[Shift+Tab] Change current focus to previous object in sequence 

[Ctrl+Select tool] Move/Draw/Edit/Select with horizontal and vertical 
constraint 

 

 
 
Alignment Hot Keys 

 

These Hot Keys apply alignment to the currently selected objects: 

[Alt+1] Horizontally align objects along left-edge of bounds 

[Alt+2] Horizontally center objects within bounds 

[Alt+3] Horizontally align objects along right-edge of bounds 
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[Alt+4] Vertically align objects along top-edge of bounds 

[Alt+5] Vertically center objects within bounds 

[Alt+6] Vertically align objects along bottom-edge of bounds 

[Alt+7] Center objects both horizontally and vertically 

 

Note: The bounds refer to the rectangular outline of each object. 

  

File Menu Hot Keys 
 

These Hot Keys enable access to the various File menu options:  

[Ctrl+N] New workspace 

[Ctrl+O] Open workspace 

[Ctrl+S] Save workspace 

[Ctrl+P] Print workspace objects 

 

Edit Menu Hot Keys 
 

These Hot Keys enable access to the various Edit menu options:  

 [Ctrl+Z] Undo last command 

[Ctrl+Y] Redo last command 

[Ctrl+R] Repeat last command 

[Ctrl+X] Cut selected object 

[Ctrl+C] Copy selected object 

[Ctrl+V] Paste object 

[Del] Delete selected object 

[Ctrl+D] Duplicate selected object 

[Ctrl+T] Edit selected text 

[Ctrl+E] Edit selected object 

[Ctrl+I] Edit font of selected text 

[F3] or [Ctrl+A] Select all objects on workspace 

[Shift+F3] Deselect all objects 

[Alt+F3] Inverse the selection of objects 

[F4] Refresh the workspace display 

 

  

Layout Menu Hot Keys 
 

These Hot Keys enable quick access to the Layout menu options: 

[Alt+K] Activate the Alignment feature 

[Ctrl+K] Apply the current Alignment dialog settings 

[Ctrl+G] Group the selected objects 
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[Alt+G] Ungroup the selected objects 

 

Arrange Menu Hot Keys 
 

These Hot Keys enable quick access to the Arrange menu options: 

 [Ctrl+F] Move the selected object to the top layer 

[Ctrl+B] Move the selected object to bottom-most layer 

[Ctrl+U] Move the selected object up by one layer 

[Ctrl+L] Move the selected object down by one layer 

[Ctrl+M] Reverse the layer order of the selected objects 

[Ctrl+H] Create a common path from the selected objects 

[Ctrl+J] Reverse the common path that had been applied to a group 
of selected objects 

[Alt+B] Convert the selected text to graphic objects 

[Shift+F2] Simplify the selected object 

 

Engrave Menu Hot Keys 
 

The Engrave menu has a single Hot Key: 

[Alt+P] Open the Engrave Preview plotting controls 

 

View Menu Hot Keys 
 

These Hot Keys enable quick access to the View menu options: 

 [Alt+S] Toggle the display of object fills 

[Alt+N] Toggle the display of the tool diameter 

[Alt+R] Toggle the display of the ruler 

[Alt+M] Toggle the display of bitmaps 

[Alt+I] Toggle the display of the InstantReplay window 

 

Options Menu Hot Keys 
 

These Hot Keys enable quick access to the Options menu options: 

 [Ctrl+W] Snap to grid 

[Alt+W] Use guides 

 

 
 

FUNCTIONS KEYS 
 

The function keys in Vision-Pro operate as follows: 
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 [F1] Help 

[F2] Disable all Shop Palette color layers except the current 
target layer 

[F3] Select all objects 

[F4] Refresh the workspace 

[F5] Activate the Zoom In tool 

[F6] Zoom out 

[Shift+F6] Zoom in 

[F7] Zoom to selected object 

[F8] Zoom to Sign Plate 

[F9] Toggle between current and previous zoom levels 

[F10] Select the menu bar 

[F11] Pan workspace toward current mouse position 
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